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NPS GASEOUS POLLUTANT MONITORING PROGRAM 
List of Standard Operating Procedures and Technical Instructions to be Referenced 

from the CASTNET QAPP 

I. NPS AIR MONITORING NETWORK FIELD OPERATOR PROCEDURES

3176 Station Operator Maintenance Procedures for Meteorological Monitoring Sites
Using the DataView System 

3176-3100 Checklist Instruction - Weekly Station Visit 

Wind Speed / Wind Direction Sensor (Climatronics) 

3176-3101 Checklist Instruction - Weekly Station Visit 

Wind Speed / Wind Direction Sensor (R.M. Young Wind Monitor) 

3176-3103 Checklist Instruction – Weekly Station Visit 

Wind Speed / Wind Direction Sensor (Climatronics – No Translator) 

3176-3110 Checklist Instruction - Weekly Station Visit 

Temperature/ Delta Temperature Sensor (Climatronics) 

3176-3111 Checklist Instruction - Weekly Station Visit 

Temperature/Delta Temperature Sensor (R.M. Young) 

3176-3115 Checklist Instruction - Weekly Station Visit 

Air Temperature and Relative Humidity Sensor (Rotronics) 

3176-3116 Checklist Instruction – Weekly Station Visit 

Air Temperature and Relative Humidity Sensor (Vaisala) 

3176-3120 Checklist Instruction - Weekly Station Visit 

Relative Humidity Sensor (Rotronics) 

3176-3121 Checklist Instruction – Weekly Station Visit 

Relative Humidity Sensor (Vaisala) 

3176-3130 Checklist Instruction - Weekly Station Visit 

Solar Radiation Sensor (Climatronics) 

3176-3131 Checklist Instruction - Weekly Station Visit 

Solar Radiation Sensor (R.M. Young) 

3176-3132 Checklist Instruction – Weekly Station Visit 

Solar Radiation Sensor (Licor) 

3176-3150 Checklist Instruction - Weekly Station Visit 

Precipitation Sensor (Climatronics) 

3176-3151 Checklist Instruction - Weekly Station Visit 

Precipitation Sensor (Texas Electronics) 

3176-3153 Checklist Instruction - Weekly Station Visit 

Precipitation Sensor (RM Young) 
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3178 Station Operator Maintenance Procedures for Gaseous Monitoring 

Sites Using the DataView System 

F_SITEOPERATOR_AQSITE_2016Oct_F_1.0 

Site Operator Routine Visits 

3178-3116 Checklist Instruction - Weekly Station Visit 

Ozone Analyzer (TEI 49C) Ozone Calibrator (TEI 49C) 

CASTNet Dry Deposition 

3178-3315 Checklist Instruction - Multipoint Calibration 

Ozone Analyzer (TEI 49C) Ozone Calibrator (TEI 49C) 

II. INFORMATION MANAGEMENT CENTER (IMC) PROCEDURES

I_IMC_DATACOLL_2017Oct_F_1.0
Information Management Center - Data Collection 
I_IMC_DATAVAL_2019Jul_F_1.0
Information Management Center - Data Validation
I_IMC_RPTS_2019June_F_1.1
Information Management Center - Data Reporting and Dissemination
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III. FIELD MAINTENANCE AND CALIBRATION PROCEDURES

F_VISIT_MTCAL_AQSITE_F_1.1
Maintenance and Calibration Visit to an Ambient Air Monitoring Station

F_SITING_AQSITE_F_1.0
Siting an Ambient Air Quality Monitoring Station

F_GAS_MTCAL_Ozone-L2_F_1.0
Verification, Calibration and Maintenance of Ozone Analyzers Using Traveling 
Level 2 Ozone Transfer Standards 
F_MET_MTCAL_ATbath_F_1.0
Verification and Maintenance of Immersible Temperature Systems 
F_MET_MTCAL_ATRH_F_1.0
Verification and Maintenance of Ambient Temperature/Relative Humidity 
Sensors by Collocated Comparison

F_MET_MTCAL_RNF_2017Nov_F_1.0
Verification and Calibration of Tipping Precipitation Gauge

F_MET_MTCAL_SOL_F_1.0
Verification and Maintenance of Solar Radiation Sensors

F_MET_MTCAL_WD_F_1.0
Verification and Maintenance of Wind Direction Sensors

F_MET_MTCAL_WS_F_1.0
Verification and Maintenance of Wind Speed Sensors

F_GAS_MTCAL_O3TransferStd_F_1.0
Certification of Ozone Transfer Standards
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Checklist Instruction - Weekly Station Visit 
 
  •   Wind Speed/Wind Direction Sensor (Climatronics) 
 
Checklist Instruction Number: 3176-3100 
 
Revision Number / Date:   3 / January 2011  (last reviewed Jan. 2011) 
 
Objective: Weekly checks of the wind speed and wind direction are performed to verify the 

operational integrity of the sensors and sampling system and to verify that 
collected data appear reasonable. 

 
 
1. Inspect the wind sensors for damage. Report any damage to the OSC. 
 
 From the ground, inspect the Climatronics wind vane and anemometer. Look for damage 

to the aluminum cups or direction vane and make certain that the sensors turn smoothly. 
Report any damage to the Operation Support Center. 

 
2.  Note the current wind speed and wind direction measurements and compare them 

to your observations of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu. 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
  Press <R> for Display Readings w/units. 

ESC 88xx v5.31  ID:BL    Real Time Engineering Units     08/06/97  14:59:27 
 
 O3   = 38.23 (PPB )  
 O3 CAL = 1.434 (PPB ) 
 O3 R8  = 38.23 (PPB ) 
 VWD  = 46.61 (DEG ) 
 SIG  = 46.61 (DEG ) 
 VWS  = 0.6261 (M/S ) 
 SWS  = 0.6261 (M/S ) 
 PWS  = 2.036 (M/S ) 
 TMP  = 3.399 (DGC ) 
 DTP  = 0.06188 (DGC ) 
 SOL  = 100.3 (WMS ) 
 RNF  = 0 (MM ) 
 RH   = 66.83 (% ) 
 WET  = 100.4 (+/- ) 
 FLW  = 3.008 (SLPM ) 
 STP  = 21.48 (DGC ) 
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 Watch the VWD (vector wind direction) and SWS (scalar wind speed) for several 
updates to identify any current trends. Then observe the conditions outside the shelter. 
Compare what you see with the readings on the datalogger. Does it make sense?  If not, 
call the Operation Support Center to report the discrepancy. 

 
 Remember: The VWD is reported as the direction the wind is blowing from. 
 
 Note:  With experience you will develop an “eye” for judging whether the wind readings 

are representative of ambient conditions. The following figure and table may help in your 
effort. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Report conditions that affect data validity (e.g., ice or damage to the sensor) in the 

logbook. 
 
3. Take the VWD, VWS, and SWS offline in preparation to check the translator 

calibration responses. 
 
 To ensure that only ambient winds are recorded, it is necessary to mark the VWD, VWS, 

and SWS channels offline. Wind data marked in this manner are automatically excluded 
from the hourly average. 

 
 Begin at the Home Menu as shown below. Remember, pressing <Esc> several times 

returns to the Home Menu. 
 
 
 
 
 
 
 

Wind Speed 
m/s mph 
1.0 2.2 
5.0 11.2 
10.0 22.4 
15.0 33.6 
20.0 44.7 

North 
   0º 
 360º 

East 
 90º West 

 270º 

 180º 
 South 
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ESC 88xx v5.31  ID:BL         Home Menu          08/06/97  14:59:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 

 
 Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <M> for Disable/Mark Channel Offline: 
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ESC 88xx v5.31  ID:BL   Choose(Space Toggle/Enter Select)  08/06/97  14:59:27
 
 O3   [01]  
 O3CAL [02] 
 O3R8  [03] 
 VWD  [04] 
 SIG   [05] 
 VWS  [06] 
 SWS  [07] 
 PWS  [08] 
 TMP   [09] 
 DTP   [10] 
 SOL   [11] 
 RNF    [12] 
 RH   [13] 
 WET    [14] 
 FLW    [15] 
 STP    [16] 
 

  
 Use the ↑ and ↓ keys to navigate and the spacebar to select the VWD, VWS, and SWS 

channels for offline status. The VWD, VWS, and SWS channels should be marked with a 
">" indicating imminent offline status. Press <Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)  08/06/97  14:59:27 
 
  O3      [01]  
 O3CAL   [02] 
 O3R8    [03] 
 > VWD    [04] 
 SIG     [05] 
 > VWS     [06] 
 > SWS     [07] 
 PWS   [08] 
 TMP     [09] 
 DTP     [10] 
 SOL     [11] 
 RNF     [12] 
 RH    [13] 
 WET     [14] 
 FLW     [15] 
 STP     [16] 
 

 
 Check the status of the VWD, VWS, and SWS channels by pressing <Esc> several times 

until the Home Menu is displayed. Press <D> once to enter the Real-Time Display Menu. 
Press <F> to display the data channels with flags (or, press <F6> in any menu to display 
flags). VWD, VWS, and SWS should be flagged with a D to the right to indicate offline 
status. The offline time is automatically recorded in the logbook when this step is 
completed. 

 
4. Set the mode switch on the F-460 wind translator from OPER. to ZERO. Verify that 

the VWD zero response is between –2º and +2º and the SWS zero response is 
between 0.2 and 0.3 m/s. 

 
 The mode selector switch on the F-460 translator is normally in the OPER. position. The 

translator can be verified by setting the mode switch to ZERO and SPAN and comparing 
the responses to the limits above. 
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 Set the F-460 mode selector switch to ZERO. Observe the VWD and SWS until both 
have stabilized. Compare the observation to the limits. VWD must be between -2º and 
+2º. SWS must be between 0.2 and 0.3 m/s. Call the Operation Support Center if the 
response is out of tolerance. 

 
5. Set the mode switch on the F-460 wind translator from ZERO to SPAN. Verify that 

the VWD span response is between 358º and 362º and the SWS span response is 
between 24 and 26 m/s. 

 
 Set the F-460 mode selector switch to SPAN. Observe the VWD and SWS until both 

have stabilized. Compare the observation to the limits. VWD must be between 358º and 
362º. SWS must be between 24 and 26 m/s. Call the Operation Support Center if the 
response is out of tolerance. 

 
6. Set the mode switch to OPER. 
 
7. Bring the VWD, VWS, and SWS channels back online. 
 
 Bring the VWD, VWS, and SWS channels online by beginning at the Home Menu of the 

ESC datalogger. Remember that pressing <Esc> several times will return you eventually 
to the Home Menu. 

 
ESC 88xx v5.31  ID:BL         Home Menu          08/06/97  14:59:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 

 
 Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL        Configuration Menu         08/06/97    14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97     14:59:27
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for  Enable/Mark Channel Online. VWD, VWS, and SWS should be the only 

channels displayed. 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
  > VWD     [04]  
    VWS     [06] 
 SWS     [07] 
 
 
 

 Use the ↑ and ↓ keys to navigate and the spacebar to select a channel. Repeat the process 
until all channels are marked as shown below. Press <Enter> to put the selected channels 
online. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
 
   > VWD     [04]  
   > VWS     [06] 
 > SWS     [07] 
 
 
 
 
 

 
 Check the status of the VWD, VWS, and SWS channels by pressing <Esc> several times 

until the Home Menu is displayed. Press <D> once to enter the Real-Time Display Menu. 
Press <F> once to display the data channels with flags (or, press <F6> in any menu to 
display flags). VWD, VWS, and SWS will no longer by marked with flags indicating 
online status; a P may be in the flag column for each channel indicating a purge period 
programmed to allow for the time it takes for ambient conditions to prevail. The P flag 
should clear within one minute. The online time is automatically recorded in the logbook 
when this step is completed. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Wind Speed/Wind Direction Sensor (R.M. Young Wind Monitor) 
     
Checklist Instruction Number: 3176-3101 
 
Revision Number / Date:   3 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the wind speed and wind direction are performed to verify the 

operational integrity of the sensors and sampling system and to verify that collected 
data appear reasonable. 

 
 
1.  Inspect the wind sensor for physical damage. Report any damage to the OSC. 
 
 From the ground, inspect the R.M. Young wind sensor propeller/vane assembly. Look for 

damage to the plastic propeller and make certain that the propeller is turning smoothly. 
Look for other circumstances that could affect data validity such as an accumulation of 
ice. Report any damage to the Operation Support Center and enter your observations in 
the logbook. 

 
2.  Compare the current wind speed and wind direction measurements to your 

observations of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu. 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97    14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
 Press <R> for Display Readings w/units. 
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ESC 88xx v5.31  ID:BL    Real Time Engineering Units        08/06/97  14:59:27 
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the VWD (vector wind direction) and SWS (scalar wind speed) for several 

updates to identify any current trends. Then observe the conditions outside the shelter. 
Compare what you see with the readings on the datalogger. Does it make sense?  If not, 
call the Operation Support Center to report the discrepancy. 

 
 Remember:  The VWD is reported as the direction wind is blowing from. 
 
 Note:  With experience you will develop an “eye” for judging whether the wind readings 

are representative of the ambient conditions. The following table and figure may help in 
your effort. 

 
 
 
 

Wind Speed 
m/s mph 
1.0 2.2 
5.0 11.2 
10.0 22.4 
15.0 33.6 
20.0 44.7 

 

    North 
 0º or 360º 

180º 
South 

West
270º

East 
90º 
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Checklist Instruction - Weekly Station Visit 
 
  •   Wind Speed/Wind Direction Sensor (Climatronics-No Translator) 
 
Checklist Instruction Number: 3176-3103 
 
Revision Number / Date:   0 / April 2006   
 
 
Objective: Weekly checks of the wind speed and wind direction are performed to verify the 

operational integrity of the sensors and sampling system and to verify that 
collected data appear reasonable. 

 
 
1. Inspect the wind sensors for damage.  Report any damage to the OSC. 
 
 From the ground, inspect the Climatronics wind vane and anemometer.  Look for damage 

to the aluminum cups or direction vane and make certain that the sensors turn smoothly.  
Report any damage to the Operation Support Center (OSC). 

 
2.  Note the current wind speed and wind direction measurements and compare them 

to your observations of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu. 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
  Press <R> for Display Readings w/units. 
 

ESC 88xx v5.31  ID:BL    Real Time Engineering Units     08/06/97  14:59:27 
 
 O3   = 38.23 (PPB )  
 O3 CAL = 1.434 (PPB ) 
 O3 R8  = 38.23 (PPB ) 
 VWD  = 46.61 (DEG ) 
 SIG  = 46.61 (DEG ) 
 VWS  = 0.6261 (M/S ) 
 SWS  = 0.6261 (M/S ) 
 PWS  = 2.036 (M/S ) 
 TMP  = 3.399 (DGC ) 
 DTP  = 0.06188 (DGC ) 
 SOL  = 100.3 (WMS ) 
 RNF  = 0 (MM ) 
 RH   = 66.83 (% ) 
 WET  = 100.4 (+/- ) 
 FLW  = 3.008 (SLPM ) 
 STP  = 21.48 (DGC ) 
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 Watch the VWD (vector wind direction) and SWS (scalar wind speed) for several 
updates to identify any current trends.  Then observe the conditions outside the shelter.  
Compare what you see with the readings on the datalogger.  Does it make sense?  If not, 
call the OSC to report the discrepancy. 

 
 Remember: The VWD is reported as the direction the wind is blowing from. 
 
 Note:  With experience you will develop an “eye” for judging whether the wind readings 

are representative of ambient conditions.  The following figure and table may help in 
your effort. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Report conditions that affect data validity (e.g., ice or damage to the sensor) in the 

logbook. 
 
 

Wind Speed 
m/s mph 
1.0 2.2 
5.0 11.2 
10.0 22.4 
15.0 33.6 
20.0 44.7 

North 
   0º 
 360º 

East 
 90º West 

 270º 

 180º 
 South 
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Checklist Instruction - Weekly Station Visit 
 
  •   Temperature/Delta Temperature Sensor (Climatronics) 
 
Checklist Instruction Number:   3176-3110 
 
Revision Number / Date:   3 / January 2011  (last reviewed Jan. 2011) 
 
Objective: Weekly checks of the temperature and delta temperature system are performed to 

verify the operational integrity of the temperature sensors and aspirators, and to 
verify that collected data appear reasonable. 

 
 
1.  Verify that the lower temperature sensor housing aspirator fan is operational. 
 
 Two ambient air temperature sensor housings are on the meteorological tower. The first 

is positioned at 10 meters above ground level and houses the primary temperature sensor 
represented by the channel name TMP in the datalogger. The second housing contains the 
sensor that measures air temperature at 2 meters above ground level. The delta 
temperature, or DTP as labeled in the datalogger, is derived from subtracting 2-meter 
temperature from 10-meter temperature (top minus bottom). 

 
 Both temperature sensors have a fan aspirated housing. The 2-meter housing is close 

enough to the ground that the fan can be heard. Listen for the sound of the fan. If it has 
failed, call the Operation Support Center. 

  
2.  Note the current temperature and delta temperature measurements and compare to 

your observation of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu. 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
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 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Uints     08/06/97  14:59:27    
 
 O3= 38.23 (PPB )  
 O3 CAL = 1.434 (PPB ) 
 O3 R8= 38.23 (PPB ) 
 VWD= 46.61 (DEG ) 
 SIG= 46.61 (DEG ) 
 VWS= 0.6261 (M/S ) 
 SWS= 0.6261 (M/S ) 
 PWS= 2.036 (M/S ) 
 TMP= 3.399 (DGC ) 
 DTP= 0.06188 (DGC ) 
 SOL= 100.3 (WMS ) 
 RNF= 0  (MM ) 
 RH= 66.83 (% ) 
 WET= 100.4 (+/- ) 
 FLW= 3.008 (SLPM ) 
 STP= 21.48 (DGC ) 
 

 
 Watch the TMP and DTP reading for several updates to identify the current values. Delta 

temperature should be between -5º C and +5º C or beyond at some sites. Negative values 
are typical on bright sunny days, closer to zero on cloudy days, and positive numbers at 
night. Snow cover, complex terrain, and high winds will affect typical values. 

 
 Observe the conditions outside the shelter. Compare what you see with the reading on the 

datalogger. Does it make sense?  If not, call the Operation Support Center to report the 
discrepancy. 

 
 Note:  With experience you will develop a feel for judging whether the TMP reading is 

representative of the ambient observation. Remember that the sun can make it seem 
warmer and wind can make it seem cooler. Use the conversion chart below for help. 

 
Temperature 

ºC  ºF 
-30  -22 
-20  -4 
-10  14 
0  32 
10  50 
20  68 
30  86 
40  104 

 
 Report conditions that affect validity (e.g., aspirator fan failure) in the logbook. 
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3.  Take the TMP and DTP offline in preparation to check the translator calibration 
responses. 

 
 To ensure that only ambient temperatures are recorded in the hourly average, it is 

necessary to mark the TMP and DTP channels offline. Temperature data marked in this 
manner are automatically excluded from the hourly average. 

 
 Begin at the Home Menu as shown below. Remember, pressing <Esc> several times 

returns to the Home Menu. 
 

ESC 88xx v5.31  ID:BL         Home Menu          08/06/97  14:59:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 
 

 
 Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
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 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97 14:59:27 
 
 O3  [01]  
 O3CAL [02] 
 O3R8  [03] 
 VWD [04] 
 SIG   [05] 
 VWS [06] 
 SWS [07] 
 TMP  [08] 
 DTP   [09] 
 SOL   [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select the TMP and DTP channels 

for offline status. The TMP and DTP channels should be marked with a ">" indicating 
imminent offline status. Press <Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
  O3      [01]  
 O3CAL   [02] 
 O3R8    [03] 
   VWD   [04] 
 SIG     [05] 
   VWS     [06] 
   SWS     [07] 
  >  TMP     [08] 
  >  DTP     [09] 
 SOL     [10] 
 RNF     [11] 
 WET     [12] 
 FLW     [13] 
 STP     [14] 
 

 
 Check the status of the TMP and DTP channels by pressing <Esc> several times until the 

Home Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press 
<F> to display the data channels with flags (or, press <F6> in any menu to display flags). 
TMP and DTP should be marked with a D flag to the right to indicate offline status. The 
offline time is automatically recorded in the logbook when this step is completed. 

 
4.  Set the mode switch on the TEMP/DELTA TEMP translator from OPER. to ZERO. 

Verify that the TMP and DTP zero responses are within the ranges indicated on the 
sticker affixed to the translator. 

 
 The mode selector switch on the temp/Δtemp translator is normally in the OPERATE 

position. The calibration of the translator can be verified by setting the mode switch to 
ZERO and SPAN and comparing the responses to the limits below. 
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OPERATE

Z
E
R
O

S
P
A
N

CLIMATRONICS

OPERATE

Z
E
R
O

S
P
A
N

CLIMATRONICS

OPERATE

Z
E
R
O

S
P
A
N

OPERATE

Z
E
R
O

S
P
A
N

CLIMATRONICS

TEMP/DELTA TRADIATION

 
 

 Set the temp/Δtemp mode selector switch to ZERO. Observe the TMP and DTP until 
both have stabilized. Compare the values to those indicated on the sticker affixed to the 
translator card. Call the Operation Support Center if the response is out of tolerance. 

 
5.  Set the mode switch on the TEMP/DELTA TEMP translator from ZERO to SPAN. 

Verify that the TMP and DTP span responses are within the ranges indicated on the 
calibration sticker affixed to the front of the translator. 

 
 Set the temp/delta temp mode selector switch to SPAN. Observe the TMP and DTP until 

both have stabilized. Compare the observation to the limits. The ranges are indicated on 
the sticker affixed to the front of the translator. Call the Operation Support Center if the 
response is out of tolerance. 

 
6.  Set the mode switch to OPER. 
 
7.  Bring the TMP and DTP channels back online. 
 
 Bring the TMP and DTP channels online by beginning at the Home Menu of the ESC 

datalogger. Remember that pressing <Esc> several times you will eventually return to the 
Home Menu. 
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ESC 88xx v5.31  ID:BL         Home Menu          08/06/97  14:59:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 
 
 

 
 Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 
 
 

 
 Press <E> for  Enable/Mark Channel Online. TMP and DTP should be the only channels 

displayed. 
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ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
  > TMP     [04]  
    DTP     [06] 
  
 
 
 
 
 
 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select a channel. Press the 

<Spacebar> to select both for online status. Press <Enter> to put the selected channels 
online. 

 
 
 
 
 
 
 
 
  
 
 
 Check the status of the TMP and DTP channels by pressing <Esc> several times until the 

Home Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press  
<F> once to display the data channels with flags (or, press <F6> in any menu to display 
flags). TMP and DTP will no longer by marked with a flag indicating online status, or a P 
will be in the flag column for each indicating a purge period programmed to allow for the 
time it takes for ambient conditions to prevail. The P flag should clear within one minute. 
The online time will automatically recorded in the logbook when this step is completed. 

 
 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
   > TMP     [04]  
   > DTP     [06] 
  
 
 
 
 
 
 
 
 



Checklist Instruction: 3176-3111                                 January 2006                                                           Page 1 of 2 

Checklist Instruction - Weekly Station Visit 
 
  •   Temperature/Delta Temperature Sensor (R.M. Young) 
 
Checklist Instruction Number: 3176-3111 
 
Revision Number / Date:   2 /January 2006  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the temperature/delta temperature system are performed to verify 

the operational integrity of the temperature sensors and aspirators, and to verify that 
collected data appear reasonable. 

 
1.  Verify that the lower temperature sensor housing aspirator fan is operational. 
 
 Two ambient air temperature sensor housings are mounted to the meteorological tower.  

The first is positioned at 10 meters above ground level and houses the primary 
temperature sensor represented by the channel name TMP in the datalogger.  The second 
housing contains the sensor that measures air temperature at 2 meters above ground level.  
The delta temperature is derived by subtracting 2-meter temperature from 10-meter 
temperature (top minus bottom) and is represented by the channel name DTP in the 
datalogger. 

 
 Both temperature sensors have a fan aspirated housing.  The 2-meter housing is close 

enough to the ground that the fan can be heard.  Listen for the sound of the fan.  If it has 
failed, call the Operation Support Center and enter your observations in the logbook. 

  
2.  Compare current TMP and DTP measurements to your observation of ambient 

conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
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 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Uints     08/06/97  14:59:27   
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the TMP and DTP reading for several updates to identify the current values.  Delta 

temperature should be between -5º C and +5º C.  Negative values are typical on bright 
sunny days, closer to zero on cloudy days, and positive values at night.  Snow cover, 
complex terrain, and high winds will affect typical values. 

 
 Observe the conditions outside the shelter.  Compare what you see with the reading on 

the datalogger.  Does it make sense?  If not, call the OSC to report the discrepancy and 
enter your observations in the logbook. 

 
 Note: With experience you will develop a feel for judging whether the TMP reading is 

representative of the ambient observation.  Remember that the sun can make it seem 
warmer and wind can make it seem cooler.  Use the conversion chart below for 
assistance. 

 
Temperature 

ºC  ºF 
-30  -22 
-20  -4 
-10  14 
0  32 
10  50 
20  68 
30  86 
40  104 

 
 
 Report any conditions that affect validity (e.g., aspirator fan failure) in the logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Air Temperature and Relative Humidity Sensor (Rotronics) 
 
Checklist Instruction Number: 3176-3115 
 
Revision Number / Date:   1 / January 2006  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the air temperature and relative humidity system are performed to 

verify the operational integrity of the relative humidity sensor and aspirator, and to 
verify that collected data appear reasonable.  

 
 
1. Verify the air temperature and relative humidity sensor housing is operational. 
 
 An air temperature/relative humidity sensor aspirator housing is mounted to the 

meteorological tower.  In most cases this aspirator is forced-aspirated by a fan.  If the 
aspirator is the fan-type, listen for the fan’s operation. 

 
 If a "natural aspirated" fan is in use, make sure it is secure and in good condition.  Call 

the Operation Support Center if problems are detected. 
 
2.  Compare the current air temperature and relative humidity measurement to your 

observation of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
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 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Units     08/06/97  14:59:27 
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the TMP (air temperature) and RH (relative humidity) reading for several updates 

to identify any current trends.  Observe the conditions outside the shelter.  Compare what 
you see with the reading on the datalogger.  Does it make sense?  If not, call the 
Operation Support Center to report any discrepancy and enter your observations in the 
logbook.  Also note any other conditions that could affect validity of the air temperature 
or relative humidity data and enter your observations in the logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Air Temperature and Relative Humidity Sensor (Vaisala) 
 
Checklist Instruction Number: 3176-3116 
 
Revision Number / Date:   1 / January 2006  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the air temperature and relative humidity system are performed to 

verify the operational integrity of the relative humidity sensor and aspirator, and to  
verify that collected data appear reasonable.  

 
 
1. Verify the air temperature and relative humidity sensor housing is operational. 
 
 An air temperature/relative humidity sensor aspirator housing is mounted to the 

meteorological tower.  In most cases this aspirator is forced-aspirated by a fan.  If the 
aspirator is the fan-type, listen for the fan’s operation. 

 
 If a "natural aspirated" fan is in use, make sure it is secure and in good condition.  Call 

the Operation Support Center if problems are detected. 
 
2.  Compare the current air temperature and relative humidity measurement to your 

observation of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
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 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Units     08/06/97  14:59:27 
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 

 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the TMP (air temperature) and RH (relative humidity) reading for several updates 

to identify any current trends.  Observe the conditions outside the shelter.  Compare what 
you see with the reading on the datalogger.  Does it make sense?  If not, call the 
Operation Support Center to report any discrepancy and enter your observations in the 
logbook.  Also note any other conditions that could affect validity of the air temperature 
or relative humidity data and enter your observations in the logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Relative Humidity Sensor (Rotronics) 
 
Checklist Instruction Number: 3176-3120 
 
Revision Number / Date:   2 / January 2011                         (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the relative humidity system are performed to verify the 

operational integrity of the relative humidity sensor and aspirator, and to verify that 
collected data appear reasonable.  

 
 
1. Verify the air temperature and relative humidity sensor housing is operational. 
 
 An air temperature/relative humidity sensor aspirator housing is mounted to the 

meteorological tower. In most cases this aspirator is forced-aspirated by a fan. If the 
aspirator is the fan-type, listen for the fan’s operation. 

 
 If a "natural aspirated" fan is in use, make sure it is secure and in good condition. Call the 

Operation Support Center if problems are detected. 
 
2.  Compare the current relative humidity measurement to your observation of 

ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
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 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Uints     08/06/97  14:59:27  
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 
 Watch the RH (relative humidity) reading for several updates to identify any current 

trends. Observe the conditions outside the shelter. Compare what you see with the 
reading on the datalogger. Does it make sense?  If not, call the Operation Support Center  
to report any discrepancy and enter your observations in the logbook. Also note any other 
conditions that could affect validity of the relative humidity data and enter your 
observations in the logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Relative Humidity Sensor (Vaisala) 
 
Checklist Instruction Number: 3176-3121 
 
Revision Number / Date:   2 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the relative humidity system are performed to verify the 

operational integrity of the relative humidity senso and aspirator, and to verify that 
collected data appear reasonable.  

 
 
1. Verify the air temperature and relative humidity sensor housing is operational. 
 
 An air temperature/relative humidity sensor aspirator housing is mounted to the 

meteorological tower. In most cases this aspirator is forced-aspirated by a fan. If the 
aspirator is the fan-type, listen for the fan’s operation. 

 
 If a "natural aspirated" fan is in use, make sure it is secure and in good condition. Call the 

Operation Support Center if problems are detected. 
 
 
2.  Compare the current relative humidity measurement to your observation of 

ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27
  
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
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 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Real-Time Engineering Units     08/06/97  14:59:27
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 
 Watch the RH (relative humidity) reading for several updates to identify any current 

trends. Observe the conditions outside the shelter. Compare what you see with the 
reading on the datalogger. Does it make sense?  If not, call the Operation Support Center 
to report any discrepancy and enter your observations in the logbook. Also note any other 
conditions that could affect validity of the relative humidity data and enter your 
observations in the logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Solar Radiation Sensor (Climatronics) 
 
Checklist Instruction Number: 3176-3130 
 
Revision Number / Date:   2 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the solar radiation system are performed to verify the 

operational integrity of the solar radiation system, to clean the sensor, and to verify 
that collected data appear reasonable. 

 
1.  Inspect the solar radiation sensor for dirt or snow if your sensor is at a height to 

reach. Clean the sensor if required. 
 
 Locate your solar radiation sensor; most air quality station sensors are on the tower. 

Inspect the sensor for dirt, snow, etc. The sensor can be cleaned with a broom to remove 
snow or a Kimwipe with water to remove dirt. 

 
2.  Note the current solar radiation measurement and compare it to your observations 

of ambient conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
  

  
 Press <R> for Display Readings w/units: 
 

ESC 88xx v5.31  ID:BL    Display Last Base Avg.    08/06/97     14:59:27     
 
 O3= 38.23 (PPB )  
 O3 CAL = 1.434 (PPB ) 
 O3 R8= 38.23 (PPB ) 
 VWD= 46.61 (DEG ) 
 SIG= 46.61 (DEG ) 
 VWS= 0.6261 (M/S ) 
 SWS= 0.6261 (M/S ) 
 PWS= 2.036 (M/S ) 
 TMP= 3.399 (DGC ) 
 DTP= 0.06188 (DGC ) 
 SOL= 100.3 (WMS ) 
 RNF= 0  (MM ) 
 RH= 66.83 (% ) 
 WET= 100.4 (+/- ) 
 FLW= 3.008 (SLPM ) 
 STP= 21.48 (DGC ) 
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 Watch the SOL (solar radiation) reading for several updates to identify any current 
trends. Observe the conditions outside the shelter. Compare what you see with the 
reading on the datalogger. Does it make sense?  If not, call the Operation Support Center 
to report the discrepancy.  

 
 Note:  With experience you will develop and “eye” for judging whether the SOL reading 

is representative of the ambient observation. Remember that the solar radiation varies 
with time of day, sky conditions, and season. 

 
 Report conditions that affect data validity (e.g., snow found on the sensor) in the logbook. 
 
3. Take the SOL offline in preparation to check the translator responses.  
 
 To ensure that only ambient solar conditions are included in the hourly average, it is 

necessary to mark the SOL channel offline. Solar radiation data marked in this manner 
are automatically excluded from the hourly averages. 

 
 Begin at the Home Menu as shown below. Remember, pressing <Esc> several times 

returns to the Home Menu. 
 

ESC 88xx v5.31  ID:BL         Home Menu          08/06/97     14:59:27     
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 

 
 Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27          
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D>, for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27      
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
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 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3   [01]  
 O3CAL [02] 
 O3R8  [03] 
 VWD  [04] 
 SIG   [05] 
 VWS  [06] 
 SWS  [07] 
 TMP  [08] 
 DTP   [09] 
 SOL   [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select the SOL channel for offline 

status. The channel should be marked with a ">" indicating imminent offline status. Press 
<Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
   O3      [01]  
 O3CAL   [02] 
 O3R8    [03] 
    VWD    [04] 
 SIG     [05] 
  VWS     [06] 
  SWS     [07] 
 TMP     [08] 
 DTP     [09] 
  > SOL     [10] 
 RNF     [11] 
 WET     [12] 
 FLW     [13] 
 STP     [14] 
 

 
 Check the status of the SOL channel by pressing <Esc> several times until the Home 

Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags (or, press <F6> in any menu to display flags). SOL 
should be marked with a D flag to the right to indicate offline status. The offline time will 
be recorded in the logbook automatically when this step is complete. 

 
4.  Set the mode selector switch on the RADIATION translator from OPER. to ZERO. 

Verify that the SOL zero response is between –5 and +5.  
  
 The mode selector switch on the radiation translator is normally in the OPER. position. 

The calibration of the translator can be verified by setting the mode selector switch to 
ZERO and SPAN and comparing the responses to the limits below. 

 
 Set the mode selector switch to ZERO. Observe the SOL until stabilized. Compare the 

observation to the limits. SOL must be between -5 and +5. 
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5.  Set the mode switch on the RADIATION translator from ZERO to SPAN. Verify 
that the SOL span response is between 1391 and 1401. 

 
 Set the mode selector switch to SPAN. Observe until stabilized. Compare the observation 

to the limits. SOL must be within 1391 and 1401. Call the Operation Support Center if 
the response is out of tolerance. 

 

OPERATE
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N

CLIMATRONICS

OPERATE
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A
N

CLIMATRONICS

OPERATE

Z
E
R
O
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P
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OPERATE

Z
E
R
O

S
P
A
N

CLIMATRONICS

RADIATIONTEMPERATURE

 
6.  Set the mode switch to OPER. 
 
7.  Bring the SOL channel back online. 
 
 Bring the SOL channel online by beginning at the Home Menu of the ESC datalogger. 

Remember that pressing <Esc> several times you will return eventually to the Home Menu. 
 

ESC 88xx v5.31  ID:BL         Home Menu          08/06/97  14:59:27       
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
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Press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27          
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27      
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 
 
 

  
 Press <E> for Enable/Mark Channel Online. SOL should be the only channel displayed. 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
  > SOL    [04]  
     
 
 
 
 
 
 
 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select a channel. Press <Enter> to 

put the selected channel online. 
 
 Check the status of the SOL channel by pressing <Esc> several times until the Home 

Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> 
once to display the data channels with flags (or, press <F6> in any menu to display 
flags). SOL will no longer by marked with a flag indicating online status; a P may be in 
the flag column indicating a purge period programmed to allow for the time it takes for 
ambient conditions to prevail. The P flag should clear within one minute. The online time 
will automatically recorded in the logbook when this step is completed. 



Checklist Instruction: 3176-3131                                 January 2011                                                            Page 1 of 2 

Checklist Instruction - Weekly Station Visit 
 
  •   Solar Radiation Sensor (R.M. Young) 
 
Checklist Instruction Number: 3176-3131 
 
Revision Number / Date:   2 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the solar radiation system are performed to verify the operational 

integrity of the solar radiation system, to clean the sensor, and to verify that 
collected data appear reasonable. 

 
1.  Inspect the solar radiation sensor for dirt or snow if your sensor is at a height to 

reach. Clean the sensor if required. Also check the leveling bubble. 
 
 Locate your solar radiation sensor; most air quality station sensors are on a tower. Inspect 

the sensor for dirt, snow, etc. If the sensor can be reached, carefully remove snow from 
the sensor and clean the sensor with a water-dampened Kimwipe to remove dust and dirt. 
Also check the leveling bubble to verify it is level. 

 
2. Compare the current solar radiation measurement to your observations of ambient 

conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

  
 Press <R> for Display Readings w/units: 
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ESC 88xx v5.31  ID:BL    Display Last Base Avg.    08/06/97  14:59:27           
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the SOL (solar radiation) reading for several updates to identify any current 

trends. Observe the conditions outside the shelter. Compare what you see with the 
reading on the datalogger. Does it make sense?  If not, call the Operation Support Center 
to report the discrepancy and enter your observations in the logbook.  

 
 Note:  With experience you will develop and “eye” for judging whether the SOL reading 

is representative of the ambient observation. Remember that the solar radiation varies 
with time of day, sky conditions, and season. 

 
 Report any conditions that affect data validity (e.g., snow found on the sensor) in the 

logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Solar Radiation Sensor (Licor) 
 
Checklist Instruction Number: 3176-3132 
 
Revision Number / Date:   2 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the solar radiation system are performed to verify the operational 

integrity of the solar radiation system, to clean the sensor, and to verify that 
collected data appear reasonable. 

 
1.  Inspect the solar radiation sensor for dirt or snow if your sensor is at a height to 

reach. Clean the sensor if required. Also check leveling bubble. 
 
 Locate your solar radiation sensor; most air quality station sensors are on a tower. Inspect 

the sensor for dirt, snow, etc. If the sensor can be reached, carefully remove snow from 
the sensor and clean the sensor with a water-dampened Kimwipe to remove dust and dirt. 
Also check the leveling bubble to verify it is level. 

 
2. Compare the current solar radiation measurement to your observations of ambient 

conditions. 
 
 From the Home Menu on the ESC datalogger, press <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
  

  
 Press <R> for Display Readings w/units: 
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ESC 88xx v5.31  ID:BL    Display Last Base Avg.    08/06/97  14:59:27 
 
 O3 = 38.23 (PPB )  
 O3CAL = 1.434 (PPB ) 
 O3R8 = 38.23 (PPB ) 
 VWD = 46.61 (DEG ) 
 SIG = 46.61 (DEG ) 
 VWS = 0.6261 (M/S ) 
 SWS = 0.6261 (M/S ) 
 PWS = 2.036 (M/S ) 
 TMP = 3.399 (DGC ) 
 DTP = 0.06188 (DGC ) 
 SOL = 100.3 (WMS ) 
 RNF = 0 (MM ) 
 RH = 66.83 (% ) 
 WET = 100.4 (+/- ) 
 FLW = 3.008 (SLPM ) 
 STP = 21.48 (DGC ) 
 

 
 Watch the SOL (solar radiation) reading for several updates to identify any current 

trends. Observe the conditions outside the shelter. Compare what you see with the 
reading on the datalogger. Does it make sense?  If not, call the Operation Support Center 
to report the discrepancy and enter your observations in the logbook.  

 
 Note:  With experience you will develop and “eye” for judging whether the SOL reading 

is representative of the ambient observation. Remember that the solar radiation varies 
with time of day, sky conditions, and season. 

 
 Report any conditions that affect data validity (e.g., snow found on the sensor) in the 

logbook. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Precipitation Sensor (Climatronics) 
 
Checklist Instruction Number: 3176-3150 
 
Revision Number / Date:   3 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the precipitation system (tipping bucket rain gauge) are 

performed to verify the operational integrity of the system, inspect and clean the 
funnel if necessary, verify the operation of the tipping mechanism and heater, and to 
verify that collected data appear reasonable. 

 
1.  Take the RNF (rainfall or precipitation) channel offline for operational checks. 
 
 The checks required to assure proper precipitation gauge operation will generate false 

RNF readings; therefore, the RNF channel must be taken offline.  
 
 From the Home Menu on the ESC datalogger, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
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 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys and the spacebar to select the RNF channel for offline status. The 

RNF channel should be marked with a ">" indicating imminent offline status. Press  
<Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 > RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
Check the status of the RNF channel by pressing <Esc> several times until the Home 
Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags (or, press <F6> in any menu to display flags). RNF 
should be marked with a D flag to the right to indicate offline status. The offline time will 
automatically be recorded in the logbook when this step is completed. 

 
2.  Inspect the precipitation gauge collection funnel for snow or debris.  

 
Inspect the collection funnel and remove any foreign objects (e.g., leaves, bugs, etc.) call 
the Operation Support Center if there is unmelted snow in the funnel. This indicates a 
failure of the heating system. Record significant findings in the logbook. 
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3.  Once a month perform a calibration check. 
 

Verify the channel is still down and start the check just after the top of the hour. Fill the 
graduated cylinder with water. Place the black calibration funnel into the sensor and pour 
water from the graduated cylinder into the black funnel. At the completion of the check 
and in the next hour, log into the datalogger and check the RNF total. The value/result 
should be between 9.1 and 11.1. Remove the funnel after the check has completed. 

 
4.  Bring the RNF back online and record the value. 
 
 From the Home Menu press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for Enable/Mark Channel Online: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
 RNF    [11] 
  
 
  
  
  
 
 

 
Press ↑ and ↓ to highlight a channel(s). Press the <Spacebar> to select it for online 
status. Press  <Enter> to put the marked channel(s) online. 

 
 Check the status of the RNF channel by pressing <Esc> several times until the Home 

Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags. RNF should be marked with a D flag to the right to 
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indicate offline status that will clear after one minute. The online time will automatically 
be recorded in the logbook when this task is completed. Enter the total value of the 10-tip 
check onto the checklist. The value will automatically be entered into the logbook when 
this step is completed. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Precipitation Sensor (Texas Electronics) 
 
Checklist Instruction Number: 3176-3151 
 
Revision Number / Date:   2 / January 2011  (last reviewed Jan. 2011) 
 
 
Objective: Weekly checks of the precipitation system (tipping bucket rain gauge) are 

performed to verify the operational integrity of the system, inspect and clean the 
funnel if necessary, verify the operation of the tipping mechanism and heater, and to 
verify that collected data appear reasonable. 

 
1.  Take the RNF (rainfall or precipitation) channel offline for operational checks. 
 
 The checks required to assure proper precipitation gauge operation will generate false 

RNF readings; therefore, the RNF channel must be taken offline.  
 
 From the Home Menu on the ESC datalogger, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88x v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
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 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys and the spacebar to select the RNF channel for offline status. The 

RNF channel should be marked with a ">" indicating imminent offline status. Press  
<Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 > RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
Check the status of the RNF channel by pressing <Esc> several times until the Home 
Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags (or, press <F6> in any menu to display flags). RNF 
should be marked with a D flag to the right to indicate offline status. The offline time will 
automatically be recorded in the logbook when this step is completed. 

 
2.  Inspect the precipitation gauge collection funnel for snow or debris.  

 
Inspect the collection funnel and remove any foreign objects (e.g., leaves, bugs, etc.) call 
the Operation Support Center if there is unmelted snow in the funnel. This indicates a 
failure of the heating system. Record significant findings in the logbook. 
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3.  Once a month perform a calibration check. 
 

Verify the channel is still down and start the check just after the top of the hour. Fill the 
graduated cylinder with water. Place the black calibration funnel into the sensor and pour 
water from the graduated cylinder into the black funnel. At the completion of the check 
and in the next hour, log into the datalogger and check the RNF total. The value/result 
should be between 9.1 and 11.1. Remove the funnel after the check has completed. 

 
4.  Bring the RNF back online and record the value. 
 
 From the Home Menu press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for Enable/Mark Channel Online: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 RNF    [11] 
  
 
 
  
  
  
 
 

 
Press ↑ and ↓ to highlight a channel(s). Press the <Spacebar> to select it for online 
status. Press  <Enter> to put the marked channel(s) online. 
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 Check the status of the RNF channel by pressing <Esc> several times until the Home 
Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags. RNF should be marked with a D flag to the right to 
indicate offline status that will clear after one minute. The online time will automatically 
be recorded in the logbook when this task is completed. Enter the total value of the 10-tip 
check onto the checklist. The value will automatically be entered into the logbook when 
this step is completed. 
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Checklist Instruction - Weekly Station Visit 
 
  •   Precipitation Sensor (RM Young) 
 
Checklist Instruction Number: 3176-3153 
 
Revision Number / Date:   1 / March 2011      (last reviewed Mar. 2011) 
 
 
Objective: Weekly checks of the precipitation system (tipping bucket rain gauge) are 

performed to verify the operational integrity of the system, inspect and clean the 
funnel if necessary, and to verify that collected data appear reasonable. 

 
1.  Review RNF data since last visit and compare values with known precipitation 

events. 
 
 Verify actual precipitation events (rain or snow) that have occurred since your last visit 

were recorded by the ESC datalogger, and/or displayed on STKPLOT in DataView. 
 
 If the data appear reasonable, complete Step 2 of this checklist and bypass Steps 3 

through 5. If data appear to be missing, complete all steps of this checklist. 
 
2.  Inspect the precipitation gauge collection funnel for snow or debris.  

 
Inspect the collection funnel and remove any foreign objects (e.g., leaves, bugs, etc.) call 
the Operation Support Center if there is unmelted snow in the funnel. This indicates a 
failure of the heating system. Record significant findings in the logbook. 

 
3. Take the RNF channel offline for operational checks. 
 
 If data appear to be missing verify rain gauge operations, but first the RNF channel must 

be taken offline. 
 
 From the Home Menu on the ESC datalogger, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 
 
 
 

 
 Press <M> for Disable/Mark Channel Offline: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
 Use the ↑ and ↓ keys and the spacebar to select the RNF channel for offline status. The 

RNF channel should be marked with a “>” indicating imminent offline status. Press  
<Enter> to take the marked channel offline. 

 
ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)    08/06/97  4:59:27
 
 O3     [01]  
 O3CA   [02] 
 O3R8   [03] 
 VWD [04] 
 SIG    [05] 
 VWS    [06] 
 SWS    [07] 
 TMP    [08] 
 DTP    [09] 
 SOL    [10] 
 > RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
 

 
Check the status of the RNF channel by pressing <Esc> several times until the Home 
Menu is displayed. Press <D> once to enter the Real-Time Display Menu. Press <F> to 
display the data channels with flags (or, press <F6> in any menu to display flags). RNF 
should be marked with a D flag to the right to indicate offline status. The offline time will 
automatically be recorded in the logbook when this step is completed. 
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4.  Pour water into the precipitation gauge, observe results. 
 
 From the Home Menu select <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
 Press <C> for Continuous Avg Report: 
 

ESC 88xx v5.31  ID:BL      Continuous Avg Report Setup       08/06/97  14:59:27
 
  
 Average Interval : 1m    
 Show Channels : O3,O3CAL,RNF  
 
 
 
 # of Flags to Report : 02 
 Use Decimal Positioner? : Y 
 Start Continuous Report 
 

 
Enter a 1 and then m for the Average Interval if it has not defaulted to the 1m.  Use the ↑ 
and ↓ keys and the spacebar to select Show Channels. Type RNF if it is not already 
displayed. Navigate down to Start Continuous Report and press <Enter>. 

 
 
  
  
 TIME O3 O3CAL RNF 
 
 10/19 11:19 41. -1.  0.0 
 
 
 
  
 
 

 
The data line will update and append once per minute.  This screen allows the operator to 
leave the shelter, pour water into the rain gauge and return to the shelter to read the 
resulting “precipitation.” 

 
 Slowly pour a small volume of water (~20ml) into the rain gauge. Listen carefully for the 

buckeyes to tip. Attempt to count the number of tips. 20ml of water should result in 10 
tips (2 ml/tip). 
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 Back in the shelter, the ESC screen will have updated and will report the tips as 
precipitation. 

 
 
  
  
 TIME O3 O3CAL RNF 
 
 10/19 11:30 41. -1.  0.0 
 10/19 11:31 41. -1.  0.0 
   10/19 11:32 40. -1.  0.0 
   10/19 11:33 42. -1.  1.0 
   10/19 11:34 41. -1.  0.0 
 
 

 
 To be certain that all the tips were collected in the displayed one minute updates, wait 

long enough for an update of 0.0 to appear for RNF. The tips may have been recorded 
over one or two minutes. The total precipitation response is the sum of the one minute 
updates. The total should be 1.0mm (.1mm/tip) for 20ml of water. Call the OSC if the 
results are different than above. 

 
 
 
 
 
 
 
 
 
 
 
 
5.  Bring the RNF back online and record the results. 
 
 From the Home Menu press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 

10 tips = 2.5 mm 10 tips = 1.0 mm
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 Press <D> for Configure (Data) Channels: 
 

ESC 88xx v5.31  ID:BL    Channel Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for Enable/Mark Channel Online: 
 

ESC 88xx v5.31  ID:BL    Choose(Space Toggle/Enter Select)   08/06/97  14:59:27
 
 RNF    [11] 
  
 
  
  
  
 
 

 
Press ↑ and ↓ to highlight a channel(s). Press the <Spacebar> to select it for online 
status. Press  <Enter> to put the marked channel(s) online. 

 
 Check the status of the RNF channel by pressing <Esc> several times until the Home 

Menu is displayed.  Press <D> once to enter the Real-Time Display Menu.  Press <F> to 
display the data channels with flags (or, press <F6> in any menu to display flags). RNF 
should be marked with a D flag to the right to indicate offline status that will clear after 
one minute. The online time will automatically be recorded in the logbook when this task 
is completed. Enter the results of the test in the logbook. 
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1.0 PURPOSE 

Instructions provided herein outline the steps of routine site operator maintenance visits using the 
DataView system for ambient air monitoring stations operated by Air Resource Specialists, Inc. 
(ARS).  
 

2.0 SUMMARY OF METHOD 
The primary purpose of routine site operator visits is to assure quality data capture and minimize 
data loss by performing routine operational checks and system integrity checks of equipment. The 
observations recorded during these visits verify the operations of the monitoring system. The site 
operator may also be asked to perform troubleshooting, simple maintenance, and sensor 
replacements in consultation with the field specialist. 
  

3.0 SCOPE 
Activities described in this document are performed by local site operators during routine site 
visits. Local operators have been appropriately trained in site operations by ARS field staff and 
possess the required technical knowledge and abilities to perform the activities described below. 
 

4.0 ROLES AND RESPONSIBILITIES 

Program or Project Manager 

• Coordinate with site operator, his/her supervisor, and ARS field specialist, concerning the 
schedule and requirements for routine and emergency maintenance. 

Fields Operations Manager 
• Review with the field specialist site operator training requirements. 

Field Technician or Specialist 
• Coordinate with site operator, his/her supervisor, and ARS field specialist, concerning the 

schedule and requirements for routine and emergency maintenance 
• Train the site operator in all phases of the routine and emergency maintenance visits. 
• Provide technical support to the station operator via telephone or email to identify 

instrument problems and initiate instrument repairs. 
• Document all technical support give to the site operator via the ARS site status log 

(www.arssitestatuslog.com). 
Local Site Contact 

• Coordinate with his/her supervisor, project manager, and ARS field specialist concerning 
the schedule and requirements for routine and emergency maintenance. 

• Perform all procedures described in site or network specific Checklist Instructions. 
• Thoroughly document all procedures performed during each site visit. 
• Report any noted inconsistencies immediately to the field specialist. 

5.0 REQUIRED EQUIPMENT AND MATERIALS 

• Keys for the shelter or support system internal lock and padlocks. 

http://www.arssitestatuslog.com/
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6.0 PROCEDURES 

 
6.1 ROUTINE VISITS – AIR QUALITY INSTRUMENTS 
 

The station operator will make routine observations at the site. Sites may have different configurations 
and DataView is customized for each site’s instrumentation. While completing the DataView CIs, the 
operator will make some or all of the following observations: 
 
OZONE (O3) Verify that the ozone analyzer is functioning properly. Check the ozone particulate 

filter weekly and change if necessary (at least every two weeks).  

SULFUR DIOXIDE 
(SO2) 
 

Verify that the sulfur dioxide analyzer is functioning properly. Verify that the 
gas dilution calibrator is functioning properly. Change the sulfur dioxide filter 
every two weeks. 

CARBON 
MONOXIDE (CO) 

Verify that the carbon monoxide analyzer is functioning properly. Verify that 
the gas dilution calibrator is functioning properly. Change the carbon 
monoxide filter every two weeks. 

OXIDES OF 
NITROGEN (NOX) 

Verify that the oxides of nitrogen analyzer is functioning properly. Verify that 
the gas dilution calibrator is functioning properly. Change the oxides of 
nitrogen filter every two weeks. 

PARTICULATE 
MONITOR (PM10 or 
PM2.5) 

Perform monthly leak check and flow verification. Clean inlet nozzle and 
nozzle area. Replace tape as necessary. 
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 6.2 ROUTINE VISITS – METEOROLOGICAL SENSORS 
 The station operator will make weekly observations at the site. Sites may have different 
configurations and DataView is customized for each site’s instrumentation. While completing the 
DataView CIs, the operator will make some or all of the following observations: 
 
WIND SPEED AND 
DIRECTION 

Inspect the wind sensor for damage. Compare current wind speed and 
direction measurements to observed ambient conditions. 
 

TEMPERATURE/ 
DELTA TEMPERATURE 

Verify that the temperature sensor housing aspirator fan is operational. 
Compare current temperature and delta temperature measurements to 
observed ambient conditions. 

RELATIVE HUMIDITY Compare the current relative humidity measurement to observed ambient 
conditions. 
 

SOLAR RADIATION Inspect the solar radiation sensor for dirt or snow and clean if necessary. 
Compare the current solar radiation measurement to observed ambient 
conditions. 
 

PRECIPITATION Inspect the precipitation gauge collection funnel for snow or debris. Tip 
the mechanism 10 times. 
 

BAROMETRIC PRESSURE Compare the current barometric pressure to trends from recent weather 
activity. Inspect the sensor and tubing for abrasions, cracks, or other 
defects. 

 
The station operator should promptly report any noted inconsistencies to the field specialist. 
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6.4 TROUBLESHOOTING, MAINTENANCE, INSTRUMENT REPLACEMENT 
 

 If a malfunction of any monitoring component occurs, or if any of the readings do not make sense, 
the station operator should call ARS (970-484-7941) to report any discrepancy. A field technician will 
instruct the station operator on troubleshooting procedures. 
 
TROUBLESHOOTING If a potential malfunction or other inconsistency is noted, the station 

operator will be directed to perform a series of troubleshooting procedures. 
The use of certain tools or diagnostic equipment (most frequently a digital 
voltmeter) will be required. The field specialist will step the station operator 
through the proper procedures by telephone or email. Typical procedures 
may include continuity checks, supply voltage checks, bearing 
observations, datalogger interrogation, or specific instrument performance 
observations. The operator will be asked to thoroughly record his/her 
findings and relate them to the field specialist for further action. 
 

MAINTENANCE The station operator may be asked to perform certain mechanical, 
electrical, electronic, or datalogger program maintenance as directed by 
the field specialist. Typical maintenance tasks could include tightening 
tower guy wires, replacing backup batteries, resetting a power line 
breaker, or restarting system components. All maintenance must be 
thoroughly documented and the results related to the field specialist. 
 

EQUIPMENT 
REPLACEMENT 
 
 
 

Under the field specialist’s direction, the station operator may be asked to 
replace a malfunctioning instrument or sensor with a field-ready unit. The 
unit would be calibrated on-site at a later date by the field specialist. All 
replacement steps will be reviewed by telephone with the station operator. 
Instrument-specific manuals or other diagrams or descriptions will be 
referenced as appropriate. All instrument replacement procedures 
including the equipment type, make, serial number, and date and time of 
replacement must be documented. 

 
6.5 SITE DOCUMENTATION 
Routine operator checks entered in the Checklist Instructions are automatically documented in the 

DataView station log. Any additional troubleshooting, maintenance, or equipment replacement actions 
must be documented in the station log using DataView. 

In the event of a DataView computer malfunction, or if DataView is not in operation at the site, 
the operator must manually complete a hard copy version of the Checklist Instruction. Upon completion, 
the site operator must mail, fax or email the completed form to  
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7.0 REFERENCES 

8.0 DEFINITIONS AND ACRONYMS 

ARS Air Resource Specialists, Inc. 
AQDB Air Quality Database 
CFR Code of Federal Regulations 
DAS Data Acquisition System 
EPA U.S. Environmental Protection Agency 
IMC Information Management Center 
MS Microsoft 
NIST National Institute of Standards and Technology 
PDF Portable Document Format 
QA Quality Assurance 
QAPP Quality Assurance Project Plan 
QC Quality Control 
SLAMS State and Local Air Monitoring Stations 
SOP Standard Operating Procedure 

Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 

Calibration: adjustment of the instrument or analyzer so it operates within established 
acceptance criteria (defined in the network of project specific QAPP) 
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Checklist Instruction - Weekly Station Visit 
 
  •   Ozone Analyzer ( TEI 49C) 
  •   Ozone Calibrator (TEI 49C) 
  •   CASTNet Dry Deposition 
 
Checklist Instruction Number: 3178-3116 
 
Revision Number / Date:   4 / January 2006  (last reviewed Jan. 2006) 
 
 
Objective:  Weekly checks of the ozone instrumentation and the CASTNet dry deposition filter 

pack are to: 
 
 • Verify that the ozone analyzer is functioning properly. 
 • Check the analyzer particulate filter in the orange holder and change if necessary.  

The filter must be changed no less than every two weeks. 
 • Change the CASTNet dry deposition filter pack, verify the operational integrity of 

the filter pack system, complete the SSRF, and return the exposed filter pack and 
SSRF to the CASTNet contractor. 

 
 
1. Check  for an  alarm condition on the front panel of the ozone analyzer.  Report 

alarms to the OSC. 
 
 Alarm conditions are indicated on the TEI 49C ozone analyzer front panel display,  as 

shown below: 
 

 
O3 PPB  67.0 
 
   ALARM              REMOTE 

 
 To list specific alarms, press the MENU button on the analyzer once to access the Main 

Menu: 
 

MAIN MENU:  10:25 
> RANGE 
 AVERAGING TIME 
 CALIBRATION FACTORS 
 

 
   CALIBRATION 
   INSTRUMENT CONTROLS 
   DIAGNOSTICS 
   ALARM 
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 Use the ↑ and ↓ buttons to move the cursor and press <Enter> once to access the Alarm 
Menu: 

 
ALARMS DETECTED: 1 
> BENCH TEMP OK 
 BENCH LAMP TEMP LOW 
 PRESSURE OK 
 

 
 FLOW A OK 
 FLOW B OK 
 INTENSITY A OK  
 INTENSITY B OK 
 O3 CONC OK 

 
 Call the Operation Support Center to report and resolve the alarms that have been flagged 

on the right side of the display.  Record the significant actions related to the alarms in the 
site logbook.  Press the RUN button once to return to the Run mode when diagnostics are 
completed. 

 
2. Take the ozone analyzer and flow offline and shut off the CASTNet flow pump and 

hour meter. 
 
 To ensure that only ambient and flow data are recorded in the hourly average, it is 

necessary to mark the O3, O3CAL, and FLW channels offline.  Data marked in this 
manner are automatically excluded from the valid data set. 

 
 To access the Login Screen of the ESC datalogger press <Esc> on the keyboard a couple 

of times until the Home Menu is displayed: 
 

 ESC 88XX v5.31  ID:RM              Home Menu                04/26/02  11:30:27 
 
 H Help Screen 

L Login/Set User Level 
 
 
 
 O Log Out/Exit 
 
 
 

 
 Press <L> for Login/Set User Level: 
 

 ESC 88XX v5.31  ID:RM            Login Screen               04/26/02  11:30:27 
 
 Enter Password             ************** 
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 Login by typing user name and password on the keyboard then press <Enter>.  The 
datalogger display will look similar to: 

 
 ESC 88XX v5.31  ID:RM              Home Menu               04/26/02  11:30:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 

 
 Press <C> for Configuration Menu: 
 

 ESC 88XX v5.31  ID:RM           Configuration Menu        04/26/02  11:30:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <D> for Configure (Data) Channels: 
 

 ESC 88XX v5.31  ID:RM        Channel Configuration Menu    04/26/02   11:30:27
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <M> for Disable/Mark Channel Offline: 
 

 ESC 88XX v5.31  ID:RM    Choose(Space Toggle/Enter Select)  04/26/02  11:30:27
 
 O3  [01]  
 O3CAL [02] 
 O3R8  [03] 
 VWD [04] 
 SIG   [05] 
 VWS [06] 
 SWS [07] 
 TMP  [08] 
 DTP   [09] 
 SOL   [10] 
 RNF    [11] 
 WET    [12] 
 FLW    [13] 
 STP    [14] 
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 Use the ↑ and ↓ keys to navigate and the spacebar to select the O3, O3CAL, and FLW 
channels for offline status.  The channels should be marked with a ">" indicating 
imminent offline status.  Press <Enter> to take the marked channels offline. 

 
 Check the status of the channels by pressing <Esc> several times until the Home Menu is 

displayed.  Press <D> once to enter the Real-Time Display Menu.  Press <F> to display 
the data channels with flags.  O3, O3CAL, FLW should be marked with a D flag to the 
right to indicate offline status.  The offline time is automatically recorded in the logbook 
when this step is complete. 

 
 Switch off the pump and the hour meter for the CASTNet flow system.  The labeled 

switches are located below the CASTNet flow box. 
 
3. Tip the dry deposition tower and replace the analyzer particulate filter in the 

orange holder every two weeks or as needed. 
 
 Lower the flow tower only during good weather (e.g., no electrical storms, high winds, 

heavy ice buildup, or obvious tower damage).  First remove the locking pin to allow the 
tower to be lowered.  Then gently control its descent with the attached rope.  Secure the 
tower by tying the rope to the base. 

 
 The dry deposition filter and particulate filter resides in the "pothead" at the top of the 

tower.  The particulate filter is in a Teflon housing with an orange tightening ring.  Look 
through the “T” at the bottom for obvious fine debris or discoloration on the filter.  If the 
filter is unfit for another week of service, it must be changed.  Install a clean filter when it 
is visibly dirty or once every 2 weeks, whichever comes first. 

 
 The filter protects the sample inlet system from particulate that could contaminate and 

subsequently reduce the ambient ozone concentrations.  Proper filter inspection and 
replacement is key in maintaining accurate readings of ambient ozone concentrations. 

 
 To open the particulate filter holder, loosen the orange tightening ring from the filter 

housing using the dark green filter wrenches supplied by the Operation Support Center.   
 
 Begin a filter change by removing and discarding the exposed filter.  Using the provided 

tweezers remove a new 5μ Teflon filter from the envelope and install it into the filter 
housing.  The 5μ filter envelope has an orange color code.  Ensure that the filter remains 
clean during this process since contamination reduces the ozone concentrations in the 
sampling stream.  Reassemble the filter holder and tighten the orange ring securely using 
the filter wrenches. 

 
4. If a new analyzer particulate filter (orange holder) was installed, condition it by 

starting a DIAGSZ. 
 
 Following a filter change, a DIAGSZ is required to verify the integrity of the sampling 

system and to condition the new filter. From the ESC datalogger Home Menu, press <C> 
for Configuration Menu: 
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 ESC 88XX v5.31  ID:RM          Configuration Menu          04/26/02  11:30:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <C> again for Configure Calibrations: 
 

 ESC 88XX v5.31  ID:RM         Cal Configuration Menu       04/26/02  11:30:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
 

 
 Press <S> for Start a Calibration Program: 
 

 ESC 88XX v5.31  ID:RM      Choose List (Enter to Select)   04/26/02  11:30:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGSZ.  This is an 

ozone calibration sequence that begins with a 15-minute span phase and concludes with a 
5-minute zero phase.  The control of the calibration sequence is automatic.  Press 
<Enter> and several things occur immediately.  Pump noise in the shelter increases 
dramatically as the ozone calibrator (O3CAL) sample pump and the zero air pumps 
switch to on. 

 
 After 15 minutes the span phase will conclude and the zero phase will commence. 
 
 After 5 additional minutes, the zero will turn off and ambient collection will resume 

automatically.  Before leaving the station, you will be asked to find and record the stored 
results. 
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5.  Remove the exposed CASTNet dry deposition filter cartridge, perform a flow 
system leak check and complete last week’s SSRF. 

 
 To confirm that all systems are in good operational condition and that filters are handled 

correctly, the operator is required to check each component and change filters weekly. 
 
 A mailing tube is sent to your site weekly by MACTEC E&C, in Gainesville, Florida.  

Each tube contains a sample filter pack enclosed in a Ziplock® bag and a Site Status 
Report Form (SSRF).  Filters are generally changed each Tuesday. Call the Operation 
Support Center for exceptions. 

 
 Begin this week’s filter change by completing last weeks SSRF.  In the FILTER OFF 

column on last week’s SSRF, record the dry deposition flow box rotameter reading 
observed at the middle of the ball. 

 
 Obtain the most recent Hourly Average for flow by starting at the Home Menu of the 

datalogger.  Press <R> for Report Generation Menu.  Then press <R> for Daily Averages 
Report.  In the highlighted Show Channels field type “FLW” and press <Enter> four 
times to view the Daily Report to Screen.   

 
 ESC 88XX v5.31  ID:RM             Daily Report Screen      04/26/02  11:30:27 
 
 Show Channels             :       FLW 
 
 
 
    Start Time                :       04/26/02 00:00:00 
    # of Flags to Report      :       02 
    Daily Report to Screen    : 
    Daily Report to Printer   : 
 
 

 
 Daily Average         04/26/02 11:30:27        JDay:  116    Logger ID: BL 
    Report                      ROCKY MOUNTAIN NATIONAL PARK 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
- - 
Name:                        FLW 
Channel Num:                 15 
Analog Input:                10 
Units:                       SLPM 
Full Scale:                     5 V 
High Output:                 5.89 
Low Output:                  0.00 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

- - 
04/26 00:00                   3.00 
04/26 01:00                   3.00 
04/26 02:00                   3.00 
04/26 03:00                   3.00 
04/26 04:00                   3.00 
04/26 05:00                   3.00 
04/26 06:00                   3.00 
04/26 07:00                   3.00 
04/26 08:00                   3.00 
04/26 09:00                   3.00 
04/26 10:00                   3.00 
04/26 11:00                 -9999.<N 
04/26 12:00                 -9999.<N 
04/26 13:00                 -9999.<N 
04/26 14:00                 -9999.<N 
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 Obtain the most recent datalogger HOURLY AVERAGE for FLW and record it in the 
FILTER OFF DAS FLOW (LPM) entry cell on the SSRF.  In this example the most 
recent hourly average occurs at 10:00 and is 3.00. 

 
 Remove the CASTNet dry deposition filter. 
 
 A) Wearing clean vinyl gloves (provided by the Operation Support Center), remove the 

dry deposition filter pack from the tower by pulling back on the locking ring of the 
quick-disconnect.  Once the filter is removed the quick-disconnect provides an 
airtight seal. 

 
 B) Insert the plastic caps that were saved in the shipping container to avoid 

contamination to the filter. 
 
 C) Place the filter pack in its Ziplock® bag.   
 
 D) Enter the date and time for FILTER OFF on last week’s SSRF. 
 
 E) Remove your gloves and discard them. 
 
 F) Observe the current reading of the Mass Flow Controller (MFC) display.  It should 

be close to zero.  Record this value as the MFC (pump off) under FILTER OFF on 
last week’s SSRF. 

 
G) Turn on the pump to leak check the sampling system.  Let the MFC value stabilize 

and record the value in the MFC LEAK CHECK box on last week’s SSRF.  The new 
value should also be close to zero.  Call the OSC if the MFC (pump off) and the 
MFC LEAK CHECK are more than ± 0.03 different.  Turn off the pump. 

 
H) Record the hour meter reading as the ELAPSED TIME (HRS). 

 
I) Record the expected ship date, then sign and date the form on the PREPARED BY 

line.  At this point, last week’s SSRF should be complete; the white, yellow, and 
gold copies and the filter you just removed can be packed in last week’s mailing tube 
for shipment to MACTEC E&C.  The pink copy remains in your stations file 
cabinet. 

 
 Inspect the plumbing for signs of obvious deterioration or moisture.  If either is 

discovered, report your finding to the OSC. 
  
6. Install new CASTNet dry deposition cartridge, raise the tower, and reset hour 

meter.  Begin the new SSRF and turn on pump and hour meter. 
 
 Open the mailing tube containing this week’s filter and a new SSRF.  Enter the codes for 

the site name and number.  The codes are found on the side of the filter housing and on 
the Chain of Custody label.   Enter the date, followed by the day of the week in the VISIT 
DATE/DAY field.  If the plumbing has not been disturbed you may enter your previous 
leak check results in the MFC LEAK CHECK cell in the FILTER ON column.  Enter 
your name and the date on the SHIPMENT OPENED BY line. 
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 Enter the filter pack number from the label on the filter pack housing.  Back outside, 

release the vacuum at the filter quick-disconnect by pressing into the center of the 
connector until you hear a faint rush of air.  Use a small clean screwdriver. 

 
 Put on clean vinyl gloves and remove the caps from the new filter pack.  Seal the caps in 

the Ziplock® bag and store the bag in the mailing tube until next week. 
 
 Install the filter pack by pressing it into the fitting until you hear a "snap," indicating a 

secure connection.  Discard the gloves. 
 
 Raise the tower slowly and secure it by inserting the locking pin. 
 
 Reset the hour meter to zero.  Turn on the flow pump and the hour meter. 
 
 Enter the FILTER ON date and time on the new SSRF, using the Local Standard Time 

(LST) displayed by the datalogger.  Ensure that the readout box LED display reaches the 
set point recorded on the calibration label affixed to the case. 

 
7. Bring the O3, O3CAL, and FLW channels back online. 
 
 Bring the O3, O3CAL, and FLW channels online by beginning at the Home Menu of the 

ESC datalogger.  Remember that pressing <Esc> several times will return you eventually 
to the Home Menu. 

 
 ESC 88XX v5.31  ID:RM              Home Menu               04/26/02  11:30:27 
 
 H Help Screen 
 L Login/Set User Level 
 C Configuration Menu 
 D Real-Time Display Menu 
 R Report Generation Menu 
 G Graph Generation Menu 
 S Status Menu 
 O Log Out/Exit 
 X Serial Como to Port 
 
 

 
 Press <C> for Configuration Menu: 
 

 ESC 88XX v5.31  ID:RM           Configuration Menu         04/26/02  11:30:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <D> for Configure (Data) Channels: 
 

 ESC 88XX v5.31  ID:RM        Channel Configuration Menu    04/26/02  11:30:27 
 
 N Enter New Configuration 
 C Change Old Configuration 
 D Delete Old Configuration 
 M Disable/Mark Channel Offline 
 E Enable/Mark Channel Online 
 I Put Channel In Maint. 
 O Take Channel Out of Maint. 
 

 
 Press <E> for  Enable/Mark Channel Online.  O3 and FLW should be the only channels 

displayed. 
 

 ESC 88XX v5.31  ID:RM    Choose(Space Toggle/Enter Select)  04/26/02  11:30:27
 
  > O3     [01] 
    O3CAL  [02] 
    FLW    [15] 
  
 
 
 
 
 

 
 Use the ↑ and ↓ keys to navigate and the spacebar to select a channel.  Press the 

<Spacebar> to select both channels for online status.  Press <Enter> to put the selected 
channels online. 

 
 ESC 88XX v5.31  ID:RM    Choose(Space Toggle/Enter Select)  04/26/02  11:30:27
 
   > O3     [01] 
   > O3CAL  [02]  
   > FLW    [15] 
  
 
 
 
 

 
 Check the status of the O3, O3CAL, and FLW channels by pressing <Esc> several times 

until the Home Menu is displayed.  Press <D> once to enter the Real-Time Display 
Menu.  Press <F> once to display the data channels with flags.  O3, O3CAL, O3R8, and 
FLW will no longer be marked with a flag indicating online status; a P may be in the flag 
column for each indicating a purge period programmed to allow for the time it takes for 
ambient conditions to prevail.  The P flag should clear within one minute.  The online 
time will be recorded in the logbook when this step is complete. 

 
 Note:  If the calibration sequence, DIAGSZ, is still active, O3, O3CAL, and O3R8 will 

be flagged with a C. 
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8-9. If a new analyzer particulate filter (orange holder) was installed and a DIAGSZ was 
activated enter the filter conditioning results for O3 and O3CAL. 

 
 From the Home Menu press <R> for Report Generation Menu: 
 

ESC 88XX v5.31  ID:BL         Report Menu          08/06/97  14:59:27 
 
 A Report Averages 
 C Report Calibrations 
 L Summarize Last Cals 
 Q Autoprint Data Channel(s) 
 D Autopring Daily Report 
 Z Autoprint Calibration(s) 
 R Daily Averages Report 
 T Daily Calibrations Report 
  

 
 Press <L> for Summarize Last Cals.  Navigate through the Last Cals using the <D> 

(down) or <U> (up) keys to find the DIAGSZ: 
 

DIAGSZ 
 

O3 
 
 

O3 CAL 
 
 
 
 
 
 

08/14   08:00 
 

SPAN 
ZERO 

 
SPAN 
ZERO 

EXPECTED 
 

400 
0 
 

400 
0 

ACTUAL 
 

406.1 
-0.1956 

 
403.9 

1.0100 

ERROR 
 

6.1 
0 
 

3.9 
1.01 

UNITS 
 

PPB 
PPB 

 
PPB 
PPB 

FLAGS 
 

DC 
DC 

 
DC 
DC 

 
 Record the O3 and O3CAL from the ACTUAL column into the appropriate cells of the 

checklist.  The result location has been highlighted in the graphic above. 
 
 O3ZERO Value between -5 and +5 ppb 
 O3SPAN Value within 10% of O3CAL SPAN 
 O3CAL ZERO Value between -5 and +5 ppb 
 O3CAL SPAN Value between 350 and 450 ppb 
 
 The checklist will prompt you to call the OSC if the results were not within tolerance. 
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Checklist Instruction - Multipoint Calibration 
 
 •   Ozone Analyzer (TEI 49C) 
 •   Ozone Calibrator (TEI 49C) 
 
Checklist Instruction Number: 3178-3315 
 
Revision Number / Date:   1 / January 2006  (last reviewed Jan. 2006) 
 
Objective:  Monthly multipoint calibrations are performed to provide a more comprehensive 

check of the instrument’s condition and verify the ozone analyzer’s response to 
ozone free (zero) air and three (3) upscale ozone concentrations: 

 
 • 360 to 440 ppb 
 • 150 to 200 ppb 
 •   50 to 80 ppb 

 
1. Start a DIAGZERO sequence from the ESC datalogger. 
 
 From the ESC datalogger Home Menu, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 

 
 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
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 Press <S> for Start a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGZERO.  This is an 

ozone calibration sequence that initiates a 30-minute zero.  The control of the calibration 
sequence is automatic.  Press <Enter> and several things occur immediately.  Pump 
noise in the shelter increases dramatically as the ozone calibrator (O3CAL) sample pump 
and the zero air pump switch on.   The alarm on the front panel of the ozone calibrator 
should go off within a few seconds.  Inspect the front panel of the ozone analyzer and the 
ozone calibrator.  If either panel is displaying an alarm, abort the multipoint calibration 
and call the Operation Support Center for diagnostic support.  Restart the multipoint 
when the alarms have been resolved. 

 
 Press <Esc> several times to return to the datalogger Home Menu. 
 
 From the Home Menu, select <D> for Real-Time Display Menu: 
 

ESC 88xx v5.31  ID:BL      Real-Time Display Menu       08/06/97  14:59:27 
 
 V Display Raw Readings 
 R Display Readings w/units 
 F Display Readings w/flags 
 B Display Last Base Avg 
 C Continuous Avg Report 
 L Show LARGE TEXT Display 
 I Display Digital Inputs 
 O Display Digital Outputs 
 A Display Analog Outputs 
 

 
  Press <C> for Continuous Avg Report: 
 

ESC 88xx v5.31  ID:BL      Continuous Avg Report Setup       08/06/97  14:59:27
 
  
 Average Interval : 1m    
 Show Channels : O3,O3CAL,RNF  
 
 
 # of Flags to Report : 02 
 Use Decimal Positioner? : Y 
 Start Continuous Report 
 

 
 Enter a <1> and then <m> for the Average Interval if it has not defaulted to the 1m.  

Arrow down to Show Channels.  Type O3 and O3CAL if it is not already displayed.  
Arrow down to Start Continuous Report and press <Enter>. 
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 TIME  O3 O3CAL RNF 
 
 08/06 14:59 41.<C -1.<C  0.0 
 
 
 
 

 
2. Check  for an  alarm condition on the front panel of the ozone analyzer.  Report 

alarms to the OSC before proceeding with the multipoint calibration. 
 
 Alarm conditions are indicated on the TEI 49C ozone analyzer front panel display,  as 

shown below: 
 

 
 
O3 PPB  0.0 
 
ZERO   ALARM              REMOTE 

 
3. Check  for an  alarm condition on the display of the ozone calibrator.  The display 

should not show an alarm condition during the DIAGZERO.  Report alarms to the 
OSC before proceeding with the multipoint calibration. 

 
 Previous to the initiation of the DIAGZERO sequence, the normal TEI 49C ozone 

calibrator front panel will display an alarm condition as shown below: 
 

 
 
O3 PPB  0.0 
 
   ALARM              REMOTE 

 
 When the DIAGZERO sequence has been initiated, the ozone calibrator sample pump 

will start and the alarm condition will no longer be met.  As the flow rate approaches its 
set point, the ALARM indicator will be replaced with and indication of the time of day as 
shown below: 

 
 
 
O3 PPB  0.0 
 
   10:25                 REMOTE 

 
 
 Note:  The time of day need not be correct for the calibrator to operate properly. 
 
 If the alarm condition persists after one minute into the DIAGZERO calibration 

sequence, call the Operation Support Center. 
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4.  Observe the continuous average report for several minutes.  When five or more one-

minute updates indicate a stable zero response, +5ppb to –5ppb, record the last one-
minute averages for O3 and O3CAL.  

 
 After several minutes the Continuous Average Report will display the arrays of one-

minute updates for O3 and O3CAL. 
 

 
  
 TIME   O3 O3CAL RNF 
 
 10/19 11:30 41.<C -1.<C  0.0 
 10/19 11:31  4.<C -0.<C  0.0 
  10/19 11:32  0.<C -1.<C  0.0 
  10/19 11:33 -1.<C  1.<C  0.0 
  10/19 11:34  0.<C  1.<C  0.0 
 
  

 
 Once the following conditions have been met: 
 
  1. The last three one-minute averages of O3 are in the range of +5ppb to –5ppb. 
  2. The last three one-minute averages of O3CAL are in the range of +5ppb to –5ppb. 
 
 Record the last one-minute average of O3 and O3CAL.  If  the conditions are not met, 

even after several more minutes, do not proceed further with the multipoint calibration.  
Call the OSC for diagnostic support. 

 
 
 If the zero values were successful and recorded, abort the DIAGZERO. 
 
 Press <Esc> several times to return to the Home Menu.  Press <C> for the Configuration 

Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
 

 
 Press <A> for Abort a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGZERO. 
 
 Press <Enter> and the zero air pump and ozone calibrator pump turn off.  The alarm 

condition should reappear on the front panel of the ozone calibrator. 
 
5.  Start a DIAGSPAN.  
 
 From the ESC datalogger Home Menu, press <C> for Configuration Menu: 
 

ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
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 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
 

 
 Press <S> for Start a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGSPAN.  This is an 

ozone calibration sequence that initiates an ozone span.  The control of the calibration 
sequence is automatic.  Press <Enter>. 

 
 Note: Incase of MDI error message, wait 1 minute before starting DIAGSPAN. 
 
6.  Observe the Continuous Average Report for several minutes.  When five or more 

one-minute updates indicate a stable span response, 360ppb to 440ppb, record the 
last one-minute averages for O3 and O3CAL. 

 
 From the Home Menu, press <D> for the Real-Time Display Menu: 
 
 Press <C> for Continuous Avg Report: 
 

ESC 88xx v5.31  ID:BL      Continuous Avg Report Setup     08/06/97  14:59:27
 
  
 Average Interval : 1m    
 Show Channels : O3,O3CAL,RNF  
 
 
 # of Flags to Report : 02 
 Use Decimal Positioner? : Y 
 Start Continuous Report 
 

 
 Enter a <1> and then <m> for the Average Interval if it has not defaulted to the 1m.  

Arrow down to Show Channels.  Type O3 and O3CAL if it is not already displayed.  
Arrow down to Start Continuous Report and press <Enter>. 
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 TIME  O3 O3CAL RNF 
 
 08/06/99 14:59:27 41.<C -1.<C  0.0 
 
 
  
 

 
 After several minutes the Continuous Average Report will display the arrays of one-

minute updates for O3 and O3CAL. 
 

 
  
  
 TIME   O3 O3CAL RNF 
 
 10/19 11:30 41.<C -1.<C  0.0 
 10/19 11:31 350.<C 361.<C  0.0 
  10/19 11:32 401.<C 400.<C  0.0 
  10/19 11:33 402.<C 400.<C  1.0 
  10/19 11:34 401.<C 401.<C  0.0 
 
  

 
 Once the following conditions have been met: 
 
 1.  The last three one-minute averages of O3 are within the range of 360ppb to 440ppb. 

 2.  The difference between O3 and O3CAL for each of the last three averages is less than 
25ppb. 

 
 Record the last one-minute average of O3 and O3CAL on the checklist.  If the conditions 

are not met, even after several more minutes, call the Operation Support Center for 
assistance. 

 
7.  Adjust the O3 analyzer LEVEL2, downward to generate a concentration between 

150ppb and 200ppb.  Record the results from the Continuous Average Reports after 
the event has stabilized.  

 
 From the front panel of the O3 analyzer, navigate through the menus to reduce the ozone 

concentration.  Start from the Run screen. 
 

 
O3 PPB  401. 
 
   ALARM                 REMOTE 

 
  



Checklist Instruction: 3178-3315                                   January 2006                                                        Page 8 of 10  

 Press the MENU button once. 
 

MAIN MENU: 10:25 
> RANGE 
 AVERAGING TIME 
 CALIBRATION FACTORS 
 

 
 CALIBRATION 
 INSTRUMENT CONTROLS 
 DIAGNOSTICS 
 ALARM 

 
 Use the ↑ and ↓ buttons to navigate and position the cursor next to INSTRUMENT 

CONTROLS. Press <Enter> once to enter the Instrument Controls Menu. 
 

INSTRUMENT CONTROLS: 
> TEMP CORRECTION 
 PRESSURE CORRECTION 
 OZONATOR SOLENOID 
 OZONATOR LEVEL 1 
 OZONATOR LEVEL2 
 

 
   SCREEN BRIGHTNESS 
   SERVICE MODE 
   TIME 
   DATE 
 
 Use the ↑ and ↓ buttons to navigate and position the cursor next to LEVEL2.  Press 

<Enter> once to enter the LEVEL2 adjustment screen. 
 

 
 O3PPB 401. 
 LEVEL2  44.1% 
 
 ↑ ↓     INC/DEC 
 

 
 Use the ↑ and ↓ buttons to decrease the power to the ozone generator.  The power is 

expressed as a percentage.  Normal lag time between and adjustment and a stable ozone 
reading is about one minute.  Wait for the ozone reading to stabilize.  Further adjust the 
power up or down until the ozone concentration stabilizes between 150ppb and 200ppb. 

 
 Watch the Continuous Average Report on the datalogger for several minutes.  When 

three or more one-minute updates indicate a stable response, record the last one-minute 
updates for O3 and O3CAL on the checklist. 
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8.  Adjust the O3 analyzer LEVEL2, downward to generate a concentration between 
50ppb and 80ppb.  Record the results from the Continuous Average Reports after 
the event has stabilized. 

 
 Use the ↑ and ↓ buttons to decrease the power to the ozone generator.  The power is 

expressed as a percentage.  Normal lag time between and adjustment and a stable ozone 
reading is about one minute.  Wait for the ozone reading to stabilize.  Further adjust the 
power up or down until the ozone concentration stabilizes between 50ppb and 80ppb. 

 
 Watch the Continuous Average Report on the datalogger for several minutes.  When 

three or more one-minute updates indicate a stable response, record the last one-minute 
updates for O3 and O3CAL on the checklist. 

 
 The multipoint is complete. 
 
9. Press the RUN button on the O3 analyzer to return to the RUN screen.  Abort the 

DIAGSPAN on the datalogger. 
 
 Press the RUN button once on the O3 analyzer.  This returns the analyzer to the Run 

screen and resets LEVEL2 to the previous set point percentage for normal spans. 
 
 Abort to DIAGSPAN and return the analyzer to ambient sampling by pressing <Esc> on 

the datalogger keyboard several times, to return to the Home Menu.  From the ESC 
datalogger Home Menu, press <C> for Configuration Menu. 

 
ESC 88xx v5.31  ID:BL      Configuration Menu       08/06/97  14:59:27 
 
 P Set Passwords 
 S Configure System Parameters 
 D Configure (Data) Channels 
 C Configure Calibrations 
 A Configure Alarms 
 O Configure Analog Outputs 
 K Configure Math Constants 
 E Configure Dig. Event Program 
 R Configure Digital I/O 
 1 Configure Serial Protocols 
 
 

 
 Press <C> again for Configure Calibrations: 
 

ESC 88xx v5.31  ID:BL     Cal Configuration Menu     08/06/97  14:59:27 
 
 N Enter New Cal Configuration 
 C Change Old Cal Configuration 
 D Delete Old Cal Configuration 
 S Start a Calibration Program 
 1 Start a Single Phase Cal 
 A Abort a Calibration Program 
 Q Quick Expected Value Editor 
 I Return to Interactive Cal 
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 Press <A> for Abort a Calibration Program: 
 

ESC 88xx v5.31  ID:BL    Choose List (Enter to Select)     08/06/97  14:59:27 
 
  
 PSZ  
 DIAGSPAN 
 DIAGZERO 
 DIAGPREC 
 DIAGSZ 
  
 
 F2      <ESC>    TAB      CTRL-K     CTRL-R     Arrows      
 Refresh Exit GOTO END GOTO TOP Clr Keys Select 
 

 
 From the Choose List Menu, use the ↑ and ↓ keys to highlight DIAGSPAN.   The 

DIAGSPAN ceases immediately. 
 
10. Review the results.  Call the Operation Support Center to discuss the multipoint 

results. 
 
 Select View Results on the checklist. 
  
 The multipoint calibration summary, displays the zero and three upscale point results, an 

X-Y plot of the results, the linear regression results and a pass/fail indicator.  Call the 
Operation Support Center to discuss the results of the multipoint check. 
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1.0 PURPOSE  
 
This standard operating procedure (SOP) outlines the steps taken by Air Resource Specialists’, Inc. (ARS) 
Information Management Center (IMC) to collect ambient air quality and meteorological data and quality 
control documentation from network dataloggers, DataView computers, manual operational logs, and other 
data compilation systems. This information includes: 
 

• Criteria pollutant parameters 
• Meteorological parameters 
• Diagnostic parameters and calibration results 
• DataView or manual station logs 

 
Successful data collection is the first step in the network data collection, validation, and reporting process 
illustrated in Figure 1-1. 
 
2.0 SUMMARY OF METHOD 
 
To assure complete, error-free data collection, data are usually logged on-site by a datalogger and 
collected hourly via telephone modem or satellite modem (see the Data Collection section of Figure 1-1). 
DataView software runs on laptop computers and the information written by the software to the station 
log is collected once each week via telephone modem (see the Data Collection section of Figure 1-1). 
Occasionally, telephone lines to a site are not available or data cannot be directly collected by modem due 
to problems such as modem or telephone line malfunctions. If data collection methods fail, the automatic 
IMC will attempt to recover data from the on-site DataView laptop or on-site data storage modules. Data 
can also be retrieved by connecting directly to a gas analyzer or particulate monitor and downloading files 
from the instrument(s) internal memory. In the event of DataView failure or at sites where manual logs 
are most practical, station logs and other quality assurance documentation can be manually completed and 
mailed, scanned and emailed, or faxed to the IMC. 
 
To summarize, the IMC collects data by one of these methods: 
 

• From a datalogger via telephone or satellite modem 
• From an FTP site 
• Directly from the instrument 
• From the on-site DataView laptop 
• On-site data storage devices (i.e., storage modules) 
• Digital transmission from a third-party source 
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Figure 1-1.   General Data Collection, Validation, and Reporting Flow Diagram. 
(Specific processes may vary by monitoring network). 

 



 Standard Operating Procedure 
Information Management Center - 

Data Collection  
Version:  1.0  I_IMC_DATACOLL_2017Oct_F_1.0 Page 5 of 22 
 

 

3.0 SCOPE 
 
Activities described in this document are performed by members of ARS’ Information Management 
Center, field specialists and site operators. Aforementioned parties have been appropriately trained to 
perform the responsibilities associated with their roles as described below. 

 
4.0 ROLES AND RESPONSIBILITIES 
 
Staff positions that have data collection responsibilities are: 
 
Data Analyst/Technician 
 
On a daily basis: 
 
• Set up and maintain the automatic data collection programs and support information. 
• Ensure that the virtual machines used for automatic data collection are fully operational, with both 

the necessary hardware and software running. 
• Review the status of the automatic data collection each morning (including reviewing the Data 

Collection Status Report) to verify complete, error-free data collection, assure the integrity of the 
monitoring systems, or to identify problems and initiate corrective actions. 

• If the Data Collection Status Report indicates an on-site datalogger time has drifted by more than 
two minutes, the data analyst/technician will update the datalogger clock. 

• Perform required daily retries. 
• Provide technical support to site operators via telephone. 
• Ensure proper archive and storage of final raw data files. 

 
Field Specialist 
 
• Inform data analyst/technicians of any changes in site configurations resulting from maintenance 

visits. 
• Inform data analyst/technicians of any equipment or data acquisition systems malfunction, 

replacements, additions, or inconsistencies. 
• Inform data analyst/technicians of any data acquisition system program changes. 
• Review stackplots and troubleshoot inconsistencies observed on the stackplots or identified by data 

analyst/technicians. 
• Provide assistance to the IMC for troubleshooting data collection problems. 
• Provide assistance in troubleshooting on-site instrument problems. 

 
Site Operator 
 
• Telephone the IMC or field specialist if data collection problems are noted on-site. 
• Provide on-site assistance for troubleshooting data collection problems. 

 
5.0 REQUIRED EQUIPMENT AND MATERIALS 
 

Detailed descriptions of all IMC hardware and software and monitoring station hardware requirements are 
presented by category in SOP 3341, Air Resource Specialists’, Inc. (ARS) Information Management 
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Center (IMC) Concept and Configuration. The IMC requires the following hardware and software to 
collect data from the dataloggers in the field: 
 

• DataView on-site system including a laptop computer, modem, and printer. 
• Monitoring site data collection hardware 

 
• IMC hardware: 

− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− Support hardware: 

- High-quality laser printer 
- Write-capable DVD drive 

• IMC software: 
− AQDBMS custom software 
− V3 Data Collection software 
− V3 Data Loading software 
− Network operating system and support software 
 

6.0 PROCEDURES 
 

This section includes six major subsections: 
 
 6.1 Automatic Data Collection 
 6.2 Manual Data Collection 
 6.3 Data Files Generated by V3 Data Collection 
 6.4 Configuring Data Collection 
 6.5 Daily Review of Data Directory Contents 
 6.6 Biweekly Station Log Collection 
 6.7 Monthly Archival of Final Raw Data Files 

 
6.1 AUTOMATIC DATA COLLECTION 
 
Hourly data are collected and loaded through a series of automated processes. The in-house data 
collection software, V3 Data Collection, continuously queues necessary data collection jobs. As resources 
become available, data collection begins to complete necessary jobs using methods specific to the data 
source. 
 
Most IMC data are collected directly from the datalogger in the field using a telephone or satellite 
modem. Upon successful connection to the site, data collection prompts the datalogger for needed data, 
including historical data that may be missing in the database. If a viable raw data file is collected, 
reformatted data are appended to the top of the file for database consumption. In the event that the data 
collection does not yield a viable raw data file, retries are continued a configured number of times. Raw 
data files are then stored on the network for data loading and raw data file archiving. Particulate matter 
(PM) data are collected directly from the BAM instrument using a similar technique. Data can also be 
manually collected by entering needed dates and times directly into the interface. After dates and times 
are provided, the job is added to the queue and acquired with the same procedure as noted above. 
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Data collected from air quality stations without telephone or cellular phone access is accomplished via 
HughesNet satellite. With HughesNet systems, ARS connects directly to monitoring stations via the 
internet using satellite modems.  
 
The data loading application runs concurrently with data collection. Data loading occurs as soon as data 
collection has completed successfully and a raw data file is placed on the network. Finally, data are 
loaded into the database. Data can also be hand-entered or blank-filled in the Data Validation interface. 
Data entry forms for entering non-hourly aerosol data, precision check data, and data from audit reports 
are also available. 
 

Table 6-1 
File Name and Directory Organization of Files Generated by AQDBMS Routines 

File Description Source(s) File Name(s)1 Directory Location2 Destination 

Data Collection Status Report AQDBMS yyyymmddDailyCollectionStatusReport.txt \sitecall\logs e-mail 

Raw ESC Hourly Data File Data Collection.exe ssss-ss_ins_01H_.R \ESC data loading 

Raw ESC Minute Data File Data Collection.exe ssss-ss_ins_01M_.R \ESC data loading 

Raw ESC Daily Data File Data Collection.exe ssss-ss_ins_24H_.R \ESC data loading 

Loaded ESC Hourly Data File ARSDataLoadingV3.exe ssss-ss_ins_01H_yyyymmddhhmiss.R \ESC\success\HOURLY or 

\ESC\failed\HOURLY 

archiving 

Loaded ESC Minute Data File ARSDataLoadingV3.exe ssss-ss_ins_01M_yyyymmddhhmiss.R \ESC\success\1MINUTE or 

\ESC\failed\1MINUTE 

archiving 

Loaded ESC Daily Data File ARSDataLoadingV3.exe ssss-ss_ins_24H_yyyymmddhhmiss.R \ESC\success\DAILY or 

\ESC\failed\DAILY 

archiving 

Archived ESC Hourly Data File ARSDataLoadingV3.exe ssss-ss_ins_01H_yyyymmddhhmiss.R archive\ESC\success\HOURLY 
or 

archive\ESC\failed\HOURLY 

archiving 

Archived ESC Minute Data File ARSDataLoadingV3.exe ssss-ss_ins_01M_yyyymmddhhmiss.R archive\ESC\success\1MINUTE 
or 

archive\ESC\failed\1MINUTE 

archiving 

Archived ESC Daily Data File ARSDataLoadingV3.exe ssss-ss_ins_24H_yyyymmddhhmiss.R archive\ESC\success\DAILY or 

archive\ESC\failed\DAILY 

archiving 

Data loading log files ARSDataLoadingV3.exe yyyymmdd_machine_Loading.log \logs reference 

Data loading error log files ARSDataLoadingV3.exe yyyymmdd_machine_LoadingError.log \logs reference 

Daily raw stackplot  
configuration and data files 

AQDBMS site.STK 

site.DAT 

Stkplots\DailyReview 

Stkplots\DailyReview 

Stackplot 

Stackplot 
 

Notes: 
1 File naming convention: yyyy = 4-digit year   ssss-ss = 6 character site code 

mm = 2-digit month   ins = 3 character instrument abbreviation 
   dd = 2-digit day   machine = data loading machine name 
   hh = 2-digit 24hour 
   mi = 2-digit minute 
   ss = 2-digt second 
   site = 4 character site code 
   STK = stackplot file   DAT = stackplot data file 

   2 Directory Location: The AQDBMS directory is currently located under N:\PROJECT\IMC\sitecall\V3. 
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Figure 6-1.  Example of V3 Data Collection Application.  
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Figure 6-2.  Example V3 Data Loading Application. 

 
 
6.1.1 Starting the Auto Poll Process 
 
The V3 Data Collection and the V3 Data Loading applications are always running on the data collection 
machines. V3 Data Collection is continually looking for data collection jobs to queue and V3 Data 
Loading is always looking for raw data files to be loaded. 
 
6.1.1.1  Polling Order 
 
The order in which the sites are polled is determined by the following: 

 
1. Polling time specified in site configuration records. 
2. Last data collection attempt time. 
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6.1.1.2  Reviewing the Data Loading Log Files 
 
The V3 Data Loading program continually logs messages regarding data loading progress and errors. The 
log files are called yyyymmdd_machine_Loading.log, where yyyy is the year, mm the month number, dd 
the day number and machine the name of the machine that completed the data loading (for example, the 
file 20171130_DataCollB.log holds the log entries for November 30, 2017 on the machine named 
DataCollB). Similarly, the error files are called yyyymmdd_machine_LoadingError.log. Both files are 
stored in the N:\project\IMC\sitecall\V3\logs directory and can be viewed by opening directly in any text 
editor. Figure 6-3 is a sample log file and Figure 6-4 is a sample error log file. 
 

 
Figure 6-3.  Example Data Loading Log. 
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Figure 6-4.  Example Data Loading Error Log. 

 
 
6.1.2 Data Collection Status Report 
 
The Data Collection Status Report is automatically e-mailed each morning and is subsequently examined 
by the data analyst/technician each working day, to determine the success or failure of the automatic data 
collection routines. An example of this report is shown in Figure 6-5. This report is intended to 
summarize the diagnostic information only. Detailed troubleshooting must be performed by the data 
analyst/technician by manually calling the problem site. 
 
6.1.3 Data Error Checking 
 
The data rarely have errors because all modems are error correcting. Manual error checking is not 
necessary. 
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Figure 6-5.  Example Data Collection Status Report.  

 
 
6.2 MANUAL DATA COLLECTION  
 
6.2.1   Manual Data Polling 
 
Manual data collection is used in the following situations: 
 

• When automatic data collection from a site has failed and the data are needed in the database. 
• When recent data are needed for immediate use. 

 
The data analyst/technician examines the Data Collection Status Report to determine which sites failed to 
poll correctly. If V3 Data Collection is unable to correctly retrieve error-free data, the data analyst/ 
technician manually retrieves as much data as possible as soon as possible using one of the following 
methods:  
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• Manual data retrieval using V3 Data Collection polling software. 
• Manual data retrieval from DataView. 
• Data received via e-mail or USB drive.  
• Third party data report. 

 
To manually poll (or re-poll) an individual site: 
 

• Select the necessary site and collection configuration needed in the V3 Polling Configuration 
application. 

• Select the Submit Manual Job tab. 
• Enter a data collection start date and click OK. 
• Enter a data collection end date and click OK. 
• The specified site and collection configuration will be added to the queue immediately and 

the data will be loaded after collection has completed. 
 
To manually re-poll all sites: 
 

• Click the Reset Attempts and Re-Poll button on the V3 Data Collection application. 
 
Manual data loading is used (1) when archived or edited raw data need to be written to the database 
without polling the site, or (2) when automated data collection has failed for an individual site. 
 
To manually load a site: 
 

• Put the file to be loaded in the appropriate network folder. For ESC files, this network 
location is: N:\project\IMC\sitecall\V3\ESC. 

 
6.2.2 Manual Data Retrieval from DataView 
 
DataView communicates directly with the datalogger, retrieving minute data every minute, hourly data 
every hour, and calibration data every day. These data are stored in a database on the DataView laptop at 
sites where DataView is in use. These data cannot be viewed outside of DataView unless they are 
exported to a comma-delimited ASCII file (.csv). This can be accomplished in two ways: 
 

• An IMC data analyst/technician can configure DataView to automatically and continuously 
save minute, hourly, and/or calibration data to an ASCII file. This is normally done only in 
situations where continuous data availability from the datalogger is not available.  
 

• The DataView user can interactively export specific data to the ASCII files. To retrieve data 
from the on-site DataView laptop: 

 
• Connect to the site’s laptop with PC Anywhere and log on to DataView. If DataView 

has been configured to automatically generate the .csv files, skip to “Transfer Files” 
below. 

• Manually export the data needed to .csv files. From dropdown boxes along the top of the 
screen, select Data Tables then Data Export. The Data Export form will appear. 

• Choose the export file destination. The default is C:\DataView2\Poll_data. Change this 
setting only if creating files that will not be sent to the IMC. If performing export on 
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site, it is recommended that data be exported onto C:\drive and transferred to a CD, 
DVD, or other media. 

• Select the appropriate data type (Hourly/Minute/Cals) and a parameter list will appear. 
If fulfilling an IMC request to recover missing datalogger data, select Hourly and Cals. 
Click the Select All button. 

• Select the appropriate dates. Click in the Start Date box and a calendar will appear. 
Select the start and end dates and click the button labeled Go. When the message Export 
Complete is displayed, click the Done button. Log off from DataView. 

• Transfer the files to the IMC using PC Anywhere. The following steps will transfer both 
the data files and the station log files to N:\project\IMC\DataView\poll_data. 

 
 On an IMC computer setup to automatically collect station logs with PC Anywhere: 

— Click the File Transfer button at the top of the screen. (The button looks like a 
page with a lightning bolt). 

— Click the Auto Transfer button, then OK, then Yes. 
— This will transfer the files from the site’s laptop to the correct location on the 

server and then will disconnect from the site. To remain connected, uncheck 
the End session when finished button when the File Transfer Status window 
appears. 

 
 On any other computer with PC Anywhere: 

 
— Click on the File Transfer button at the top of the screen. (The button looks 

like a page with a lightning bolt). 
— On your side of the file transfer screen, navigate to N:\project\IMC\DataView 

\Poll_data|.  
— On the DataView laptop side of the file transfer screen, navigate to: 

C:\DataView2\poll_data\. 
— Select the files to transfer. 
— Click the appropriate arrow. 

 
This will transfer the files from the site’s laptop to the correct location on our server 
to be loaded into the database (station logs) and afterwards, disconnect you from the 
site. If you wish to stay connected, uncheck the End session when finished button 
when the File Transfer Status window appears. 

  
 
 
 
 
 
 
 
 
6.3 DATA FILES GENERATED BY V3 DATA COLLECTION 
 
Data from the raw data files are automatically saved. Figure 6-6 shows an hourly raw datalogger data file. 
Figure 6-7 shows a daily report style raw datalogger data file. If data loading is successful, V3 Data 
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Loading moves files to the \success directory. The SOP I_IMC_DATAVAL_2017Oct_F_1.0, Information 
Management Center - Data Validation, details the steps of loading these data.  
 
 

 
Figure 6-6.  Example ESC Datalogger Raw Hourly Data File. 
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Figure 6-7.  Example ESC Datalogger Raw Daily Data File. 

 
 
6.4 CONFIGURING DATA COLLECTION 
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Data Collection configurations are set up using the V3 Polling Configuration application (Figure 6-8). 
To set up a polling configuration: 
 

• Select the necessary site from the dropdown box in the V3 Data configuration application. 
• Select the datalogger type or instrument type in the datalogger dropdown box. 
• Select the Comm Type in the dropdown box (IP or Dial Up). 
• Enter the IP or phone number, port numbers, passwords, and time zone in the respected 

fields. 
• Add a polling configuration by selecting the (+) button. Then name the configuration based 

on the naming convention listed in Table 6-1.  
 

 
Figure 6-8.  Example of V3 Polling Configuration Application. 

 
 
 
 
 
 
 

6.5 DAILY REVIEW OF DATA DIRECTORY CONTENTS 
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Daily review of file sizes and locations is useful for error control. Data directories will be visually 
scanned for the following: 
  

• Ballooning file sizes - these may indicate unplanned or unintentional configuration changes 
• Small file sizes - these may indicate connection issues that are limiting collection times while 

connected 
• Loading failures - these may indicate unexpected data characters in raw data files or other 

polling and/or loading issues 
• Duplicate files for the same time periods - these may coincide with any of the issues above 

and may indicate any number of polling and/or loading issues 
 
6.6 BIWEEKLY STATION LOG COLLECTION 
 
A flowchart of the station log process is provided in Figure 6-9. Files generated by this process and their 
distribution are shown in Table 6-2. 
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Figure 6-9.  AQDBMS Station Log Acquisition and Processing Flowchart 
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Table 6-2 

 

File Name and Directory Organization of Files Generated by Station Log Collection Routines 
 

File Type File Description Source(s)1 File Name(s)2 Directory Location3 Destination 
Station 
Logs 

Comma-delimited 
ASCII text files 

Station log 
collection 
software 

sitemmddyyyylog.
csv 

DATAVIEW\POLL_DA
TA 
 

Archived and 
imported to 
AQDBMS 

Notes: 
1 Refers to routines defined in Figure 4-1. 
 
2 File naming convention: mm = 2-digit month   site = 4-character site code 
   (based on MS-DOS dd = 2-digit day    RET = retry file 
   8.3 file name format) yyyy = 4-digit year   SPN = span file 
   ERR = error report   DAT = stackplot data file 
   MES = detailed message report  D = hourly data import file 
   SUM = summary report   L = calibration data import file 
   CSV = Excel import format file 
 
3 Directory Location: The AQDBMS directory is currently located under N:\PROJECT\IMC\. 
 
6.6.1 Automatic Station Log Collection 
 
The station logs are collected by several methods. At sites with reliable communications, the station logs 
are automatically acquired by the station log collection software and stored in comma-delimited ASCII 
files. If the automatic collection fails, the data analyst/technician may also run the software manually. 
Station logs at sites that do not have reliable telephone service are collected by the site operator onto a CD 
or thumb drive using a DataView utility and then transmitted to the IMC by e-mail or regular 
mail/shipping. Logs may also be hand-entered from printed copies of the logs. 
 
6.6.1.1 Starting the Automatic Station Log Software 
 
The automatic station log collection software is loaded onto a computer with a modem. The software uses 
a continuous clock/timer function and is configured to begin execution at 2:30 a.m. each Wednesday. This 
program calls each DataView site and downloads the most recent station log files to the IMC as comma-
delimited ASCII files. 
 
6.6.1.2 Polling Order 
 
The order in which the sites are polled is determined by the time specified in the automatic station log 
collection software setup, and generally polls according to time zone. The sites are polled in 15-minute 
intervals with four (4) automatic retries built in to each polling session. To change the polling time of a 
site, the polling configuration can be directly edited. 
 
6.6.1.3 Reviewing the Station Log Acquisition Status 
 
The current availability of station logs may be reviewed at any time by running the DataView Status 
Summary program. A sample of the status summary output is provided as Figure 4-2. This program lists 
by site, the date of the last station log acquired and the age of the file. Station log files older than 7 days 
are highlighted. Several columns of information are presented in this table for troubleshooting purposes. 
The data analyst/technician should review the last three columns of the report daily and take action to 
recover station logs older than 7 days. 
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Figure 6-10.  Example DataView Status Report. 

 
 
6.6.2 Manual Station Log Collection 
 
6.6.2.1 Manually Retrieving Digital Station Logs 
 
If automatic acquisition of the digital station logs fails, the data analyst/technician should attempt to 
manually retrieve the file by running the station log collection software. After the program begins, the 
analyst should select the site that has failed and choose the Run button. If several manual attempts fail, 
the problem must be reported to network operations for troubleshooting. 
 
6.6.2.2 Manually Retrieving Hardcopy Station Logs 
  
If, after all attempts at acquiring the digital station logs fail, including on-site remedies, the data 
analyst/technician must contact the site operator and request that a copy of the missing pages be printed 
and/or copied from the DataView computer and mailed to the IMC. 
 
6.6.3 Automatic Import of Station Logs to the AQDBMS 
 
Newly acquired station log files are automatically imported into the AQDBMS daily during the automatic 
data collection process. 
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6.6.4 Monthly Archive of Raw Station Log Files 
 
All collected raw station log files are archived monthly with the other raw data files. Each quarter, the 
station log files are checked for completeness and organization. They are then written to CD once per year 
and distributed. This process is accomplished in the following steps: 
 

• The data analyst/technician ensures that a complete month of station logs have been collected 
and resides in the \poll_data directory. 

• Create two (2) copies of the CD and store one copy on-site in the IMC and one in an off-site 
location other than the IMC. Additional copies may be provided to the client if requested. 

 
6.7 MONTHLY ARCHIVAL OF FINAL RAW DATA FILES 
 
Raw data files must be archived for possible future reference. The previous sections in this document 
describe the process to collect and load the data. At the end of each month, the data files are reorganized 
and moved into a data archiving directory structure. On a quarterly basis the previously archived files are 
written to DVD and distributed. Files remain on the network for approximately one year after they have 
been archived to DVD. 
 
 To archive data files:  

• Navigate to the N:\project\IMC\sitecall\V3\archive directory. 
• Open the DataFileArchive application. 
• As necessary, change any of the default data. 
• Click the GO Archive! button. This process may take a considerable amount of time and time 

must be allowed for completion. 
 

 
Figure 6-11.  Example Data File Archive Application. 
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7.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2012, Air Quality Data Base Management System (AQDBMS) 
User’s Guide. 
 
8.0 DEFINITIONS AND ACRONYMS 
 

AQDBMS Air Quality Database Management System 
ARS Air Resource Specialists, Inc. 
ASCII American Standard Code for Information Interchange 
BAM Beta Attenuation Monitor 
CD Compact Disc 
DVD Digital Versatile Disc 
FTP File Transfer Protocol 
IMC Information Management Center 
PM Particulate Matter 
SOP Standard Operating Procedure 

 
 



 Standard Operating Procedure 
Information Management Center - 

Data Validation 
Version:  1.0  I_IMC_DATAVAL_2019Jul_F_1.0 Page 1 of 93 
 

 
Approvals 

 
The purpose of this review and approval is to evaluate this Standard Operating Procedure (SOP) for 
adequacy prior to issuance.  The signatories below are stating that the approach defined within this 
document is acceptable and that the affected company interests have been represented. 
 
 
 

Author Signature: 

 

 
 

Program: QA Manager 

Approval Signature: 

 

 
 

Program: IMC Section Manager 
   

  



 Standard Operating Procedure 
Information Management Center - 

Data Validation 
Version:  1.0  I_IMC_DATAVAL_2019Jul_F_1.0 Page 2 of 93 
 

 
 

 REVISION HISTORY 
 

Review date: Changes made: Changes made by: 
   
   
   
   
   
   
   

 
 

ANNUAL REVIEW 
 

The undersigned attests that this standard operating procedure has undergone annual review for adherence to current 
practices and the latest QA/QC protocols: 
 
   

Signature Title Date 
   

Signature Title Date 
   

Signature Title Date 
   

Signature Title Date 
 
  



 Standard Operating Procedure 
Information Management Center - 

Data Validation 
Version:  1.0  I_IMC_DATAVAL_2019Jul_F_1.0 Page 3 of 93 
 
1.0 PURPOSE  
 
This standard operating procedure (SOP) outlines the steps of ambient air quality and meteorological data 
validation, to assure quality data and to ensure that data are validated to meet Environmental Protection 
Agency (EPA) guidelines for successful submission to the EPA AQS (Air Quality System) database. The 
steps outlined apply to all ambient air quality and meteorological parameters that are monitored and 
loaded into the Information Management Center (IMC) database, regardless of whether the data for a 
specific parameter are uploaded to the EPA AQS database. 
 
2.0 SUMMARY OF METHOD 
 
The validation process consists of the following major steps: 

 
• Review of raw data visually on a daily basis for data acquisition errors, and for details on 

instrument performance. Process data through Level 0 validation to ensure that all possible 
data have been collected and are correctly loaded into the permanent table of the database. 

• Process data through Preliminary validation to identify values that do not meet acceptance 
criteria. 

• Process data through Final validation that includes input from air quality specialists, field 
specialists, and site operators to resolve all questionable validation issues. 

• Accommodate post-final validation changes when necessary. 
 
Successful validation at each level requires completion of a set of automatic (computer program) and 
manual checkpoints as shown in the data collection, validation, and reporting flow diagram (Figure 2-1). 
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Figure 2-1.   General Data Collection, Validation, and Reporting Flow Diagram. 
(Specific processes may vary by monitoring network). 
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3.0 SCOPE 
 
Activities described in this document are performed by members of ARS’ Information Management 
Center, field specialists, technical assistants, site operators and sponsoring organization staff members. 
Aforementioned parties have been appropriately trained to perform the responsibilities associated with 
their roles as described below. 

 
4.0 ROLES AND RESPONSIBILITIES 
 
Staff positions that have data validation responsibilities are: 
 
Information Management Section Manager 
 

• The information management section manager shall oversee validation procedures to ensure 
timely and proper validation. The manager shall update the Data Validation Log in the AQDBMS 
with the Final validation date after performing a final review of the data. 

 
IMC Team Lead 
 

• Review all calibration results and verify that all affected data are properly dealt with. 
• Update information in the Site Configuration Table of the AQDBMS and stackplot configuration 

files as needed. 
• Review stackplots of raw data. 
• Verify Data Validation Log updates. 
• Update the Data Validation Log with detailed data validation notes.  
• Blank-fill missing data as necessary. 
• Collect and log field documentation. 
• File all hardcopy documentation and maintain hardcopy site files. 
• Identify collection or monitoring system problems and initiate corrective actions. 
• Review preliminary validations performed by the data analysts/technician. 
• Participate in the monthly plot review and respond to questions posed during the plot review. 

 
Data Analyst/Technician (IMC Team Lead may also assist with these duties) 
 

• Update information in the Site Configuration Table of the AQDBMS and stackplot configuration 
files as needed. 

• Review stackplots of raw data. 
• Verify Data Validation Log updates. 
• Update the Data Validation Log with detailed data validation notes.  
• Update the Data Validation Log in the AQDBMS with the Level 0 and Preliminary validation 

dates. 
• Collect digital data and load it into the database. 
• Blank-fill missing data as necessary. 
• Collect and log field documentation. 
• File all hardcopy documentation and maintain hardcopy site files. 
• Identify collection or monitoring system problems and initiate corrective actions. 
• Review validation codes applied by the Auto Validation tool. 
• Review and annotate stackplots using field documentation and Auto Validation codes. 
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• Review plots of the validated data to check for errors. 
• Review annotated stackplots with the field specialist. 
• Participate in the monthly plot review and respond to questions posed during the plot review. 
• Review validated stackplots. 
• Generate the data reports. 

 
Field Specialist 
 

• The field specialist shall review stackplots and troubleshoot inconsistencies observed on the 
stackplots or identified by IMC staff. 

• Participate in the monthly plot review. 
 
Site Operator 
 

• The site operator shall respond to any questions regarding site documentation or data events, and 
forward any additional comments or observations to the IMC. 

 
Technical Assistant 
 

• Review/edit/format/PDF/print out trip reports and give them to the IMC. 
• File all hardcopy documentation. 

 
Sponsoring Organization Staff 
 

• Telephone the IMC or field specialist if data collection problems are noted on site. 
• Provide on-site assistance for troubleshooting data collection problems. 

 
5.0 REQUIRED EQUIPMENT AND MATERIALS 
 

All IMC equipment and materials are fully described in and SOP 3341, Air Resource Specialist’s, Inc. (ARS) 
Information Management Center (IMC) Concept and Configuration. The IMC requires the following 
hardware and software for validation of ambient air quality and meteorological data: 
 

• IMC hardware: 
− Hardware specifications for IMC servers 
− Hardware specifications for workstations 
− IMC computer support hardware: 

− High-quality laser printer 
 

• IMC AQDBMS software: 
− Oracle Database System 
− AQDBMS custom software: 

− Data validation and reporting software 
− Network operating system and support software 
− V3 data collection software 
− V3 data loading software 
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6.0 PROCEDURES 
 

This section is comprised of five major subsections: 
 
 6.1 Validation Logging 

6.2 Level 0 Validation Procedures 
 6.3 Preliminary Validation Procedures 
 6.4 Third Level Validation Procedures 
 6.5 Final Validation Procedures 

 
6.1 VALIDATION LOGGING 
 
6.1.1 THE DATA VALIDATION LOG 
 
The Data Validation Log is used to track the completion of each major step of the validation process. A 
log is created in the AQDBMS for each site by month and year. The master record logs the initials of the 
data analyst/technician completing each validation step and when it occurred. The validation log also 
provides a summary of the decision-making process that went into validating the data. The data 
analyst/technician provides justification for the validation codes that were applied to the data. See Section 
4.0, Using the Data Validation Log, in the Air Quality Data Base Management System (AQDBMS) User’s 
Guide (ARS, 2012) for detailed instructions. 
 
To use the Data Validation Log: 

• Select Logs-> Data Validation Log from the AQ and Met Processing frame. 
• Select a site from the Site drop-down box. If no records for the selected site exist, a “Site not 

Found” message is displayed. Click OK. Otherwise, the most recent Master Table record and 
related comments for the selected site are displayed. 

• Select a different month and/or year from the drop-down list boxes to display previous month’s 
records for the site. 

• Records can be added by right-clicking and selecting Add. 
 
6.1.2 THE SITE STATUS LOG 
 
The Site Status Log is a diary of site-related events such as instrument malfunctions and repairs, data 
adjustments, calibrations, special site visits, weather episodes, etc., that may be relevant to data 
validation. A basic description of each event is entered as a record in the Master Table. The master record 
contains the site number and name, a reference number assigned by the program, date started and stopped 
fields to define the period of time involved, and an affected parameters field to indicate which data 
parameters may be affected by the event. Another field indicates if the event is considered to be a 
problem or not. This field is used to quickly create a list of current problems found in the log. The Detail 
Table holds as many records as needed to record notes about each event. Normally, a master record will 
have at least one detail record. Entries can be added, modified, or deleted in both the Master Table and the 
Detail Table. See Section 5.0, Using the Site Status Log, in the Air Quality Data Base Management 
System (AQDBMS) User’s Guide (ARS, 2012) for detailed instructions. 
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6.2 LEVEL 0 VALIDATION PROCEDURES 
 
6.2.1 LOADING AND ENTERING DATA INTO THE AQDBMS DATABASE 
 
Data are collected hourly via modem or TCP/IP and stored digitally as explained in  
SOP I_IMC_DATACOLL_2017Oct_F_1.0, Information Management Center - Data Collection.  
 
6.2.1.1 Correcting Data Loading Errors 
 
The AQDBMS program writes messages to a folder indicating reasons for loading failures and records of 
loading successes. This folder is located in the \\ARSLS2\data\Ndrive\Project\imc\sitecall\V3\logs 
directory and can be viewed in any text editor. The folder contains success logs (...Loading.logs) and 
failure logs (...LoadingError.logs). 
 
6.2.2 DATA REVIEW 
 
Data are typically collected via modem and stored in ASCII files (see SOP 
I_IMC_DATACOLL_2017Oct_F_1.0, Information Management Center - Data Collection). Data flags 
generated by the dataloggers are also stored. Table 6-1 is a list of datalogger flags. The data and flags are 
then loaded into the AQDBMS database and visually reviewed by the data analyst/technician in graphical 
format for data acquisition errors and for details on instrument performance.  
 

Table 6-1  
 

   ESC 8816 Datalogger Data Flags1 

 

Flag          Description 
P Power failure 
D Channel Disabled/Off-line 
B Bad status 
C Calibration 
M Maintenance 
+ Maximum exceeded 
- Minimum exceeded 
> Some missing data, but meets requirement for valid average 
< Does not meet requirement for valid average 
H High-high alarm threshold exceeded 

  1  These flags are replaced by permanent validation codes later in the validation process. 
 
 
6.2.3 ANOMALY SCREENING 
 
After data for a site/day are verified, they are automatically screened for anomalies by an AQDBMS 
program. This program applies anomaly flags (Level 0 validation codes). These flags are added in a 
separate screening flag field. The screening program uses values stored in the AQDBMS Screening 
Ranges Table. Figure 6-1 shows example records from this table. It contains the screening ranges for each 
current site and parameter code, which allows each screening element to be defined independently from 
the other.  
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Figure 6-1.  Example Records in the Screening Ranges Table. 
 
To manually screen the data for anomalies, click the Screen button. The program looks up acceptable 
ranges of values in the Screening Ranges Table and flags anomalies. The program also compares the 
values of certain parameters and applies flags as needed. Table 6-2 is a list of anomaly flags. The program 
stops and a message is displayed if screening ranges have not been defined for a site/parameter 
combination. In this case, request that the data analyst/technician make appropriate changes to the 
Screening Ranges Table, as described in SOP 3650, Maintenance Responsibilities for the Ambient Air 
Quality Data Base Management System (AQDBMS). After the data analyst/technician makes the changes, 
run the screening program again. 
 
After screening, the data analyst/technician notifies the field specialist by opening a site status log if any of 
the following are true: 
 

• Data for any parameter are at a full scale or zero scale values for an uncommonly long time. This 
indicates an instrument may have been left in zero or span mode inadvertently. 

• Daily calibration data (zero and span values from the analyzer) are not within the expected range.  
• Other unusual and noteworthy data flags that would call attention to either a needed repair of an 

instrument or correction of a condition by the site operator. 
 

  



 Standard Operating Procedure 
Information Management Center - 

Data Validation 
Version:  1.0  I_IMC_DATAVAL_2019Jul_F_1.0 Page 10 of 93 
 

 

Table 6-2 
 

Anomaly Screening Flags 
 

Flag Description 
XV > the maximum value in the Screening Ranges Table. 
NR Rate-of-change < minimum value in the Screening Ranges Table. 
NV < minimum value in the Screening Ranges Table. 
WS Scalar wind speed > Vector wind speed - generated by the screening program 
IM Set in VWS, VWD, and SDWD when SWS < minimum expected (NV) 
XR Rate-of-change > the maximum value in the Screening Ranges Table. 
TH Data invalid for ozone when station temp is ≥ 30.5ºC. 
TL Data invalid for ozone when station temperature < 19.5ºC. 
VM Valid but the validated value has been adjusted for the max value by the screening 

program based on the max_adj, max_adj_to, and max_val fields of the Screening 
Ranges Table. 

VZ Valid but the validated value has been adjusted for zero by the screening program 
based on the zero adjustment value in the Screening Ranges Table.  

 
Corrective action is initiated to resolve any noted inconsistencies and the problem and actions are entered 
in the AQDBMS Site Status Log.  
 
6.2.4 USING THE AQDB UPLOAD INTERFACE TO FLAG DATA 
 
The Data Upload Configuration Lightswitch application provides a method to exclude suspect data from 
automated data dissemination processes. Following the data review process, any parameters that are 
found to have instrument malfunctions or reporting errors that aren’t already flagged on the logger should 
be flagged down using this tool in order to prevent bad data from being distributed. A flag should be 
applied beginning with the first hour of suspect data. If the problem was short-lived or has already been 
resolved at the time the flag is applied, an end date can be entered into the application so only the affected 
hours are flagged. If the problem is persistent and has yet to be resolved, the end date should be left blank. 
This will ensure that each new hour of data that is collected for the particular site and parameter where the 
flag is applied will continue to be flagged and removed from data uploads until the issue has been 
resolved and an end date applied. 
 
6.2.5 REVIEW OF RAW DATA STACKPLOTS 
 
A stackplot may include single or multiple user-selected parameters on line or bar graphs plotted against 
time on the X-axis. Up to 20 parameters may be plotted on up to 10 separate graphs (1 or 2 parameters per 
graph) in a stack. Temporal data variations are then easy to compare. Stackplots are used throughout the 
validation process. Raw data are graphed on stackplots on a weekly basis for each site for the following 
time periods each month: 

 
• Days 1 – 7 
• Days 8 – 15 
• Days 16 – 23 
• Days 24 – end of month 
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One copy of each plot is generated weekly and reviewed by all data analyst/technicians. Problems not 
detected up to this point in the validation process are entered into the Site Status Log and a field specialist 
is notified for resolution of the problem. Comments regarding the data are handwritten on the plots. This 
copy is then filed in a temporary file box in order to receive further comments later in the validation 
process. For instructions on running the stackplot graphics program, see the Air Quality Data Base 
Management System (AQDBMS) User’s Guide (ARS, 2012). 
 
6.2.6 SITE DOCUMENTATION 
 
Site operators are required to complete station checklists in DataView during every station visit. The 
station checklists are downloaded and stored in the AQDBMS. At times, manual checklists must be 
completed by the site operators and faxed or e-mailed to the IMC. When this is necessary, the manually 
collected information is filed with other site documentation in the IMC. 
 
Level 0 validation is complete for a site/month on the date all possible data for the month has been 
collected and loaded into the AQDBMS database and all site documentation has been received. This date 
is entered in the AQDBMS Data Validation Log. 
 
6.3 PRELIMINARY VALIDATION PROCEDURES  
 
Data for a site/month must be at Level 0 validation before beginning Preliminary validation. The Monthly 
Validation Checklist, shown in Figure 6-2, is used as a guide for the Preliminary validation procedure. The 
checklist identifies the major steps taken during Preliminary validation and provides a record of the date 
each step was completed and the initials of the analyst completing it. Preliminary data validation is 
accomplished by the following: 
 

• Review the previous months’ stackplots and Data Validation Log. 
• Review and validate calibration plots. 
• Print and review precision plots. 
• Print and review station log and Site Status Log. 
• Review SSRF forms, trip reports and check RH calibration results. 
• ‘Auto validate’ data. 
• Run “datalogger flags listing” report from database, verify all flags are coded. 
• Check minimum and maximum thresholds for all parameters. 
• Review minute trace for all gases. 
• Apply additional validation codes if necessary. 
• Record annotation and weekly stackplots. 
• Run and print “Stackplots for Validation Review;” review and change codes as needed. 
• Update Data Validation Log. 

 
Validation acceptance criteria and the methods for determining if a data value meets the criteria are 
usually related to one of the following events or limitations (examples of specific criteria for each 
parameter are presented in Appendix A. These criteria may vary based on specific project requirements): 
 

• Data are out of instrument specifications. 
• Data exceed minimum or maximum expected value. 
• Data exceed minimum or maximum expected rate-of-change. 
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• Station temperature is out of specified limits. (See the Appendix of this SOP for a list of 
instruments and their approved station temperature operating ranges.) 

• Data are affected by calibration check. 
• Zero and span check data are within specified limits. 
• Less than 45 minutes of data are available (hourly averaging period). 
• Instrument or datalogger was affected by acts of nature. 
• Instrument or datalogger was affected by power failure. 
• Data capture was affected by a datalogger failure. 
• Data were affected by operator maintenance or calibration check. 
• Data were affected by site operator error. 
• Data were affected by instrument malfunction or failure. 
• Data were below lower detectable limit. 

 
The Appendix of this SOP provides additional details on what types of failures and specific criteria to 
look for by parameter. The Appendix also lists project-specific validation acceptance criteria by 
parameter.  
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Figure 6-2.   The Monthly Validation Checklist. 
  

MONTHLY VALIDATION CHECKLIST 
 

                                                                                        Site_____________ 
                                                                                                     

                                                                                                            Month/Year_____________ 
 
Preliminary   (and level 0 verification)      DATE              INITIALS  

   
1. Review previous months’ Stackplots and Data Validation Log. ______ ______ 
   
2. Review and validate Calibration Plots. ______ ______ 
 
3. Print and review Precision Plots. ______ ______ 

       
4. Print and review Station Log and Site Status Log                                       ______ ______ 
  
 Monthly RNF      Monthly PM flow check      Weekly station checks 
          
 
5. Review SSRF Forms, Trip Reports & check RH Cal Results. ______ ______ 
  
6.     ‘Auto Validate’ data. ______ ______ 
 
7. Run “datalogger flags listing” report from database, verify all flags are coded. ______ ______ 
 
8. Check minimum and maximum thresholds for all parameters.  ______ ______ 
 
9. Review minute trace for all gases.  ______ ______ 
 
10. Apply additional validation codes if necessary. ______ ______ 
 
11. Record annotations on weekly stackplots. ______ ______ 
 
12. Run and print “Stackplots for Validation Review”– review & change codes as needed.   ______                     ______ 
 
13. Update Data Validation Log.  ______                    ______         

 
3RD Level 

 
14. Review Site Status Log, Field Station Logs, Calibration Plots, and                                  ______                    ______  
 Precision Plots to verify annotations on plots.  
 
15. Check minimum and maximum thresholds for all parameters.  ______                    ______ 
 
16. Review Validated Stackplots, investigate suspect data if necessary.  ______                    ______ 
 
17. Verify preliminary Validation Codes in database.  ______                    ______ 
 
18. Update Data Validation Log.  ______                    ______ 
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6.3.1 REVIEW THE PREVIOUS MONTHS’ STACKPLOTS AND DATA VALIDATION LOG 
 
Review the previous months’ annotated stackplots as well as the data validation log to see what issues 
occurred that may carry over into the current month being validated. Data should continue to be 
invalidated using the same validation code for any issue that was not resolved the previous month. 
 
6.3.2 REVIEW AND VALIDATE CALIBRATION PLOTS 
 
For all gas parameters the monthly calibration plot is reviewed. This plot displays the results of the daily 
automated zero, precision, and span. Acceptance criteria for all relevant parameters can be found in the 
Appendix of this SOP. When checks fall outside of acceptable limits, data are invalidated back to the last 
good check until the issue is resolved. Zero drift can be corrected by zero-correcting data based on the 
zero checks. 
 
Each gaseous parameter should run a zero, span, and precision on a regular basis.  The results from these 
calibration events must be reviewed as a part of the data validation process to verify that the data are 
accurate.  Refer to the acceptance criteria for each event by parameter in the Appendix of this SOP. 
 
To review the calibration results, run a calibration plot for each gaseous pollutant from the reports 
interface of the AQDBMS. These plots display the result of each event as well as the percent difference 
for comparison to the acceptance criteria. Identify events that are outside of the acceptable limits. Data 
outside of these limits are not necessarily invalid.  Checks found outside of limits should be investigated 
to determine if the poor response is an accurate reflection of the analyzer response or if there was an issue 
with the event running correctly. Once it is determined which checks are valid and which are invalid, 
validation codes should be applied to each calibration check using the ‘Data Validation for Calibration 
Data’ window of the AQDBMS. If the analyzer is the one that is not responding correctly then ambient 
data must be invalidated.  Data are invalidated beginning the hour after the last known good calibration 
event until the next good calibration event. 
 
Sometimes data can be adjusted when the zero results are not within the acceptance criteria.  Procedures 
for adjusting data in this situation are as follows: 
 

1. Data are not adjusted until the zero results are outside of the criteria listed in the Appendix of 
this SOP. 

2. Data are adjusted from the point at which the zero drifted outside of limits until the next zero 
that is within limits. 

3. Data are adjusted by subtracting the result of the zero from the raw values. 
 

Refer to the Appendix of this SOP for further instructions on how to zero adjust data. 
 
Note:  In general ozone data are not adjusted when zero results are outside of tolerance, rather the data are 
invalidated. Exceptions to this rule may be made with the approval of the project manager. 
 
6.3.3 PRINT AND REVIEW PRECISION PLOTS 
 
A precision plot shows the percent difference of each valid 1-point QC check on a bar chart. This plot can 
be generated from the reports interface of the AQDBMS and should be run to verify that all valid checks 
are within limits and that sufficient checks were performed during the month. Refer to the Appendix of 
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this SOP for criteria on how often a 1-point QC check needs to occur. If checks do not occur at the 
required frequency, a qualifier code of ‘QX’ should be applied to the data beginning the hour after the last 
valid check occurred under the next 1-point QC check runs. 
 
6.3.4 PRINT AND REVIEW STATION LOG AND SITE STATUS LOG 
 
Site operators are required to complete site station logs when performing checks at the site. These station 
logs are collected and loaded into the AQDBMS. Station logs can be printed by selecting this report 
product from the reports interface. These logs should be generated and reviewed to determine when 
maintenance was performed at the site. Site operator comments are reviewed to determine if any issues 
occurred at the site that may have affected data. 
 
After reviewing the station logs, check off site visits on the validation checklist to document whether or 
not all required visits are being performed each month. Also mark on the checklist if a precipitation check 
or flow check (PM instruments only) was performed for the month. 
 
The Site Status Log is a summary of site-related events such as instrument malfunctions and repairs, 
special site visits, unusual events, etc. that may affect data validation. Print and review all site status logs 
that pertain to the month and site that is being validated to determine periods of data that may need to be 
invalidated. The field group should be consulted if there is any information in the Site Status Log that is 
not clear on how it may affect data. 
 
6.3.5 REVIEW SSRF FORMS, TRIP REPORTS AND CHECK RH CALIBRATION RESULTS 
 
All CASTNET sites will have SSRF forms associated with the filter pack system. These forms should be 
reviewed to determine if any leaks are present in the system. 
 
Trip reports are reviewed to verify that all calibration results are within data validation acceptance 
criteria. Refer to the Appendix of this SOP for a list of acceptance criteria by parameter. Any results 
outside of tolerance should be reviewed with the field technician that performed the work in order to 
understand what caused the failure. If the failure is determined to be accurate, data should either be 
invalidated or adjusted back to the last good check. 
 
Relative humidity sensors are routinely changed out during semi-annual maintenance visits and are 
brought back to the ARS lab for calibration. Results from the calibration in the lab should be reviewed to 
determine whether or not data collected from that particular relative humidity sensor were within 
acceptance criteria. Figure 6-3 presents a sample report of RH calibration results. 
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Figure 6-3.  Sample Report of RH Calibration Results (Page 1) 
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Figure 6-3.  Sample Report of RH Calibration Results (Page 2) 
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6.3.6 ‘AUTO VALIDATE’ DATA 
 
During the preliminary validation process, data validation codes are applied to every record of data using 
the ‘Auto Validate’ button within the data validation window. First select the site, date range and 
parameters to be validated then click the ‘Auto Validate’ button. Codes are then automatically applied to 
each record of data selected. These codes are guided by the datalogger and anomaly flags that are already 
in the database from the data collection process. A validation code is entered for each data point in a field 
separate from the datalogger and anomaly screening flags. A list of datalogger and anomaly screening 
flags and most common actions taken based on the flags can be found in the Appendix of this SOP; as can 
a list of validation codes and conditions. 
 
To apply validation codes automatically: 
 

• Select the site to validate. 
• Enter the Start Date/Time of the data set to work on. 
• Enter the End Date/Time of the data set to work on. 
• Click the Get ParCodes button. The program queries the database and returns all the parameter 

codes found for the selected site and period in the list box. 
• Select (highlight) one or more parameter codes in the list box. 
• Select the Auto Validation button and the database applies a validation code to each record 

selected. 
 
6.3.7 RUN “DATALOGGER FLAGS LISTING” REPORT FROM DATABASE, VERIFY ALL 

FLAGS ARE CODED 
 
The "datalogger flags listing" report product provides a list of all hours by parameter that were invalidated 
during the auto validation process. This product displays the code that was automatically applied to each 
record of flagged data. 
 
Generate this report from the reporting interface to review the data records and parameters that were 
flagged down for the month and to determine whether or not the validation codes that were automatically 
applied need to be manually changed or updated. Validation codes should be manually changed as needed 
only after reviewing other pieces of information such as the station logs, site status logs, stackplots, etc. 
Figure 6-4 displays a sample datalogger flags listing report. 
 
6.3.8 CHECK MINIMUM AND MAXIMUM THRESHOLDS FOR ALL PARAMETERS 
 
Check that each parameter is within minimum and maximum acceptance limits. This is done by viewing 
each parameter, one parameter at a time, in the data validation window. Right click to sort by the display 
value. This will sort each record for the month from lowest to highest value allowing the user to quickly 
check that no validated data points are outside of the acceptable limits for each parameter. See the 
Appendix of this SOP for a list of acceptable minimum and maximum values by parameter. 
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Figure 6-4.   Sample Datalogger Flags Listing Report 
 
 
 
 
 
 



 Standard Operating Procedure 
Information Management Center - 

Data Validation 
Version:  1.0  I_IMC_DATAVAL_2019Jul_F_1.0 Page 20 of 93 
 

 

6.3.9 REVIEW MINUTE TRACE FOR ALL GASES 
 
The minute trace from each gas analyzer should be reviewed either in DataView or by running the 1-
minute stackplot for the AQDBMS to determine if any dropouts, spikes, or noise in the data may have 
occurred that would affect the hourly averages. The corresponding data record should be invalidated 
where any spike or dip that is determined to be an anomaly affects the hourly average (e.g. the value 
would have been larger or smaller than recorded had it not been for the anomaly). The appropriate data 
records should also be invalidated if qualitative review of any noise is seen that affects the hourly 
average. A Site Status Log should be opened if the noise is persistent. See the Appendix of this SOP for 
more detail on what to look for in the minute trace. 
 
The minute trace should also be viewed to determine what types of calibrations occurred in order to 
accurately select the validation code that should be applied during each event. See the Appendix of this 
SOP for a list of calibration shapes by type of event. 
 
 
6.3.10 APPLY ADDITIONAL VALIDATION CODES IF NECESSARY 
 
During the Preliminary validation process, validation codes are applied in the database. The codes entered 
are guided by the datalogger and anomaly flags that are already in the database. A validation code is 
entered for each data point in a field separate from the datalogger and anomaly screening flags. A list of 
datalogger and anomaly screening flags and the most common analyst actions taken based on the flags 
can be found in the Appendix of this SOP; as can a list of validation codes and conditions. 
 
The Data Validation interface of the AQDBMS is used to apply validation codes to the data via two 
windows. The initial window provides a way to apply codes to all data points, list missing data, and 
blank-fill data within a selected set of data. The second window displays a tabular data window of the 
selected data and provides a way to apply validation codes to selected data points within a window. It 
provides an interface for sorting and applying specific filters to the data and for hand entering data.  
 
To open the Data Validation window, select Validate from the AQ and Met Processing frame. 
 
6.3.10.1   The Initial Data Validation Window 
 
Validation codes may be applied automatically by using the “Auto Validation” button in the Data 
Validation window, or they may be applied manually by the data analyst/technician when there is a need 
to override the codes applied by the database. When entering the data validation interface, the initial Data 
Validation window can be used to list missing data, blank-fill data, auto validate data, display a data grid, 
or enter the interface to manually apply validation codes.  This window is shown in Figure 6-5. 
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Figure 6-5. The Initial Validation Window. 
 
To apply validation codes manually: 
 

• Select the site to validate. 
• Enter the Start Date/Time of the data set to validate. 
• Enter the End Date/Time of the data set to validate. 
• Click the Get ParCodes button. The program queries the database and returns all the parameter 

codes found for the selected site and period in the list box. 
• Select (highlight) one or more parameter codes in the list box. 
• Select a validation code from the Validation Code drop-down box. 
• Click the Apply Code button. The process window displays a message listing the number of 

updated records. 
Important Note: When using this method, validation codes are committed to the database table 
immediately. This method should only be used for power failures or when blank-filling data 
(see instructions on blank-filling below). 
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To search for missing data: 
 

• Select the site to validate. 
• Enter the Start Date/Time of the data set to validate. 
• Enter the End Date/Time of the data set to validate. 
• Click the Get ParCodes button. The program queries the database and returns all the parameter 

codes found for the selected site and period in the list box. 
• Select (highlight) one or more parameter codes in the list box. 
• Click the List Missing Data button. The cursor changes to an hourglass. When the cursor 

changes back to a pointer, the process has completed. Missing data within the selected data set 
will be listed in the process box. 

 
 To blank-fill data: 
 

• Select the site to validate. 
• Enter the Start Date/Time of the data set to review. 
• Enter the End Date/Time of the data set to review. 
• Click the Get ParCodes button. The program queries the database and returns all the parameter 

codes found for the selected site and period in the list box. 
• Check the blank fill box. 
• Check the All box and click Get ParCodes to retrieve a list of all parameter codes. Select the 

parameter codes to be blank-filled for the selected site and time period. 
-or- 

• Check the pattern date and enter a date that contains the parameter codes that need to be blank-
filled for the selected period. 
-or- 

• Enter an end date just beyond the period of time to be blank-filled that contains all parameter 
codes that need to be blank-filled. Click the Get Par Codes button and highlight all parameters 
listed. 

• Select a code from the Validation Code drop-down list box. 
• Click the Apply Code button. Data will be blank-filled with a value of “-999” in the raw value 

and validated value fields, the selected code in the validation code field, and a “B” in the source 
code field. NOTE: The program will not overwrite existing data. When the process is complete, 
the number of blank-filled rows will be indicated in the process box. 
 

To display the data grid: 
 

• Select the site to validate. 
• Enter the Start Date/Time of the data set to review. 
• Enter the End Date/Time of the data set to review. 
• Click the Get ParCodes button. The program queries the database and returns all the parameter 

codes found for the selected site and period in the list box. 
• Select the parameter code to display. NOTE: If more than one parameter code is selected, only 

data for the first code will be displayed. 
• Click the 24x31 button. The data will be displayed in a grid of 24 hours across by days down 

(optimally one month). For each data point, if any code other than a “V”, “VA”, “VM”, or “VZ” 
exists in the validation code field, the code will be displayed in red. Otherwise, the value found in 
the validated value field is displayed. 
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• Select the Print button to print a copy of the data grid. 
• Click the X button to close the window and return to the validation window. 

 
6.3.10.2   The Data Validation Data Window 
 
The second window available for data validation provides an interface for applying validation codes to 
specific, individually selected data points when the data analyst/technician needs to override the codes 
applied during the Auto Validation process. For example, the Auto Validate process cannot determine 
what type of calibration was performed or if the wind sensors were frozen due to weather conditions. In 
these cases the data analyst/technician will update the validation codes that were applied during this 
process. Data from all columns of the database table are displayed in tabular form as shown in Figure 6-6. 
The data window data can be sorted and/or filtered. The interface also provides a means for re-screening 
data and for hand entering data values when necessary. 
  
To open the Data Validation data window: 
 

• In the Initial Data Validation window, select the site to validate. 
• Enter the Start Date/Time of the data set to validate. 
• Enter the End Date/Time of the data set to validate. 
• Click the Get ParCodes button. The program queries the database and returns all the parameter 

codes found for the selected site and period in the list box. 
• Select (highlight) one or more parameter codes in the list box. 
• Click the data table picture button. The Data Validation data window is opened and displays the 

selected set of data in a tabular data window. 
 
To apply validation codes: 

 
• Open the Data Validation data window. 
• Highlight the data points to apply the code to. 
• Select a code from the Validation Code drop-down list box. 
• Click the Apply Code button. 

 
To sort and filter data: 

 
• Open the Data Validation data window. 
• Right-click anywhere in the data window. 
• Select Filter or Sort from the pop-up menu. A dialog box is displayed. Follow the dialog box 

instructions to apply filter or sorting options. Click the Help button to access specific help on the 
dialog boxes. 
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Figure 6-6. Example Data Validation Data Window.  

 
 
6.3.10.3  Entering Qualifier Codes  
 
Qualifier codes can be entered in the Data Validation data window. Qualifier codes are used to flag data 
where there is an issue, but data should remain valid. An example of this is when a valid precision check 
was not completed for more than 14 days; in this case, a ‘QX’ code should be applied. 
 
To apply qualifier codes: 
 

• Open the Data Validation data window 
• Select (highlight) the data points to apply the Qualifier code to. Note this is a multi-select data 

window and rows can be selected with shift-click and ctrl-click. 
• Enter the qualifier code in the Qualifier Code box.  

o A list of qualifier codes can be found at: 
https://aqs.epa.gov/aqsweb/documents/codetables/qualifiers.html 
 

https://aqs.epa.gov/aqsweb/documents/codetables/qualifiers.html
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• Click the Apply Qual Code button. 

 
 
6.3.10.4   Entering Control Values 
 
Control values can be entered in the Data Validation data window. Control values are arithmetic 
expressions that are applied to or replace raw values and result in adjusted validated values. The first 
character in the control value field must be an arithmetic operator. For example, if raw data values for 
wind speed were determined to be 10 m/s less than actual conditions (based on verification checks 
performed in the field and/or in the laboratory) enter +10 in each control value field. This action will add 
10 to the raw data values and place the result in the validated data fields. When the control value field is 
used, the final data validation code must equal “VA” which means valid, but value adjusted. 
 
Acceptable operators for control values: 
 
 Operator Result 
 +  adds the control value to the raw value 
 -  subtracts the control value from the raw value 
 *  multiplies the raw value by the control value 
 /  divides the raw value by the control value 
 =  substitutes the control value for the raw value 
 
To enter control values: 
 

• Open the Data Validation data window. 
• Select (highlight) the data points to apply the VA code to. Note this is a multi-select data window 

and rows can be selected with shift-click and ctrl-click. 
• Select the VA code from the Validation Code drop-down list box. 
• Enter the value to apply in the Control Value box. 

 
Click the Apply Code button. 
 
6.3.11 RECORD ANNOTATIONS ON WEEKLY STACKPLOTS 
 
To determine if a data value meets validation acceptance criteria, the data analyst/technician reviews the 
site documentation and weekly stackplots for the site/month being validated, then annotates the plots 
during any period where data were affected. Comments on plots are based on information from the site 
documentation, communication with field personnel and site operators, datalogger flags, and anomaly 
screening flags and reflect the codes in the AQDBMS as applied using the Auto Validation tool. A 
commented plot is shown in Figure 6-7. The following guidelines are used when commenting plots: 
 

• Comments are written within the outline of the day of the affected data and in close proximity to 
the data point affected. 

• Comments include the hours affected, the parameters affected, and the corresponding invalid code 
which provides the reason for invalidating the data. 

• Explanations of valid but unusual data are also included. 
• Data points invalidated by the Auto Validation tool are noted on the stackplot when appropriate. 
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• Site visits are identified at the top of the plot above the corresponding date with date, time, and 
duration of the visit. 

• Normal actions that occur during a site visit and do not invalidate data are also identified on the 
plot (for example, meteorological instrument checks that last less than 15 minutes). This indicates 
that a required maintenance check was completed and further establishes validity of the data. 
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6.3.12 RUN AND PRINT “STACKPLOTS FOR VALIDATION REVIEW;” REVIEW AND 

CHANGE CODES AS NEEDED 
 
Validation review stackplots (stackplots of the raw data overlaid with the validated data) are reviewed to 
verify that all anomalies and suspect data have been properly invalidated. Any suspect data points found 
that have not already been reviewed are thoroughly investigated and data are invalidated if deemed 
necessary. In the event that additional data are invalidated, the validation review plots should be re-run 
and reviewed again. This process is repeated until all suspect data have been thoroughly reviewed to 
determine their validity. 
 
6.3.13 UPDATE DATA VALIDATION LOG 
 
Once preliminary validation is complete, the data validation log is updated with the date this step was 
completed as well as the initials of the data analyst/technician that performed this step in the validation 
process. Data validation notes are added to provide documentation of the decision-making process that 
went into validating the data. 
 
6.4 THIRD LEVEL VALIDATION PROCEDURES 
 
Annotated stackplots and site documentation are reviewed to verify that all annotations on the plots are 
complete and accurate. Codes are cross-checked by the data analyst/technicians during 3rd level 
validation. The AQDBMS Data Validation Log is then updated by entering the date completed and the 
analyst’s initials into the log record for the site/month. Refer to the list of “3rd Levels Common Mistakes 
to Check For” in the Appendix of this SOP 
 
6.4.1 REVIEW SITE STATUS LOG, FIELD STATION LOGS, CALIBRATION PLOTS, AND 

PRECISION PLOTS TO VERIFY ANNOTATIONS OF PLOTS 
 
The site status log is reviewed to verify any equipment issues were addressed and properly documented in 
the data validation log. Any issues affecting data that have not already been resolved are discussed with 
the project manager, data manager, field staff, or QA manager to determine final data validity. Calibration 
plots and precision plots are reviewed to verify that all checks were within limits for the month. If any 
checks are found outside of acceptance criteria, verify either the ambient data were invalidated as needed 
or the checks were invalidated if it was determined the check(s) in question did not run correctly. 
 
Field station logs are reviewed to verify that all sites visits were properly annotated on the stackplots. 
Verify that the correct hours were annotated on the plots if there were instrument problems that led to data 
loss and check that the correct validation code was used for each situation that resulted in data loss.  
 
  

Figure 6-7. Example of a Commented Stackplot. 
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6.4.2 CHECK MINIMUM AND MAXIMUM THRESHOLDS FOR ALL PARAMETERS 
 
To verify the value for each parameter falls within minimum and maximum acceptance limits review each 
parameter, one at a time, in the data validation window. Right click to sort by the display value. This will 
sort each record for the month from lowest to highest value allowing the user to quickly check that no 
validated data points are outside of the acceptable limits for each parameter. 
 
 
6.4.3 REVIEW VALIDATED STACKPLOTS, INVESTIGATE SUSPECT DATA IF 

NECESSARY 
 
Validation review stackplots (stackplots of the raw data overlaid with the validated data) are reviewed to 
verify that all anomalies and suspect data have been properly invalidated. Any suspect data points found 
that have not been properly addressed are thoroughly investigated and corrections are made if necessary. 
 
6.4.4 VERIFY PRELIMINARY VALIDATION CODES IN DATABASE 
 
All validation codes as annotated on the stackplots should be checked to verify they were entered 
correctly in the database. This is done by reviewing the monthly data grid.  
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 6-8.   Monthly Data Grid 

 
The monthly data grid is accessed by selecting the site, month, and a parameter in the data validation 
window and then by clicking on the “24x31” button. All records that were coded valid will display with 
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the validated value for that hour and each record coded as invalid will display in red with the invalidation 
code that was used. 
 
The following items should be checked when verifying the validation codes on the monthly data grid: 

• Check for missing records (if a record is missing the last hour in the grid will be missing) and 
blank-fill if necessary. 

• Verify that the correct validation code was applied. 
• Verify that validation codes were applied to the correct hours as annotated on the stackplots. 
• Verify that codes used for nightly calibration events are consistent with the previous month. The 

same codes should be used each month unless the program/event timing was changed. 
• Verify that validation codes applied to issues that carried over from the previous month are 

consistent. 
• Verify that parameters that should be validated versus coded as ‘NA’ are consistent with the 

previous month. 
 
6.4.5 UPDATE DATA VALIDATION LOG 
 
Once 3rd level validation is complete, the data validation log is updated with the date this step was 
completed as well as the initials of the data analyst/technician that performed this step in the validation 
process. If any corrections were made to the data, the data validation notes are updated accordingly. 
 
6.5 FINAL VALIDATION PROCEDURES 
 
Data for a site/month must be at Preliminary validation before beginning Final validation.  
 
6.5.1 REVIEW OF VALIDATED DATA 
 
During the Final validation process, a review of all validated data is completed by the IMC Manager. This 
is accomplished by reviewing stackplots of the raw data overlaid with the validated data. These plots 
allow the IMC Manager to see the validated dataset as well as which data points were determined to be 
invalid. Plots are reviewed to verify that validation is complete and accurate. Any discrepancies found are 
thoroughly investigated and corrections are made if necessary. 
 
6.5.2 PLOT REVIEW 
 
After all levels of validation are complete, and before data are considered final, a joint review of the 
validated data is held among IMC staff, field staff, and project participants such as the project manager or 
the client. An interactive Web interface or hard copy plots of data are used to review the data. In some 
cases, historical summaries and deviations from normal are reviewed to determine if all data fall within 
normal limits for the month in review. Other materials that are reviewed may include contour maps of the 
country, smoke plume maps, pollution maps, or multi-site plots that allow for a comparison of pollutants 
within a similar region. Any questionable periods of data discovered during the group plot review are 
thoroughly investigated and changes to data are made if warranted. 
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6.5.3 MAKING VALIDATION CODE CORRECTIONS AND COMPLETING FINAL 
 VALIDATION 
  
After the monthly plot review and after review of the validated stackplots and after problems have been 
resolved, necessary validation code changes are made in the database. To make validation code changes, 
the Data Validation data window is used, which displays a tabular data window of selected data. It 
provides a way to hand-enter and apply validation codes to selected data points within a window.  
 
6.5.3.1 Completing Final Validation 
 
After making validation code changes, the following steps are taken to complete Final validation: 
 

• The changed data are regenerated into a new stackplot data file to replace the old. 
• The validated stackplots are again reviewed; changes are made if necessary and are entered into 

the database. 
• Reports are generated and distributed according to project-specific requirements (see SOP 

I_IMC_RPTS_2017Dec_F_1.0, Information Management Center -Data Reporting and 
Dissemination. 

• The Data Validation Log entry for the site/month is updated with the Final validation date and 
initials of the IMC Manager. 
 

After completing these steps, Final validation is complete and data are ready to be uploaded to AQS, 
included in data requests, and provided in monthly, quarterly, or annual data summary reports. 
 
6.5.4 POST-FINAL VALIDATION PROCEDURES 
 
If a validation error is found after the data are labeled as final, the following steps are taken: 
 

• The necessary changes are made in the AQDBMS database. 
• Changes made are logged within the database and reports are generated that list the corrections that 

were made. 
• If the affected data have been submitted to the Environmental Protection Agency’s (EPA) Air 

Quality System (AQS) database, they must be resubmitted. 
• If the affected data have been submitted to other data depositories (e.g., CASTNET or other project-

specific databases or Web sites), they must be resubmitted. 
 

6.5.5 ANNUAL DATA REVIEW 
 

Although preliminary and final validation occurs on a monthly basis, ARS believes an annual review of all 
data is critical to produce a quality final data set. This review includes a visual inspection of the data on 
annual time series plots, which can help identify areas where values may have shifted or drifted throughout 
the year. These shifts are not as obvious when reviewing data on a smaller time scale.  
 
Another component of the annual data review involves comparing the year’s concentrations to historical 
values from that station. Statistical computations such as the rolling mean and standard deviations from the 
mean are reviewed graphically. Values outside of historical ranges or visually anomalous are identified and 
are subjected to additional review in order to determine the cause of the deviation. All calibrations and on-site 
maintenance are reviewed in detail as well as synoptic meteorological conditions and data from nearby sites 
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in order to determine if the deviation is real or due to atmospheric conditions for that year. If data are found to 
be unreasonable based on comparisons with these records, data will be invalidated and the validation codes in 
the AQDBMS updated to reflect this change. All changes to data are logged in a table within the AQDBMS 
and corrected values are uploaded to the AQS. 
 
Figure 6-9 shows a rolling 28-day average of all hourly data and time stamps the average as time beginning. 
The dark gray lines represent the overall mean across all years (middle dark gray line) and ± 2 standard 
deviations (top and bottom dark gray lines). The light gray lines represent each year, with the red line 
highlighting the year in review. This product can be generated for any parameter from any station with 
multiple years highlighted or any single year highlighted in color. 
 
Following the Annual Data Review, all data for the year are locked within the AQDBMS in order to ensure 
that changes to final validated data cannot be made inadvertently. Only the Database Administrator and IMC 
Manager have the ability to change validation codes once data have been locked. In addition, these changes 
can only be made intentionally as the Database Administrator or IMC Manager must first unlock the data in 
order to make updates. This process ensures that the integrity of all final validation codes is maintained 
indefinitely. 
 

 
Figure 6-9. Example Historical Data Comparison Stackplot. 
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7.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2012, Air Quality Data Base Management System (AQDBMS) 
User’s Guide. 
 
8.0 DEFINITIONS AND ACRONYMS 
 
 

AQDB  Air Quality Database 
AQDBMS Air Quality Database Management System 
AQS  Air Quality System 
ARS  Air Resource Specialists 
 
EPA  Environmental Protection Agency 
IMC  Information Management Center 
 
QA  Quality Assurance  
QAPP  Quality Assurance Project Plan 
QC  Quality Control 
 
RH  Relative Humidity 
SOP  Standard Operating Procedure 
SSRF  Site Status Report Form 
TCP/IP  Transmission Control Protocol/Internet Protocol 
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APPENDIX 
 
 

Validation Acceptance Criteria for the Gaseous and Meteorological Parameters 

Analyst’s Actions Based on Datalogger and Anomaly Screening Flags 

Validation Codes 

EPA Validation Acceptance Criteria (from EPA QA Handbook Vol. II, Appendix D. Rev. 1) 

3rd Levels – Common Mistakes to Check For 

Calibration Shapes 

Items to Check for Evidence of Moisture in a BAM 

Minute Trace Drop 

Noise Example 

Notes on NO, NOx, NO2 Data Validation 

Revised Min/Max Adjustments 

Temperature Limits – Gas 

Validation Acceptance Criteria by Project 

Validation Rules by Parameter (Update flow) 

Zero-Adjust Thresholds 

Procedures for Zero Corrections of Data from non-Trace Analyzers 

Procedures for Zero Corrections of Data from Trace Analyzers 

Memorandum on Revision to the Zero Drift Acceptance Criteria in the QA Handbook 
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 Validation Acceptance Criteria for the Gaseous and Meteorological Parameters  
 

 

Parameter Calibration Method Criteria Validation Criteria 
(Data Reasonableness) 

Temperature 
(Climatronics or RM Young) 

Three water baths and certified 
thermometer 
(0ºC, 20 to 30ºC, 30 to 50ºC) 
 

Max error ≤ ±0.5°C from actual 

Temperature (Rotronics/Vaisala) 
 

Temperature transfer standard Max error ≤ ±1.5°C 

Temperature and 
Temperature Difference 
(Climatronics or RM Young) 
 

Three water baths 
(0ºC, 20 to 30ºC, 30 to 50ºC) 
 

Max error ≤ ±0.5°C 

Shelter Temperature 
 

Temperature transfer standard Max error ±2°C 

Relative Humidity RH sensor transfer standard 
 

Max error ≤ ±10.0% 

Wind Speed Selectable speed rpm motor Max error ≤ ±0.5 m/s for values <5.0 m/s 
≤ ±5.0% for values >5.0 m/s 
 

Wind Speed Starting Threshold Weighted torque disk Max error ≤ 0.4 g-cm (Climatronics) 
≤ 0.5 g-cm (RM Young) 
 

Wind Direction Alignment Solar Azimuth, Precision 
compass, USGS map 
 

Max error ≤ ±5° from true degrees 

Wind Direction Linearity 
 

45º increment inputs Max error ≤ ±5° 

Wind Direction Starting 
Threshold 
 

Weighted torque disk Max error ≤ 8 g-cm (Climatronics) 
≤ 11 (RM Young) 

Precipitation (Tipping Bucket) Addition of known water volume 
 

Max error ≤ ±10.0% 

Precipitation (Weighting Gauge) 
 

Addition of certified weights, 
 or known water volume 
 

Max error ≤ ±10% or ≤ ±0.10 inches 

Wetness Sensor Mist with distilled water; and 
apply test resistance (230-240 
Ohms) 

Response Confirmed sensor response as 
necessary to correct readings to full 
scale of 100 (equivalent to 1.0VDC) 
 

Solar Radiation Collocated transfer standard 
 

Average error 
 

≤ ±10% 

Barometric Pressure 
 

Collocated transfer standard Max error ≤ ±3.0 mmHg or ±4.0 mb 

Gas Max difference Gas primary or transfer standard 
(0 and 5 upscale points) 
 

Max error ≤ ±10.0% of actual 

Gas Average difference Gas primary or transfer standard 
(0 and 5 upscale points) 
 

Average error ≤ ±10.0% 

Gas Slope (m) Gas primary or transfer standard 
(0 and 5 upscale points) 
 

Actual 0.900 ≤ slope ≤ 1.100 

Gas Intercept (b) Gas primary or transfer standard 
(0 and 5 upscale points) 
 

Actual ≤ ±5.0 ppb from actual for O3 and SO2 
≤ ±5.0 ppm for CO 

Gas Correlation (r) Gas primary or transfer standard 
(0 and 5 upscale points) 
 

Actual >0.9900 

Data Acquisition System Time 
 

Compare with NIST time Max error ≤ ±2 minutes 

Data Acquisition System Voltage 
 

Known voltage inputs Max error ≤ ±0.003 VDC 

Meteorological Translator Cards Compare with calibrated 
voltmeter 

Max error ≤ ±0.005 VDC of designated zero 
value; and ≤ ±0.1% of span 
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Analyst’s Actions Based on Datalogger and Anomaly Screening Flags 
 

Flag Type Description Action 

- Datalogger Low alarm Investigate 

# Datalogger Insufficient data Investigate 

* Datalogger Out of calibration Investigate 

/ Datalogger Rate-of-change alarm  Investigate 

\ Datalogger Rate-of-change alarm Investigate 

^ Datalogger High alarm Investigate 

_ Datalogger Low alarm Investigate 

< Datalogger Missing data Invalidate with PF or RF 

B Datalogger Bad status Investigate 

C Datalogger Calibration Invalidate with ZS, PC, CA, SC, PA,   or MT 

D Datalogger Channel disabled/off-line Investigate; can be valid or invalid 

P Datalogger Power failure Investigate; may be erroneous or true 
power failure 

Z Datalogger Zero/span Investigate 

IM Screening  Set in VWS, VWD, and SDWD when SWS           
< min. expected (NV) 

Invalidate keeping IM 

NR Screening  Rate-of-change less than minimum value in the 
Screening Ranges Table 

Investigate 

NV Screening  Less than minimum value in the Screening  
Ranges Table 

Investigate 

TH Screening  Ozone data suspect  when station temp is  
≥30.5ºC 

Investigate 

TL Screening Ozone data suspect when station temp is  
<19.5ºC 

Investigate 

VM Screening Valid but the validated value has been adjusted 
for the max value by the screening program 
based on the max adj, max adj to, and max val 
fields of the Screening Ranges Table 

None 

VZ Screening Valid but the validated value has been adjusted 
for zero by the screening program based on the 
zero adjustment value in the Screening Ranges 
Table 

None 

WS Screening  Vector wind speed greater than Scalar wind 
speed – generated by the screening program 

Invalidate VWS, VWD, SDWD with IM 

XR Screening 
program 

Rate-of-change greater than the maximum value 
in the Screening Ranges Table 

Investigate 

XV Screening 
program 

Greater than the maximum value in the Screening 
Ranges Table 

Investigate 
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Validation Codes 
 

 Code Description 

AP Vandalism 

BL Value below limit 

BM Begin monitoring. For a new site or instrument, place in only one hour before valid data. 

CA Multipoint calibration of an AQ instrument, > 15 min/hour. 

CR Construction/repairs 

EM End monitoring. When a site or instrument is discontinued, place in only one hour after valid data. 

IM Instrument malfunction. Problem was not discovered until after data had been collected, instrument failure or other 
problem was not identified until the data validation occurred, may or may not be related to a problem listed on the status 
board. 

IN Acts of nature. 

IW Instrument warm-up. After the instrument was off or a power failure long enough to cause the instrument to go through a 
warm-up cycle. Some indicators:  dpt > temp, noisy signal or drift shown on chart. Usually only used for 1 – 2 hours. 

LI Local interference. Human interference directly or indirectly that was local and not under the control of the operator. 
Examples: dust, particulates, construction. 

MT Maintenance. Someone on-site actively attempting repairs or doing preventive maintenance (changing chart paper, 
replacing instrument parts). Can be the site operator or repair person or remote activation or programming of the 
datalogger. 

NA Monitoring out for the month, before or after an analyzer is placed at a site, no intent of collecting data, unable to 
calculate value. 

OE Mistake by operator or anybody else at the station that leads to a loss in data. Example.: switches left in incorrect 
positions after repairs or calibrations, lines not returned to the manifold after an audit, open manifold ports, etc. 

OR Instrument in process of being repaired, often off-site. Incapable of getting good values, more than 1-hour of data, 
problem identified on site & status log or log book record would normally be present. MT must follow. Often a cal must 
follow. 

OS Signal is off the top of the chart, data are presumed good. 

PA Calibration on-site by an external agency person. May be several hours. (Gaseous parameters only.) 

PC Precision Check. Normally once per week. 

PF Power failure >15 minutes/hour, instrument warm-up and data loss at the top of the hour may also be an issue (RF). 

PQ Poor QA results 

RF Datalogger system fails and chart record is unavailable. 

SA External agency person on-site which leads to data loss (Met parameters only.) 

SC Use when both a precision check and a zero/span check are done within the same hour.  

TH Data invalid for ozone when station temp is ≥30.5ºC. 

TL Data invalid for ozone when station temperature < 19.5ºC. 

TO When time is off by more than 5 minutes. 

V Valid Value. 

VA Valid value, but the validated value has been adjusted from the raw value by the data analyst/technician. The control 
value field must contain the offset. 

VM Valid but the validated value has been adjusted for the max value by the analyst based on the parameter criteria. 

VZ Valid but the validated value has been adjusted for zero. 

WD  Wildlife damage 

ZS Invalid data for the hour if zero/span takes longer than 15 minutes or the hour. 



 

 

EPA Validation Acceptance Criteria 
(from EPA QA Handbook Vol. II, Appendix D. Rev. 1) 

 
Ozone Validation Template 

 

1) Requirement (O3) 2) Frequency 3) Acceptance Criteria Information /Action 
CRITICAL CRITERIA-OZONE 

 
Monitor 

 
NA Meets requirements listed in FRM/FEM 

designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

 
One Point QC 
Check Single 
analyzer 

 
Every 14 days 

 
< +7.1% (percent difference) or < +1.5 ppb 

difference whichever is greater 

1 and 2) 40 CFR Part 58 App A Sec. 3.1 
3) Recommendation based on DQO in 40 CFR Part 58 
App A Sec. 2.3.1.2. QC Check Conc range 0.005 - 0.08 
ppm and 05/05/2016 Technical Note on AMTIC 

Zero/span check  
Every 14 days 

Zero drift < + 3.1 ppb (24 hr) 
< + 5.1 ppb (>24hr-14 day) 

Span drift < + 7.1 % 

1 and 2) QA Handbook Volume 2 Sec. 12.3 
3) Recommendation and related to DQO 

OPERATIONAL CRITERIA -OZONE 
 
 
 

Shelter Temperature Range 

 
 

Daily (hourly 

values) 

 

20.0 to 30.0o C. (Hourly avg) 
or 

per manufacturers specifications if designated 
to a wider temperature range 

1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 
 

Generally, the 20-30.0o C range will apply but the most 
restrictive operable range of the instruments in the shelter 
may also be used as guidance. FRM/FEM list found on 
AMTIC provides temp. range for given instrument. 
FRM/FEM monitor testing is required at 20-30o C range 
per 40 CFR Part 53.32 

Shelter Temperature Control Daily (hourly values) < 2.1o C SD over 24 hours 1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 
Shelter Temperature Device 
Check 

Every 182 days and 2/ calendar year <+ 2.1o C of standard 1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 

 
Annual Performance 
Evaluation Single 
analyzer 

Every site every 365 days and 1/ calendar 
year within period of monitor operation, 

Percent difference of audit levels 3-10 
< +15.1% 

Audit levels 1&2 < + 1.5 ppb difference or 
<+ 15.1% 

1 and 2) 40 CFR Part 58 App A Sec. 3.1.2 
3) Recommendation- 3 audit concentrations not including 
zero. AMTIC guidance 2/17/2011 
AMTIC Technical Memo 

Federal Audits (NPAP) 20% of sites audited in calendar year Audit levels 1&2 < + 1.5 ppb difference all 
other levels percent difference < + 10.1% 

1 and 2) 40 CFR Part 58 App A Sec. 3.1.3 
3) NPAP QAPP/SOP 

 
 
 

Verification/Calibration 

Upon receipt/adjustment/repair/ 
installation/moving and repair and 
recalibration of standard of higher 

level 
Every 182 day and 2/ calendar year if 
manual zero/span performed biweekly 
Every 365 day and 1/ calendar year if 
continuous zero/span performed daily 

 
 

All points < + 2.1 % or < +1.5 ppb difference 
of best-fit straight line whichever is greater 

and Slope 1 + .05 

 
1) 40 CFR Part 50 App D 
2) Recommendation 
3) 40 CFR Part 50 App D Sec 4.5.5.6 

Multi-point calibration (0 and 4 upscale points) 

Slope criteria is a recommendation 

Zero Air/Zero Air Check Every 365 days and 1/calendar year Concentrations below LDL 1) 40 CFR Part 50 App D Sec. 4.1 
2 and 3) Recommendation 

Ozone Level 2 Standard    



 

 

 
 

1) Requirement (O3) 2) Frequency 3) Acceptance Criteria Information /Action 
 

Certification/recertification to 
Standard Reference 
Photometer (Level 1) 

 

Every 365 days and 1/calendar year 

 
single point difference < + 3.1% 

1) 40 CFR Part 50 App D Sec. 5.4 
2 and 3) Transfer Standard Guidance EPA-454/B-10-001 

 
Level 2 standard (formerly called primary standard) 
usually transported to EPA Regions SRP for comparison 

Level 2 and Greater Transfer 
Standard Precision 

 
Every 365 days and 1/calendar year Standard Deviation less than 0.005 ppm or 

3.0% whichever is greater 

1) 40 CFR Part 50 Appendix D Sec. 3.1 
2) Recommendation, part of reverification 
3) 40 CFR Part 50 Appendix D Sec. 3.1 

(if recertified via a transfer 
standard) Every 365 days and 1/calendar year 

Regression slopes = 1.00 + 0.03 and two 
intercepts are 0 + 3 ppb 

1, 2 and 3) Transfer Standard Guidance EPA-545/B-10- 
001 

Ozone Transfer standard 
(Level 3 and greater) 

   

Qualification Upon receipt of transfer standard < +4.1% or < +4 ppb (whichever greater) 1, 2 and 3) Transfer Standard Guidance EPA-545/B-10- 
001 

Certification After qualification and upon 
receipt/adjustment/repair 

RSD of six slopes < 3.7% 
Std. Dev. of 6 intercepts < 1.5 

1, 2 and 3) Transfer Standard Guidance EPA-545/B-10- 
001 1 

Recertification to higher level 
standard 

Beginning and end of O3 season or 
every 182 days and 2/calendar year 

whichever less 

New slope = + 0.05 of previous and 
RSD of six slopes <3.7% 

Std. Dev. of 6 intercepts < 1.5 

1, 2 and 3) Transfer Standard Guidance EPA-545/B-10- 
001 recertification test that then gets added to most recent 
5 tests. If does not meet acceptability certification fails 

Detection (FEM/FRMs) Noise and Lower Detectable Limits (LDL) are part of the FEM/FRM requirements. It is recommended that monitoring organizations perform the LDL test to 
minimally confirm and establish the LDL of their monitor. Performing the LDL test will provide the noise information. 

 
Noise 

 
Every 365 days and 1/ calendar year < 0.0025 ppm (standard range) 

< 0.001 ppm (lower range) 

1) 40 CFR Part 53.23 (b) (definition & procedure) 
2) Recommendation- info can be obtained from LDL 
3) 40 CFR Part 53.20 Table B-1 

 
Lower detectable limit 

 
Every 365 days and 1/calendar year < 0.005 ppm (standard range) 

< 0.002 ppm (lower range) 

1) 40 CFR Part 53.23 (b) (definition & procedure) 
2) Recommendation 
3) 40 CFR Part 53.20 Table B-1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
CO Validation Template  

 
1) Requirement (CO) 2) Frequency 3) Acceptance Criteria Information /Action 

CRITICAL CRITERIA-CO 
 

Sampler/Monitor 
 

NA 

 
Meets requirements listed in FRM/FEM 

designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

One Point QC Check 
Single analyzer 

 
Every 14 days 

 
< +10.1% (percent difference) 

1 and 2) 40 CFR Part 58 App A Sec. 3.1.1 
3) Recommendation based on DQO in 40 CFR Part 58 
App A Sec. 2.3.1. QC Check Conc range 0.5 – 5 ppm 

 
Zero/span check 

 
Every 14 days 

Zero drift < + 0.41 ppm (24 hr) 
< + 0.61 ppm (>24hr-14 day) 

Span drift < + 10.1 % 

1 and 2) QA Handbook Volume 2 Sec. 12.3 
3) Recommendation 

OPERATIONAL CRITERIA-CO 
 
 
 

Shelter Temperature range 

 
 

Daily 
(hourly values) 

 

20.0 to 30.0o C. (Hourly avg) 
or 

per manufacturers specifications if designated to a 
wider temperature range 

1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 
 

Generally, the 20-30.0 o C range will apply but the most 
restrictive operable range of the instruments in the 
shelter may also be used as guidance. FRM/FEM list 
found on AMTIC provides temp. range for given 
instrument. FRM/FEM monitor testing is required at 
20-30 o C range per 40 CFR Part 53.32 

Shelter Temperature Control Daily (hourly values) < 2.1o C SD over 24 hours 1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 

Shelter Temperature Device 
Check Every 182 days and 2/ calendar year < + 2.1o C of standard 1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 

 
Annual Performance 
Evaluation Single Analyzer 

 
Every site every 365 days and 1/ 

calendar year 
Percent difference of audit levels 3-10 < +15.1% 

Audit levels 1&2 < + 0.031 ppm difference or 
< +15.1% 

1 and 2) 40 CFR Part 58 App A Sec. 3.1.2 
3) Recommendation- 3 audit concentrations not 
including zero. AMTIC Technical Memo 

Federal Audits (NPAP) 20% of sites audited in a calendar 
year 

Audit levels 1&2 < + 0.031 ppm difference all 
other levels percent difference < + 15.1% 

1 and 2) 40 CFR Part 58 App A Sec. 3.1.3 
3) NPAP QAPP/SOP 

 
 
 

Verification/Calibration 

Upon receipt/adjustment/repair/ 
installation/moving 

Every 182 day and 2/ calendar year if 
manual zero/span performed 

biweekly 
Every 365 days and 1/ calendar year 
if continuous zero/span performed 

daily 

 
 

All points < + 2.1 % or < + 0.03 ppm difference 
of best-fit straight line. whichever is greater  

and Slope 1 + .05 

1) 40 CFR Part 50 Appendix C Sec. 4 
2 and 3) Recommendation 

 
See details about CO2 sensitive instruments Multi-point 
calibration (0 and 4 upscale points) 

 
Slope criteria is a recommendation 

    

 
 



 

 

 
 
 

1) Requirement (CO) 2) Frequency 3) Acceptance Criteria Information /Action 
 
 

Gaseous Standards 

 
 

All gas cylinders 

 
 

NIST Traceable 
(e.g., EPA Protocol Gas) 

1) 40 CFR Part 50 Appendix C Sec. 4.3.1 
2) NA Green Book 
3) 40 CFR Part 50 Appendix C Sec. 4.3.1 See details 
about CO2 sensitive instruments 
Gas producer used must participate in EPA Ambient Air 
Protocol Gas Verification Program 
40 CFR Part 58 App A Sec. 2.6.1 

 
Zero Air/Zero Air Check 

 
Every 365 days and 1/ calendar year 

 
< 0.1 ppm CO 

1) 40 CFR Part 50 App C Sec. 4.3.2 
2) Recommendation 
3) 40 CFR Part 50 App C Sec. 4.3.2 

 
Gas Dilution Systems 

Every 365 days and 1/ calendar year 
or after failure of 1 point QC check or 

performance evaluation 

 
Accuracy < + 2.1 % 

1, 2 and 3) Recommendation based on SO2 
requirement in 40 CFR Part 50 App A-1 Sec. 4.1.2 

Detection (FEM/FRMs) Noise and Lower Detectable Limits (LDL) are part of the FEM/FRM requirements. It is recommended that monitoring organizations perform the LDL test to 
minimally confirm and establish the LDL of their monitor. Performing the LDL test will provide the noise information. 

 
Noise 

 
Every 365 days and 1/ calendar year < 0.2 ppm (standard range) 

< 0.1 ppm (lower range) 

1) 40 CFR Part 53.23 (b) (definition & procedure) 
2) Recommendation- info can be obtained from LDL 
3) 40 CFR Part 53.20 Table B-1 

 
Lower detectable level 

 
Every 365 days and 1/ calendar year < 0.4 ppm (standard range) 

< 0.2 ppm (lower range) 

1) 40 CFR Part 53.23 (c) (definition & procedure) 
2) Recommendation 
3) 40 CFR Part 53.20 Table B-1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
NO2, NOx, NO Validation Template 

 
1) Requirement (NO2) 2) Frequency 3) Acceptance Criteria Information /Action 

CRITICAL CRITERIA- NO2 
    

 
Sampler/Monitor 

 
NA Meets requirements listed in FRM/FEM 

designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

 
One Point QC Check 
Single analyzer 

 
 

Every 14 days 

 
< +15.1% (percent difference) or < + 1.5 ppb 

difference whichever is greater 

1 and 2) 40 CFR Part 58 App A Sec. 3.1.1 
3) Recommendation based on DQO in 40 CFR Part 58 
App A Sec. 2.3.1.5 QC Check Conc range 0.005 - 0.08 
ppm and 05/05/2016 Technical Note on AMTIC 

Zero/span check  
Every 14 days 

Zero drift < + 3.1 ppb (24 hr) 
< + 5.1 ppb (>24hr-14 day) 

Span drift < + 10.1 % 

1 and 2) QA Handbook Volume 2 Sec. 12.3 
3) Recommendation and related to DQO 

 
 

Converter Efficiency 

 
During multi-point calibrations, span and 

audit 
Every 14 days 

 
(>96%) 

96% – 104.1% 

1) 40 CFR Part 50 App F Sec. 1.5.10 and 2.4.10 
2) Recommendation 
3) 40 CFR Part 50 App F Sec. 1.5.10 and 2.4.10 
Regulation states > 96%, 96 – 104.1% is a 
recommendation. 

OPERATIONAL CRITERIA- NO2 
 
 
 

Shelter Temperature Range 

 
 

Daily 
(hourly values) 

 

20.0 to 30.0o C. (Hourly avg) 
or 

per manufacturers specifications if designated 
to a wider temperature range 

1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 
 

Generally, the 20-30.0 o C range will apply but the 
most restrictive operable range of the instruments in 
the shelter may also be used as guidance. FRM/FEM 
list found on AMTIC provides temp. range for given 
instrument. FRM/FEM monitor testing is required at 
20-30 o C range per 40 CFR Part 53.32 

Shelter Temperature Control Daily (hourly values) < 2.1o C SD over 24 hours 1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 

Shelter Temperature Device 
Check every 182 days and 2/calendar year < + 2.1o C of standard 1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 

 
Annual Performance 
Evaluation Single Analyzer 

 
Every site every 365 days and 1/ 

calendar year 

Percent difference of audit levels 3-10 
< +15.1% 

Audit levels 1&2 < + 1.5 ppb difference or 
< +15.1% 

1) 40 CFR Part 58 App A Sec. 3.1.2 
2) 40 CFR Part 58 App A Sec. 3.1.2 
3) Recommendation - 3 audit concentrations not 
including zero. AMTIC Technical Memo 

 
Federal Audits (NPAP) 

 
20% of sites audited in calendar year 

Audit levels 1&2 < + 1.5 ppb difference all 
other levels percent difference < + 15.1% 1 & 2) 40 CFR Part 58 App A Sec. 3.1.3 

3) NPAP QAPP/SOP 

 
 
 
 



 

 

 
 
 
 

1) Requirement (NO2) 2) Frequency 3) Acceptance Criteria Information /Action 
 
 

Verification/Calibration 

Upon receipt/adjustment/repair/ 
installation/moving 

Every 182 day and 2/ calendar year if 
manual zero/span performed biweekly 
Every 365 day and 1/ calendar year if 
continuous zero/span performed daily 

Instrument residence time < 2 min 
Dynamic parameter > 2.75 ppm-min 

All points <+ 2.1 % or < + 1.5 ppb difference 
of best-fit straight line whichever is greater 

and Slope 1 + .05 

1) 40 CFR Part 50 App F 
2 and 3) Recommendation 

Multi-point calibration (0 and 4 upscale points) 

Slope criteria is a recommendation 
 
 
 

Gaseous Standards 

 
 
 

All gas cylinders 

 
 

NIST Traceable 
(e.g., EPA Protocol Gas) 

50-100 ppm of NO in Nitrogen with < 1 ppm 
NO2 

1) 40 CFR Part 50 App F Sec. 1.3.1 
2) NA Green Book 
3) 40 CFR Part 50 App F Sec. 1.3.1. A technical 
memo may change the concentration requirment. 

 
Gas producer used must participate in EPAAmbient 
Air Protocol Gas Verification Program 40 CFR Part 
58 App A Sec. 2.6.1 

Zero Air/ Zero Air Check Every 365 days and 1/ calendar year Concentrations below LDL 1) 40 CFR Part 50 App F Sec. 1.3.2 
2 and 3) Recommendation 

 
Gas Dilution Systems 

Every 365 days and 1/ calendar year or 
after failure of 1 point QC check or 

performance evaluation 

 
Accuracy < + 2.1 % 

1, 2 and 3) Recommendation based on SO2 
requirement in 40 CFR Part 50 App A-1 Sec. 4.1.2 

Detection (FEM/FRMs) Noise and Lower Detectable Limits (LDL) are part of the FEM/FRM requirements. It is recommended that monitoring organizations perform the LDL test to 
minimally confirm and establish the LDL of their monitor. Performing the LDL test will provide the noise information. 

 
Noise 

 
Every 365 days and 1/ calendar year 

 
< 0.005 ppm 

1) 40 CFR Part 53.23 (b) (definition & procedure) 
2) Recommendation- info can be obtained from LDL 
3) 40 CFR Part 53.20 Table B-1 

 
Lower detectable level 

 
Every 365 days and 1/ calendar year 

 
< 0.01 ppm 

1) 40 CFR Part 53.23 (c) (definition & procedure) 
2) Recommendation 
3) 40 CFR Part 53.20 Table B-1 

 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
SO2 Validation Template 

 
1) Requirement (SO2) 2) Frequency 3) Acceptance Criteria Information /Action 

CRITICAL CRITERIA- SO2 
Sampler/Monitor NA Meets requirements listed in FRM/FEM 

designation 
1) 40 CFR Part 58 App C Sec. 2.1 2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

 
One Point QC Check 
Single analyzer 

 
 

Every 14 days 

 
< +10.1% (percent difference) or < + 1.5 ppb 

difference whichever is greater 

1 and 2) 40 CFR Part 58 App A Sec. 3.1.1 
3) Recommendation based on DQO in 40 CFR Part 58 
App A Sec. 2.3.1.2 QC Check Conc range 0.005 - 0.08 
ppm and 05/05/2016 Technical Note on AMTIC 

Zero/span check  
Every 14 days 

Zero drift < + 3.1 ppb (24 hr) 
< + 5.1 ppb (>24hr-14 day) 

Span drift < + 10.1 % 

1 and 2) QA Handbook Volume 2 Sec. 12.3 
3) Recommendation and related to DQO 

OPERATIONAL CRITERIA- SO2 
 
 
 
Shelter Temperature Range 

 
 

Daily 
(hourly values) 

 

20.0 to 30.0o C. (Hourly avg) 
or 

per manufacturers specifications if designated to 
a wider temperature range 

1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 
 
Generally, the 20-30.0 o C range will apply but the most 
restrictive operable range of the instruments in the 
shelter may also be used as guidance. FRM/FEM list 
found on AMTIC provides temp. range for given 
instrument. FRM/FEM monitor testing is required at 20- 
30 o C range per 40 CFR Part 53.32 

Shelter Temperature Control Daily (hourly values) < 2.1o C SD over 24 hours 1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 

Shelter Temperature Device 
Check every 180 days and 2/calendar year < + 2.1o C of standard 1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 

 
Annual Performance 

Evaluation Single Analyzer 

 
Every site every 365 days and 1/ 

calendar year 

Percent difference of audit levels 3-10 
< +15.1% 

Audit levels 1&2 < + 1.5 ppb difference or 
< +15.1% 

1 and 2) 40 CFR Part 58 App A Sec. 3.1.2 
3) Recommendation - 3 audit concentrations not 
including zero. AMTIC Technical Memo 

 
Federal Audits (NPAP) 

 
20% of sites audited in calendar year 

Audit levels 1&2 < + 1.5 ppb difference all 
other levels percent difference < + 15.1% 

1&2) 40 CFR Part 58 App A Sec. 3.1.3 
3) NPAP QAPP/SOP 

 
 
Verification/Calibration 

Upon receipt/adjustment/repair/ 
installation/moving 

Every 182 day and 2/ calendar year if 
manual zero/span performed biweekly 
Every 365 day and 1/ calendar year if 
continuous zero/span performed daily 

 
All points < + 2.1 % or < + 1.5 ppb difference 

of best-fit straight line whichever is greater 
and Slope 1 + .05 

1) 40 CFR Part 50 App A-1 Sec. 4 
2 and 3) Recommendation 

Multi-point calibration (0 and 4 upscale points) 

Slope criteria is a recommendation 

 
Gaseous Standards 

 
All gas cylinders 

 
NIST Traceable 

(e.g., EPA Protocol Gas) 

1) 40 CFR Part 50 App A-1 Sec. 4.1.6.1 
2) NA Green Book 
3) 40 CFR Part 50 App F Sec. 1.3.1 
Producers must participate in Ambient Air Protocol Gas 

 
 



 

 

 
 

1) Requirement (SO2) 2) Frequency 3) Acceptance Criteria Information /Action 
   Verification Program 40 CFR Part 58 App A Sec. 2.6.1 

 
Zero Air/ Zero Air Check 

 
Every 365 days and 1/ calendar year 

 
Concentrations below LDL 

< 0.1 ppm aromatic hydrocarbons 

1) 40 CFR Part 50 App A-1 Sec. 4.1.6.2 
2) Recommendation 
3) Recommendation and 40 CFR Part 50 App A-1 Sec. 
4.1.6.2 

 
Gas Dilution Systems 

Every 365 days and 1/ calendar year or 
after failure of 1point QC check or 

performance evaluation 

 
Accuracy < + 2.1 % 

1) 40 CFR Part 50 App A-1Sec. 4.1.2 
2) Recommendation 
3) 40 CFR Part 50 App A-1 Sec. 4.1.2 

Detection (FEM/FRMs) Noise and Lower Detectable Limits (LDL) are part of the FEM/FRM requirements. It is recommended that monitoring organizations perform the LDL test to 
minimally confirm and establish the LDL of their monitor. Performing the LDL test will provide the noise information. 

 
Noise 

 
Every 365 days and 1/ calendar year < 0.001 ppm (standard range) 

< 0.0005 ppm (lower range) 

1) 40 CFR Part 53.23 (b) (definition & procedure) 
2) Recommendation- info can be obtained from LDL 
3) 40 CFR Part 53.20 Table B-1 

 
Lower detectable level 

 
Every 365 days and 1/ calendar year < 0.002 ppm (standard range) 

< 0.001 ppm (lower range) 

1) 40 CFR Part 53.23 (c) (definition & procedure) 
2) Recommendation 
3) 40 CFR Part 53.20 Table B-1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

PM2.5 Filter Based Local Conditions Validation Template 
 

 
1) Criteria (PM2.5 LC) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

CRITICAL CRITERIA- PM2.5 Filter Based Local Conditions 
Field Activities 

 
Sampler/Monitor 

 
NA Meets requirements listed in FRM/FEM/ARM 

designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

Filter Holding Times    

Pre-sampling all filters < 30 days before sampling 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.3.5 

Sample Recovery all filters < 7 days 9 hours from sample end date 1, 2 and 3) 40 CFR Part 50, App. L 10.10 

 
Sampling Period (including 
multiple power failures) 

 
 

all filters 

 
1380-1500 minutes, or 

if value < 1380 and exceedance of NAAQS 1/ 
midnight to midnight local standard time 

1, 2 and 3) 40 CFR Part 50 App L Sec. 3.3 and 40 CFR 
Part 50 App N Sec. 1 for the midnight to midnight local 
standard time requirement 

 
See details if less than 1380 min sampled 

Sampling Instrument    

Average Flow Rate every 24 hours of op average within 5% of 16.67 liters/minute 1, 2 and 3) Part 50 App L Sec. 7.4.3.1 

Variability in Flow Rate every 24 hours of op CV < 2% 1, 2 and 3) 40 CFR Part 50, App L Sec. 7.4.3.2 

One-point Flow Rate Verification every 30 days each seperated 
by 14 days 

< + 4.1% of transfer standard 
< + 5.1% of flow rate design value 

1, 2 and 3) 40 CFR Part 50, App L, Sec. 9.2.5 and 
7.4.3.1 and 40 CFR Part 58, Appendix A Sec. 3.2.1 

Design Flow Rate Adjustment After multi-point calibration or 
verification < + 2.1% of design flow rate 1, 2 and 3) 40 CFR Part 50, App. L, Sec. 9.2.6 

Individual Flow Rates every 24 hours of op no flow rate excursions > +5% for > 5 min. 1/ 1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.3.1 

Filter Temp Sensor every 24 hours of op 
no excursions of > 5o C lasting longer than 30 min 

1/ 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.11.4 

 
External Leak Check 

Before each flow rate 
verification/calibration and 

before and after PM2.5 separator 
maintenance 

 
< 80.1 mL/min (see comment #1) 

1) 40 CFR Part 50 App L, Sec. 7.4.6.1 
2) 40 CFR Part 50 App L Sec. 9.2.3 and Method 2-12 
Sec. 7.4.3 
3) 40 CFR Part 50, App. L, Sec. 7.4.6.1 

 
Internal Leak Check 

 
If failure of external leak check 

 
< 80.1 mL/min 

1) 40 CFR Part 50, App. L, Sec. 7.4.6.2 
2) Method 2-12, Sec. 7.4.4 
3) 40 CFR Part 50, App. L, Sec. 7.4.6.2 

 
 
 
 
 
 
 
 
 



 

 

 
Laboratory Activities 

 
1) Criteria (PM2.5 LC) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

 
 
 

Post-sampling Weighing 

 
 
 

all filters 

Protected from exposure to temperatures above 
25C from sample retrieval to conditioning 

 
<10 days from sample end date if shipped at 

ambient temp, or 
< 30 days if shipped below avg ambient (or 4o C or 

below for avg sampling temps < 4o C ) from 
sample end date 

1, 2 and 3) 40 CFR Part 50 App L Sec. 8.3.6 and 
L Sec. 10.13. 

 
See technical note on holding time requirements at : 
https://www3.epa.gov/ttn/amtic/pmpolgud.html 

Filter Visual Defect Check 
(unexposed) all filters Correct type & size and for pinholes, particles or 

imperfections 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 10.2 

Filter Conditioning Environment    

Equilibration all filters 24 hours minimum 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.5 
Temp. Range all filters 24-hr mean 20.0-23.0o C 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.1 
Temp. Control all filters < 2.1o C SD* over 24 hr. 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.2 SD use is 

a recommendation 
Humidity Range 

all filters 
24-hr mean 30.0% - 40.0% RH or 

Within +5.0 % sampling RH but > 20.0%RH 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.3 

Humidity Control all filters < 5.1 % SD* over 24 hr. 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.4 SD use is 
recommendation 

Pre/post Sampling RH all filters difference in 24-hr means < + 5.1% RH 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.3.3 
Balance all filters located in filter conditioning environment 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.3.2 

 
Microbalance Auto-Calibration 

 
Prior to each weighing session 

 
Manufacturer’s specification 

1) 40 CFR Part 50, App. L, Sec. 8.1 
2) 40 CFR Part 50, App. L, Sec. 8.1 and Method 2.12 
Sec. 10.6 
3) NA 

OPERATIONAL EVALUATIONS TABLE PM2.5 Filter Based Local Conditions 
Field Activities 

 
One-point Temp Verification 

 
every 30 days 

 
< + 2.1oC 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2) Method 2.12 Sec. 7.4.5 and Table 6-1 
3) Recommendation 

 
Pressure Verification 

 
every 30 days 

 
< + 10.1 mm Hg 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2) Method 2.12 Sec. 7.4.6 and Table 6-1 
3) Recommendation 

Annual Multi-point Verifications/Calibrations   

Temperature multi-point 
Verification/Calibration 

on installation, then every 365 
days and once a calendar year < + 2.1oC 1) 40 CFR Part 50, App. L, Sec. 9.3 

2 and 3) Method 2.12 Sec. 6.4.4 Table 6-1 
 
 
 
 
 



 

 

 
 
 

 
1) Criteria (PM2.5 LC) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

 
 

Pressure Verification/Calibration 

 
on installation, and on one- 

point verification failure 

 

< + 10.1 mm Hg 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2 and 3) Method 2.12 Sec. 6.5 
Sampler BP verified against independent standard 
verified against a lab primary standard that is certified as 
NIST traceable 1/year 

 
Flow Rate Multi-point Verification/ 
Calibration 

Electromechanical 
maintenance or transport or 

every 365 days and once a 
calendar year 

 
< + 2.1% of transfer standard 

1) 40 CFR Part 50, App. L, Sec. 9.2. 
2) 40 CFR Part 50, App. L, Sec. 9.1.3, Method 2.12 
Sec. 6.3 & Table 6-1 
3) Recommendation 

Other Monitor Calibrations per manufacturers’ op manual per manufacturers’ operating manual 1, 2 and 3) Recommendation 
Precision    

 
Collocated Samples every 12 days for 15% of sites 

by method designation CV < 10.1% of samples > 3.0 µg/m3 
1) and 2) Part 58 App A Sec. 3.2.3 
3 Recommendation based on DQO in 40 CFR Part 58 
App A Sec. 2.3.1.1 

Accuracy    

Temperature Audit every 180 days and at time of 
flow rate audit < + 2.1oC 1, 2 and 3) Method 2.12 Sec. 11.2.2 

Pressure Audit every 180 days and at time of 
flow rate audit < +10.1 mm Hg 1, 2 and 3) Method 2.12 Sec. 11.2.3 

Semi Annual Flow Rate Audit Twice a calendar year and 
between 5-7 months apart 

< + 4.1% of audit standard 
< + 5.1% of design flow rate 

1 and 2) Part 58, App A, Sec. 3.2.2 
3) Method 2.12 Sec. 11.2.1 

Monitor Maintenance    

PM2.5 Separator (WINs) every 5 sampling events cleaned/changed 1, 2, and 3) Method 2.12 Sec. 8.2.2 

PM2.5 Separator (VSCC) every 30 days cleaned/changed 1, 2 and 3) Method 2.12 Sec. 8.3.3 
Inlet Cleaning every 30 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.3 
Downtube Cleaning every 90 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.4 
Filter Housing Assembly Cleaning every 30 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.3 
Circulating Fan Filter Cleaning every 30 days cleaned/changed 1, 2 and 3) Method 2.12 Sec. 8.3 
Manufacturer-Recommended 
Maintenance 

per manufacturers’ SOP per manufacturers’ SOP  

Laboratory Activities 
Filter Checks    

 
Lot Blanks 

 
9 filters per lot 

 
< +15.1 µg change between weighings 

1, 2, 3) Recommendation and used to determine filter 
stability of the lot of filters received from EPA or 
vendor. Method 2.12 Sec. 10.5 

Exposure Lot Blanks 3 filters per lot < +15.1 µg change between weighings 1, 2 and 3) Method 2.12 Sec. 10.5 
Used for preparing a subset of filters for equilibration 

Filter Integrity (exposed) each filter no visual defects 1, 2 and 3) Method 2.12 Sec. 10.7 and 10.3 
Lab QC Checks    

 



 

 

 
 
 

 
1) Criteria (PM2.5 LC) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

Field Filter Blank 10% or 1 per weighing session <+ 30.1 µg change between weighings 1) 40 CFR Part 50, App. L Sec. 8.3.7.1 
2 and 3) Method 2.12 Table 7-1 & Sec.10.5 

Lab Filter Blank 10% or 1 per weighing session <+ 15.1 µg change between weighings 1) 40 CFR Part 50, App. L Sec. 8.3.7.2 
2 and 3) Method 2.12 Sec. 10.5 

 
Balance Check (working standards) 

 
beginning, 10th sample, end 

 
< +3.1 µg from certified value 

1, 2 and 3) Method 2.12 Sec. 10.6 
Standards used should meet specifications in Method 
2.12, Sec. 4.3.7 

Routine Filter re-weighing 1 per weighing session <+ 15.1 µg change between weighings 1, 2 and 3) Method 2.12 Sec. 10.8 

Microbalance Audit every 365 days and once a 
calendar year 

<+ 0.003 mg or manufacturers specs, whichever is 
tighter 

1, 2 and 3) Method 2.12 Sec. 11.2.7 

Lab Temp Check Every 90 days < + 2.1oC 1, 2 and 3) Method 2.12 Sec. 10.10 

Lab Humidity Check Every 90 days < + 2.1% 1, 2 and 3) Method 2.12 Sec. 10.10 
Verification/Calibration    

 
Microbalance Calibration 

 
At installation every 365 days 

and once a calendar year 

 
Manufacturer’s specification 

1) 40 CFR Part 50, App. L, Sec. 8.1 
2) 40 CFR Part 50, App. L, Sec. 8.1 and Method 2.12 
Sec. 10.11 
3) NA 

Lab Temperature Certification every 365 days and once a year < + 2.1oC 1, 2 and 3) Method 2.12 Sec. 4.3.8 and 9.4 

Lab Humidity Certification every 365 days and once a year < + 2.1% 1, 2 and 3) Method 2.12 Sec. 4.3.8 and 9.4 
Calibration & Check Standards -    

Working Mass Stds. Verification 
Compared to primary standards 

Every 90 days < + 2.1 ug 1, 2 and 3) Method 2.12 Sec. 9.7 

Primary standards certification every 365 days and once a 
calendar year 0.025 mg tolerance (Class 2) 1, 2 and 3) Method 2.12 Sec. 4.3.7 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
Continuous PM2.5 Local Conditions Validation Template 

 
1) Criteria (PM2.5 Cont) 2) Frequency 3) Acceptable Range Information /Action 

CRITICAL CRITERIA- PM2.5 Continuous, Local Conditions 
 

Sampler/Monitor Designation 
 

NA 

Meets requirements listed in FRM/FEM/ARM 
designation 
Confirm method designation on front panel or just inside 
instrument. 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

 
 

Firmware of monitor 

 
 

At setup 

1. Must be the firmware (or later version) as identified 
in the published method designation summary. 

2. Firmware settings must be set for flowrate to 
operate and report at “local conditions” (i.e., not 
STP). 

 
 

40 CFR Part 50 App N. sec. 1 (c) 

 
 

Data Reporting Period 

 
 

Report every hour 

1. The calculation of an hour of data is dependent on the 
design of the method. 

2. A 24-hour period is calculated in AQS if 18 or more 
valid hours are reported for a day 1/. 

See operator’s manual. Hourly data are always 
reported as the start of the hour on local standard 
time 
40 CFR Part 50 App N. Sec 3 (c) 

Sampling Instrument 

PM10 Inlet (if applicable to method 
designated) At Setup 

Must be a Louvered PM10 size selective inlet as specified 
in 40 CFR 50 appendix L, Figures L-2 through L-19 

 

PM2.5 second stage separator (if 
applicable to method designated) At Setup 

 
Must be a BGI Inc. Very Sharp Cut Cyclone (VSCCTM) or 

equivalent second stage separator approved for the 
method. 

The other approved second stage separator option 
for select FEMs is the Dichot. Only the GRIMM 
180 and Teledyne T640 and T640X are known to 
not have a second stage seperator as part of the 
method. 

Average Flow Rate 
every 24 hours of operation; 

alternatively, each hour can be 
checked 

average within 5% of 16.67 liters/minute at local 
conditions 

1, 2 and 3) Part 50 App L Sec. 7.4.3.1 

Variability in Flow Rate 
every 24 hours of op CV < 2% 1, 2 and 3) 40 CFR Part 50, App L Sec. 7.4.3.2 

One-point Flow Rate Verification 
every 30 days each seperated 

by 14 days 
< + 4.1% of transfer standard 

< + 5.1% of flow rate design value 
1, 2 and 3) 40 CFR Part 50, App.L, Sec. 9.2.5, 40 
CFR Part 58, Appendix A Sec. 3.2.3 & 3.3.2 

Design Flow Rate Adjustment 
After multi-point calibration or 

verification < + 2.1% of design flow rate 1,2 and 3) 40 CFR Part 50, App. L, Sec. 9.2.6 

External Leak Check 

Before each flow rate 
verification/calibration and 

before and after PM2.5 separator 
maintenance 

 
Method specific. See operator’s manual. 

1) 40 CFR Part 50 App L, Sec. 7.4.6.1 
2) 40 CFR Part 50 App L Sec.t 9.2.3 and Method 
2-12 Sec. 7.4.3 
3) 40 CFR Part 50, App. L, Sec. 7.4.6.1 

 
Internal Leak Check 

 
If failure of external leak check 

 
Method specific. See operators manual. 

1) 40 CFR Part 50, App. L, Sec. 7.4.6.2 
2) Method 2-12 7.4.4 
3) 40 CFR Part 50, App. L, Sec. 7.4.6.2 



 

 

1) Criteria (PM2.5 Cont) 2) Frequency 3) Acceptable Range Information /Action 
Annual Multi-point Verifications/Calibrations   

 
 

Leak Check 

 
 

every 30 days 

 

< 1.0 lpm BAM (Not Thermo BAMS) 
+ 0.15 lpm TEOM 

1) 40 CFR Part 50 App L, Sec. 7.4.6.1 
2) Recommendation 
3) BAM SOP Sec. 10.1.2 

TEOM SOP Sec. 10.1.6 
Thermo BAM leak check should not be attempted. 
Foils could be ruptured. 

Temperature multi-point 
Verification/Calibration 

on installation, then Every 365 
days and 1/ calendar year < + 2.1oC 1) 40 CFR Part 50, App.L, Sec. 9.3 

2 and 3) Method 2.12 Sec. 6.4.4 
 

One-point Temp Verification 
 

every 30 days 
 

< + 2.1oC 
1) 40 CFR Part 50, App.L, Sec. 9.3 
2) Method 2.12 Sec. 7.4.5 and Table 6-1 
3) Recommendation 

 
 

Pressure Verification/Calibration 

 
on installation, then Every 365 

days and 1/ calendar year 

 

< + 10.1 mm Hg 

1) 40 CFR Part 50, App.L, Sec. 9.3 
2 and 3) Method 2.12 Sec. 6.5 
BP verified against independent standard verified 
against a lab primary standard that is certified 
NIST traceable 1/year 

 
Flow Rate Multi-point Verification/ 
Calibration 

Electromechanical 
maintenance or transport or 

Every 365 days and 1/ calendar 
year 

< + 2.1% of transfer standard 

1) 40 CFR Part 50, App.L, Sec. 9.2. 
2) 40 CFR Part 50, App.L, Sec. 9.1.3, Method 2.12 

Sec. 6.3 & Table 6-1 
3) Recommendation 

 
Other Monitor Calibrations/checks 

 
per manufacturers’ op manual Annual zero test on Met One BAM 1020 and BAM 1022 

per manufacturers’ operating manual. Note: more 
frequent zero tests may be appropriate in areas with 
seasonal changes in dew-points. 

Precision    

 
Collocated Samples 

every 12 days for 15% of sites 
by method designation CV < 10.1% of samples > 3 µg/m3 

1) and 2) Part 58 App A Sec. 3.2.3 
3 Recommendation based on DQO in 40 CFR Part 
58 App A Sec. 2.3.1.1 

Accuracy    

Temperature Audit 
every 180 days and at time of 

flow rate audit < + 2.1oC 
1, 2 and 3) Method 2.12 Sec. 11.2.2 

Pressure Audit 
every 180 days and at time of 

flow rate audit < +10.1 mm Hg 
1, 2 and 3) Method 2.12 Sec. 11.2.3 

Semi Annual Flow Rate Audit 
Twice a calendar year and 5-7 

months apart 
< + 4.1% of audit standard 

< + 5.1% of design flow rate 
1 and 2) Part 58, App A, Sec. 3.3.3 
3) Method 2.12 Sec. 11.2.1 

Shelter Temperature   
 

Temperature range At setup per operator manual 
 

Temperature Control Daily (hourly values) < 2.1o C SD over 24 hours 
1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 

Temperature Device Check 
every 180 days and twice a 

calendar year < + 2.1o C 
1, 2 and 3) QA Handbook Volume 2 Sec. 7.2.2 

 



 

 

 
1) Criteria (PM2.5 Cont) 2) Frequency 3) Acceptable Range Information /Action 

Monitor Maintenance    

PM2.5 Separator (WINS) every 5 sampling events cleaned/changed 1, 2,and 3) Method 2.12 Sec. 8.2.2 

PM2.5 Separator (VSCC) every 30 days cleaned/changed 1,2 and 3) Method 2.12 Sec. 8.3.3 
Inlet Cleaning every 30 days cleaned 1,2 and 3) Method 2.12 Sec. 8.3 
Downtube Cleaning every 90 days cleaned 1,2 and 3) Method 2.12 Sec. 8.4 
Filter Housing Assembly Cleaning every 30 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.3 
Circulating Fan Filter Cleaning every 30 days cleaned/changed 1, 2 and 3) Method 2.12 Sec. 8.3 
Manufacturer-Recommended 

Maintenance per manufacturers’ SOP per manufacturers’ SOP  

TEOM-FDMS Specific Operational Criteria 

Total Flow Verification every 30 days Sum of flow rates from 3 paths equal design 
flow rate < + 5.1% 

1,2 and 3) TEOM SOP Sec. 10.1.2 

Bypass leak check (TEOM) every 30 days + 0.60 lpm 1,2 and 3) TEOM SOP Sec. 10.1.6 or TEOM 
Operating Manual Sec. 5-4 

Replace TEOM filters as needed Change TEOM filter as filter loading approaches 90%, but 
must be changed before reaching 100%. 

1,2 and 3) TEOM SOP Sec. 10.1.8 

Replace the 47-mm FDMS (Purge) 
filters 

every 30 days or any time 
TEOM filters are replaced replaced 1,2 and 3) TEOM SOP Sec. 10.1.10 

 
Internal/External Data Logger Data 

 
Every 30 days 

10 randomly selected values 

agree exactly (digital) and + 1 µg/m3 (analog). Note: 
digital is expected and should be used unless there is no 

capacity to utilize digital in the monitoring agencies’ data 
system. 

1, 2 and 3) TEOM SOP Sec. 10.1.24 

Replace In-line filters 
every 180 days and twice a 

calendar year replaced 
1, 2 and 3) TEOM SOP Sec. 10.2 

Clean cooler assembly 
every 365 days and once a 

calendar year cleaned 
1, 2 and 3) TEOM SOP Sec. 10.3.1 

Clean/Maintain switching valve 
every 365 days and once a 

calendar year cleaned 
1, 2 and 3) TEOM SOP Sec. 10.3.2 

Clean air inlet system of mass 
transducer enclosure 

every 365 days and once a 
calendar year cleaned 

1, 2 and 3) TEOM SOP Sec. 10.3.3 

Replace the dryers 1/yr or due to poor performance 
Review dryer dew point data to determine acceptable 

performance of dryer 
1, 2 and 3) TEOM SOP Sec. 10.3.4 

 
Calibration (KO) constant 
verification 

 
every 365 days and once a 

calendar year 

 
Pass or Fail 

(< 2.5%) 

1, 2 TEOM SOP Sec. 10.3.6 
3) 1405-DF operating guide. Verification software 
either passes or fails the verification. Acceptance 
criteria is < 2.5 % 

Rebuild sampling pump 18 months < 66% of local pressure 1, 2 and 3) TEOM SOP Sec. 10.4 

 
 
 
 
 
 



 

 

1) Criteria (PM2.5 Cont) 2) Frequency 3) Acceptable Range Information /Action 
GRIMM Specific Operational Criteria 

 
Internal rinsing air filter 

 
After a few years 

 
Changed 

1, 2 and 3) GRIMM SOP Sec. 12.4 
May require a trained service staff to change. May 
only require changing if a message reads “check 
nozzle and air inlet” 

Change Dust Filter Every 365 days and 1/ calendar 
year Changed 1, 2 and 3) GRIMM SOP Sec. 12.3 

Relative Humidity Setting At Setup Per Operators manual (55%) unless otherwise directed 
and approved to use at a different value 

 

Calibration of spectrometer Yearly +/- 5% for mass Operators’ Manual section 5.2 
Cleaning or changing of the Nafion 
in inlet As needed We are seeking clarification from GRIMM on this Operators’ Manual section 11.4.2 

Thermo BAM Specific Operational Criteria 

Cleaning Nozzle and Vane (BAM) Minimally every 30 days cleaned 1, 2 and 3) BAM SOP Sec. 10.1.3 

 
Leak Check 

 
every 30 days 

 
< 0.42 L/min 

1) BAM 5014i Instruction Manual 
2) 
3) BAM 5014i Instruction Manual 

Replace or clean pump muffler every 180 days and twice a 
calendar year Cleaned or changed  

 
Internal/External Data Logger Data 
(BAM) 

 
Every 30 days 

10 randomly selected values 

agree exactly (digital) and + 1 µg/m3 (analog). Note: 
digital is expected and should be used unless there is no 

capacity to utilize digital in the monitoring agencies’ data 
system. 

1, 2 and 3) BAM SOP Sec. 10.1.9 

Clean/replace internal debris filter 
Every 365 days and 1/ calendar 

year   

MetOne BAM Specific Operational Criteria 

BAM check of membrane span foil Daily Avg. < + 5.1% of ABS 
1, 2 and 3) BAM SOP Sec. 10.4.3. Applies on the 
BAM 1020 

 
BAM electrical grounding  

At setup 

1. Is the chassis of the BAM grounded? 
 

Is the downtube grounded to the chassis at the collar (i.e., 
with setscrews) 

 
Per operator manual 

Nozzle cleaning Every 30 days, or more often as 
needed cleaned Per operator manual 

Zero test Yearly 
Standard deviation of the data from a 72-hour zero test 

< 2.4 µg/m3 
Per operator manual 

 
 
 
 
 
 
 
 



 

 

 
PM10c for PM10-2.5 Low –Volume, Filter-Based Local Conditions Validation Template 

 
1) Criteria (PM10c) 2) Frequency 3) Acceptable Range Information /Action 

CRITICAL CRITERIA- PM10c Filter Based Local Conditions 
Field Activities 

 
Sampler/Monitor 

 
NA Meets requirements listed in FRM/FEM/ARM 

designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

Filter Holding Times    

Pre-sampling all filters < 30 days before sampling 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.3.5 

Sample Recovery all filters <7 days 9 hours from sample end date 1, 2 and 3) 40 CFR Part 50 App L Sec. 10.10 

Sampling Period (including 
multiple power failures) 

 
all filters 

1380-1500 minutes, or 
value if < 1380 and exceedance of NAAQS 1/ 

midnight to midnight local standard time 

1, 2 and 3) 40 CFR Part 50 App L Sec. 3.3 
 

See details if less than 1380 min sampled 
Sampling Instrument    

Average Flow Rate every 24 hours of op average within 5% of 16.67 liters/minute 1, 2 and 3) Part 50 App L Sec. 7.4.3.1 

Variability in Flow Rate every 24 hours of op CV < 2% 1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.3.2 
 

One-point Flow Rate Verification every 30 days each seperated 
by 14 days 

+ 4% of transfer standard 
+ 5% of flow rate design value 

1, 2 and 3) 40 CFR Part 50, App. L, Sec. 9.2.5, 40 CFR 
Part 58 App A Sec. 3.3.1 

Design Flow Rate Adjustment After multi-point calibration or 
verification < + 2.1% of design flow rate 1, 2 and 3) 40 CFR Part 50, App. L, Sec. 9.2.6 

Individual Flow Rates every 24 hours of op no flow rate excursions > +5% for > 5 min. 1/ 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.3.1 

Filter Temp Sensor every 24 hours of op 
no excursions of > 5o C lasting longer than 30 min 

1/ 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.11.4 

 
External Leak Check 

Before each flow rate 
verification/calibration and 

before and after PM2.5 separator 
maintenance 

 
< 80.1 mL/min (see comment #1) 

1) 40 CFR Part 50 App L, Sec. 7.4.6.1 
2) 40 CFR Part 50 App L Sec.t 9.2.3 and Method 2-12 
Sec. 7.4.3 
3) 40 CFR Part 50, App. L, Sec. 7.4.6.1 

 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 

1) Criteria (PM10c) 2) Frequency 3) Acceptable Range Information /Action 
 

Internal Leak Check 
 

If failure of external leak check 
 

< 80.1 mL/min 
1) 40 CFR Part 50, App. L, Sec. 7.4.6.2 
2) Method 2-12, Sec. 7.4.4 
3) 40 CFR Part 50, App. L, Sec. 7.4.6.2 

Laboratory Activities 
 
 
 

Post-sampling Weighing 

 
 
 

all filters 

Protected from exposure to temperatures above 
25C from sample retrieval to conditioning 

 
<10 days from sample end date if shipped at 

ambient temp, or 
<30 days if shipped below avg ambient (or 4o C or 

below for avg sampling temps < 4o C ) from 
sample end date 

1, 2 and 3) 40 CFR Part 50 App L Sec. 8.3.6 

Filter Visual Defect Check 
(unexposed) all filters Correct type & size and for pinholes, particles or 

imperfections 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 10.2 

Filter Conditioning Environment    

Equilibration all filters 24 hours minimum 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.5 
Temp. Range all filters 24-hr mean 20.0-23.0o C 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.1 
Temp.Control all filters < 2.1o C SD* over 24 hr 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.2 SD use is 

a recommendation 
Humidity Range 

all filters 
24-hr mean 30.0% - 40.0% RH or within 

+5.0% sampling RH but > 20.0%RH 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.3 

Humidity Control all filters < 5.1% SD* over 24 hr. 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.4 SD use is 
recommendation 

Pre/post Sampling RH all filters difference in 24-hr means < + 5.1% RH 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.3.3 

Balance all filters located in filter conditioning environment 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.3.2 
OPERATIONAL EVALUATIONS TABLE- PM10c Filter Based Local Conditions 

Field Activities 
Sampling Instrument    

Routine Verifications   

 
One-point Temp Verification 

 
every 30 days 

 
<+ 2.1oC 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2) Method 2.12 Sec. 7.4.5 and Table 6-1 
3) Recommendation 

 
Pressure Verification 

 
every 30 days 

 
< + 10.1 mm Hg 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2) Method 2.12 Sec. 7.4.6 and Table 6-1 
3) Recommendation 

Annual Multi-point Verifications/Calibrations   

Temperature multi-point 
Verification/Calibration 

on installation, then every 365 
days and once a calendar year <+ 2.1oC 1) 40 CFR Part 50, App. L, Sec. 9.3 

2 and 3) Method 2.12 Sec. 6.4.4 Table 6-1 
 
 
 



 

 

 
1) Criteria (PM10c) 2) Frequency 3) Acceptable Range Information /Action 

 
 

Pressure Verification/Calibration 

 
on installation, then every 365 
days and once a calendar year 

 

<+ 10.1 mm Hg 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2 and 3) Method 2.12 Sec. 6.5 
Sampler BP verified against independent standard 
verified against a lab primary standard that is certified 
as NIST traceable 1/year 

 
Flow Rate Multi-point Verification/ 
Calibration 

Electromechanical 
maintenance or transport or 

every 365 days and once a 
calendar year 

 
<+ 2.1% of transfer standard 

1) 40 CFR Part 50, App. L, Sec. 9.2. 
2) 40 CFR Part 50, App. L, Sec. 9.1.3, Method 2.12 
Sec. 6.3 & Table 6-1 
3) Recommendation 

Other Monitor Calibrations per manufacturers’ op manual per manufacturers’ operating manual 1, 2 and 3) Recommendation 
Precision    

 
Collocated Samples every 12 days for 15% of sites 

by method designation CV < 10.1% of samples > 3.0 µg/m3 
1) and 2) Part 58 App A Sec. 3.2.3 
3 Recommendation based on DQO in 40 CFR Part 58 
App A Sec. 2.3.1.1 

Accuracy    

Temperature Audit every 180 days and at time of 
flow rate audit <+ 2.1oC 1, 2 and 3) Method 2.12 Sec. 11.2.2 

Pressure Audit every 180 days and at time of 
flow rate audit <+10.1 mm Hg 1, 2 and 3) Method 2.12 Sec. 11.2.3 

Semi Annual Flow Rate Audit Twice a calendar year and 5-7 
months apart 

<+ 4.1% of audit standard 
<+ 5.1% of design flow rate 

1 and 2) Part 58, App A, Sec. 3.2.2 
3) Method 2.12 Sec. 11.2.1 

Monitor Maintenance    

PM2.5 Separator (WINs) every 5 sampling events cleaned/changed 1, 2 and 3) Method 2.12 Sec. 8.2.2 

PM2.5 Separator (VSCC) every 30 days cleaned/changed 1, 2 and 3) Method 2.12 Sec. 8.3.3 
Inlet Cleaning every 30 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.3 
Downtube Cleaning every 90 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.4 
Filter Housing Assembly Cleaning every 30 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.3 
Circulating Fan Filter Cleaning every 30 days cleaned/changed 1, 2 and 3) Method 2.12 Sec. 8.3 
Manufacturer-Recommended 
Maintenance 

per manufacturers’ SOP per manufacturers’ SOP  

Laboratory Activities 
Filter Checks    

 
Lot Blanks 

 
9 filters per lot 

 
< +15.1 µg change between weighings 

1, 2, 3) Recommendation and used to determine filter 
stability of the lot of filters received from EPA or 
vendor. Method 2.12 Sec. 10.5 

Exposure Lot Blanks 3 filters per lot < +15.1 µg change between weighings 1, 2 and 3) Method 2.12 Sec. 10.5 
Used for preparing a subset of filters for equilibration 

Filter Integrity (exposed) each filter no visual defects 1, 2 and 3) Method 2.12 Sec. 10.7 and 10.3 
Lab QC Checks    

 
 
 
 



 

 

 
1) Criteria (PM10c) 2) Frequency 3) Acceptable Range Information /Action 

Field Filter Blank 10% or 1 per weighing session <+ 30.1 µg change between weighings 1) 40 CFR Part 50, App. L Sec. 8.3.7.1 
2 and 3) Method 2.12 Table 7-1 & Sec.10.5 

Lab Filter Blank 10% or 1 per weighing session <+ 15.1 µg change between weighings 1) 40 CFR Part 50, App. L Sec. 8.3.7.2 
2 and 3) Method 2.12 Sec. 10.5 

 
Balance Check (working standards) 

 
beginning, 10th sample, end 

 
< +3.1 µg from certified value 

1, 2 and 3) Method 2.12 Sec. 10.6 
Standards used should meet specifications in Method 
2.12, Sec. 4.3.7 

Routine Filter re-weighing 1 per weighing session <+ 15.1 µg change between weighings 1, 2 and 3) Method 2.12 Sec. 10.8 

Microbalance Audit every 365 days and once a 
calendar year 

<+ 0.003 mg or manufacturers specs, whichever is 
tighter 

1, 2 and 3) Method 2.12 Sec. 11.2.7 

Lab Temp Check Every 90 days < + 2.1oC 1, 2 and 3) Method 2.12 Sec. 10.10 
Lab Humidity Check Every 90 days < + 2.1% 1, 2 and 3) Method 2.12 Sec. 10.10 
Verification/Calibration    

 
Microbalance Calibration 

 
At installation every 365 days 

and once a calendar year 

 
Manufacturer’s specification 

1) 40 CFR Part 50, App. L, Sec. 8.1 
2) 40 CFR Part 50, App. L, Sec. 8.1 and Method 2.12 
Sec. 10.11 
3) NA 

Lab Temperature Certification every 365 days and once a year < + 2.1oC 1, 2 and 3) Method 2.12 Sec. 4.3.8 and 9.4 

Lab Humidity Certification every 365 days and once a year < + 2.1% 1, 2 and 3) Method 2.12 Sec. 4.3.8 and 9.4 

Calibration & Check Standards -    

Working Mass Stds. Verification 
Compared to primary standards 

Every 90 days < + 2.1 ug 1, 2 and 3) Method 2.12 Sec. 9.7 

Primary standards certification every 365 days and once a 
calendar year 0.025 mg tolerance (Class 2) 1, 2 and 3) Method 2.12 Sec. 4.3.7 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

PM10 Filter Based Dichot STP Conditions Validation Template 
 

1) Criteria (PM10 Dichot 
STP) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

CRITICAL CRITERIA- PM10 Filter Based Dichot 
Field Activities 

    

 
Sampler/Monitor 

 
NA Meets requirements listed in FRM/FEM/ARM 

designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

Sample Recovery all filters ASAP 1, 2 and 3) 40 CFR Part 50 App J Sec. 9.15 

Sampling Period all filters 1440 minutes + 60 minutes 
midnight to midnight local standard time 

1, 2 and 3) 40 CFR Part 50 App J Sec. 7.1.5 

Sampling Instrument    

Average Flow Rate every 24 hours of op average 16.67 liters/minute 1, 2 and 3) Method 2.10 Sec. 2.1 
Verification/Calibration    

One-point Flow Rate Verification every 30 days each seperated 
by 14 days < + 7.1% of transfer standard 1, 2 40 CFR Part 58 App A Sec. 3.3.1 

and 3) Method 2.10 Table 3-1 
Lab Activities 

Filter    

Visual Defect Check (unexposed) all filters see reference 1, 2 and 3) Method 2.10 Sec. 4.2 

Collection efficiency all filters > 99 % 1, 2 and 3) Part 50, App J Sec. 7.2.2 

Alkalinity all filters < 25.0 microequivalents/gram 1, 2 and 3) 40 CFR Part 50, App J Sec. 7.2.4 
Filter Conditioning Environment    

Equilibration all filters 24 hours minimum 1, 2 and 3) 40 CFR Part 50, App. J Sec. 9.3 
Temp. Range all filters 15-30.0o C 1, 2 and 3) 40 CFR Part 50, App. J Sec. 7.4.1 
Temp.Control all filters < 3.1o C SD* over 24 hr 1, 2 and 3) 40 CFR Part 50, App. J Sec. 7.4.2 

SD use is recommendation 
Humidity Range all filters 20% - 45.0% RH 1, 2 and 3) 40 CFR Part 50, App. J Sec. 7.4.3 
Humidity Control all filters <5.1% SD* over 24 hr 1, 2 and 3) 40 CFR Part 50, App. J Sec. 7.4.4 

SD use is recommendation 
Pre/post Sampling RH all filters difference in 24-hr means < + 5.1% RH 1, 2 and 3) Recommendation based on 40 CFR Part 50, App. 

L Sec. 8.3.3 
Balance all filters located in filter conditioning environment 1, 2 and 3) Recommendation based on 40 CFR Part 50, App. 

L Sec. 8.3.2 
OPERATIONAL EVALUATIONS TABLE PM10 Filter Based Dichot 

Field Activities 
Verification/Calibration    

System Leak Check During precalibration check Vacuum of 10 to 15 in. & rate of decline to 0 in 
>60 seconds 

1, 2 and 3) Method 2.10 Sec. 2.2.1 

 
 
 
 



 

 

 
 

1) Criteria (PM10 Dichot 
STP) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

FR Multi-point 
Verification/Calibration 

every 365 days and once a 
calendar year 

Correlation coefficient of >.990 with no point 
deviating more than 0.5 L/min for total or 0.05 

L/min for coarse 

1) 40 CFR Part 50, App. J, Sec. 8.0 
2 and 3) Method 2.10 Sec. 2.2.4 

Field Temp M-point Verification on installation, then every 365 
days and once a calendar year < + 2.1oC 1, 2 and 3) Recommendation based on Part 50, App. L 

Precision    

Collocated Samples every 12 days for 15% of sites <5.1 µg/m3 for concentrations below 80µg/m3 

and <7.1% for concentrations above 80µg/m3 

1 and 2) 40 CFR Part 58 App A Sec. 3.3.4 
3) Part 50, App J Sec. 4.1 

Semi Annual Flow Rate Audit every 180 days and twice a 
calendar year < + 10.1% of audit standard 1 and 2) 40 CFR Part 58, App A, Sec. 3.3.3 

3) Method 2.10 Sec. 7.1.5 
Monitor Maintenance    

Impactor every 90 days and 4 times a 
calendar year cleaned/changed 1, 2 and 3) Method 2.10 Sec. 6.1.2 

Inlet/downtube Cleaning every 90 days and 4 times a 
calendar year cleaned 1, 2 and 3) Method 2.10 Sec. 6.1.2 

Vacuum pump every 365 days and once a 
calendar year Replace diaphragm and flapper valves 1, 2 and 3) Method 2.10 Sec. 6.1.3 

Manufacturer-Recommended 
Maintenance per manufacturers’ SOP per manufacturers’ SOP  

Lab Activities 
Balance Check beginning, 10th sample, end < 4.1 µg of true zero 

< 2.1 µg of 10 mg check weight 
1, 2 and 3) Method 2.10 Sec. 4.5 

“Standard” filter QC check 10% < + 20.1 µg change from original value 1, 2 and 3) Method 2.10 Sec. 4.5 
From standard non-routine filter 

“Routine” duplicate weighing 5-7 per weighing session < + 20.1 µg change from original value 1, 2 and 3) Method 2.10 Sec. 4.5 
From routine filter set 

Integrity- Random sample of test 
field blank filters 

 
10% 

 
+ 5 µg/m3 

1) 40 CFR Part 50 App J Sec. 7.2.3 2 and 
2) Recommendation 
3) 40 CFR Part 50 App J Sec. 7.2.3 

Lab Temperature Calibration every 180 days and twice a 
calendar year + 2oC 1, 2 and 3) Recommendation related to 40 CFR Part 50, App 

.L 

Lab Humidity Calibration every 180 days and twice a 
calendar year + 2% 1, 2 and 3) Recommendation related to 40 CFR Part 50 App 

L Sec. 5.8.1 

Microbalance Calibration every 365 days and once a 
calendar year Manufacturer’s specification 1, 2 and 3) Recommendation related to 40 CFR Part 50 App 

L 

Filter Weighing Audit every 365 days and once a 
calendar year < + 20.1 µg change from original value 1, 2 and 3) Method 2.10 Table 7-1 

Balance Audit every 365 days and once a 
calendar year 

Observe weighing technique and check balance 
with ASTM Class 1 standard 

1, 2 and 3) Method 2.10 Table 7-1 Sec. 7.2.2 

 
 
 



 

 

 
 

1) Criteria (PM10 Dichot 
STP) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

Primary Mass Stds. (compare to 
NIST-traceable standards) 

every 365 days and once a 
calendar year 

NIST traceable 
(e.g., ANSI/ASTM Class 1, 1.1 or 2) 

1, 2 and 3) Method 2.10 Sec. 9 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

PM10 Filter Based High Volume (HV) STP Conditions Validation Template 
 

1) Criteria (PM10 Hi-Vol 
STP) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

CRITICAL CRITERIA- PM10 Filter Based Hi-Vol 
Field Activities 

 
Sampler/Monitor 

 
NA Meets requirements listed in 

FRM/FEM/ARM designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

Filter Holding Times    

Sample Recovery all filters ASAP 1, 2 and 3) 40 CFR Part 50 App J Sec. 9.15 

Sampling Period all filters 1440 minutes + 60 minutes 
midnight to midnight local standard time 

1, 2 and 3) 40 CFR Part 50 App J Sec. 7.1.5 

Average Flow Rate every 24 hours of op ~1.13 m3/min (varies with instrument) 1, 2 and 3) Method 2.11 
Verification/Calibration    

One-point Flow Rate Verification every 90 days and 4 times a 
calendar year 

<+ 7.1% of transfer standard and <+10.1% 
from design 

1 and 2) 40 CFR Part 58, App A, Sec. 3.3.2 
3) Method 2.11 Sec. 3.5.1, Table 2-1 

Lab Activities 
Filter    

Visual Defect Check (unexposed) all filters see reference Method 2.11 Sec. 4.2 
Collection efficiency all filters 99 % 1, 2 and 3) 40 CFR Part 50, App J Sec. 7.2.2 
Alkalinity all filters < 25.0 microequivalents/gram 1, 2 and 3) 40 CFR Part 50, App J Sec. 7.2.4 
Filter Conditioning Environment    

Equilibration all filters 24 hours minimum 1, 2 and 3) 40 CFR Part 50, App.J Sec. 9.3 
Temp. Range all filters 15.0-30.0o C 1, 2 and 3) 40 CFR Part 50, App.J Sec. 7.4.1 
Temp.Control all filters < 3.1o C SD* over 24 hr 1, 2 and 3) 40 CFR Part 50, App.J Sec. 7.4.2 SD use is 

recommendation 
Humidity Range all filters 20.0% - 45.0% RH 1, 2 and 3) 40 CFR Part 50, App.J Sec. 7.4.3 
Humidity Control all filters < 5.1% SD* over 24 hr 1, 2 and 3) 40 CFR Part 50, App.J Sec. 7.4.4 SD use is 

recommendation 
Pre/post Sampling RH all filters difference in 24-hr means < + 5.1% RH 1, 2 and 3) Recommendation based on Part 50, App. L Sec. 8.3.3 

Balance all filters located in filter conditioning environment 1, 2 and 3) Recommendation based on Part 50, App. L Sec. 8.3.2 
OPERATIONAL EVALUATIONS TABLE PM10 Filter Based Hi-Vol 

Field Activities 
Verification/Calibration    

System Leak Check During precalibration check Auditory inspection with faceplate blocked 1, 2 and 3) Method 2.11 Sec. 2.3.2 
FR Multi-point 
Verification/Calibration 

every 365 days and once a 
calendar year 3 of 4 cal points within < + 10.1% of design 1, 2 and 3) Method 2.11 Sec. 2.3.2 

Field Temp M-point Verification on installation, then every 365 
days and once a calendar year < + 2.1oC 1, 2 and 3) Recommendation 

Precision    

 
 
 



 

 

 
 

1) Criteria (PM10 Hi-Vol 
STP) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

Collocated Samples every 12 days for 15% of sites CV < 10.1% of samples > 15 µg/m3 
1) and 2) 40 CFR Part 58 App A Sec. 3.3.4 
3) Recommendation 

Semi Annual Flow Rate Audit every 180 days and twice a 
calendar year 

< + 7.1% of transfer standard and< + 10.1% 
from design 

1 and 2) 40 CFR Part 58, App A, Sec. 3.3.3 
3) Method 2.11 Sec. 7 Table 7-1 

Monitor Maintenance    

Inlet/downtube Cleaning every 90 days and 4 times a 
calendar year cleaned 1, 2 and 3) Method 2.11 Sec. 6 

Motor/housing gaskets every 90 days and 4 times a 
calendar year Inspected replaced 1, 2 and 3) Method 2.11 Sec. 6 

Blower motor brushes 600-1000 hours Replace 1, 2 and 3) Method 2.11 Sec. 6 
Manufacturer-Recommended 
Maintenance per manufacturers’ SOP per manufacturers’ SOP NA 

Lab Activities 
Lab QC Checks    

Balance Check (Standard Weight 
Check and Calibration Check) beginning, 15th sample, end < + 0.51 mg of true zero and < + 0.51 mg 

1-5 g check weight 
1, 2, and 3) Method 2 .11 Sec. 4.5.1 and 4.5.2 

“Routine” duplicate weighing 5-7 per weighing session < + 2.8 mg change from original value 1, 2 and 3) Method 2.11 Sec. 4.5.3 
From routine filter set 

Integrity- Random sample of test 
field blank filters 

 
10% 

 
< + 5.1 µg/m3 

1) 40 CFR Part 50 App J Sec. 7.2.3 
2) Recommendation 
3) 40 CFR Part 50 App J Sec. 7.2.3 

Lab Temperature Calibration every 180 days and twice a 
calendar year < + 2.1oC 1, 2 and 3) Recommendation related to 40 CFR Part 50, App. L 

Lab Humidity Calibration every 180 days and twice a 
calendar year < + 2.1% 1, 2 and 3) Recommendation related to 40 CFR Part 50 App L 

Microbalance Calibration every 365 days and once a 
calendar year Manufacturer’s specification  

Primary Mass Stds. (compare to 
NIST-traceable standards) 

every 365 days and once a 
calendar year 

NIST traceable 
(e.g., ANSI/ASTM Class 1, 1.1 or 2) 

1, 2 and 3) Method 2.11 Sec. 9 

Audits    

 
Filter Weighing every 365 days and once a 

calendar year 

 
< + 5.1 mg change from original value 

1) Method 2.11 Table 7-1 
2) Recommendation 
3) Method 2.11 Table 7-1 

 
Balance Audit every 365 days and once a 

calendar year 
Observe weighing technique and check 
balance with ASTM Class 1 standard 

1) Method 2.11 Table 7-1 
2) Recommendation 
3) Method 2.11 Table 7-1 

 
 
 
 
 
 



 

 

 

Continuous PM10 STP Conditions Validation Template 
 

1) Criteria (PM10 Cont) 2) Frequency 3) Acceptable Range Information /Action 
CRITICAL CRITERIA- PM10 Continuous 

 
Sampler/Monitor 

 
NA Meets requirements listed in 

FRM/FEM/ARM designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

Sampling Period all filters 1440 minutes + 60 minutes 
midnight to midnight local standard time 

1, 2 and 3) 40 CFR Part 50 App J Sec. 7.1.5 

Average Flow Rate every 24 hours of op Average within < + 5.1% of design recommendation 

Verification/Calibration    

One-point Flow Rate Verification every 30 days each seperated 
by 14 days < + 7.1% of transfer standard 1 and 2) 40 CFR Part 58, App A, Sec. 3.3 

3) Method 2.10 Table 3-1 
OPERATIONAL EVALUATIONS TABLE PM10 Continuous 

Verification/Calibration    

System Leak Check During precalibration check Auditory inspection with faceplate blocked 1, 2 and 3) Method 2.11 Sec. 2.3.2 
FR Multi-point 
Verification/Calibration 

every 365 days and once a 
calendar year 3 of 4 cal points within < + 10.1% of design 1) 40 CFR Part 50 App J Sec. 8.0 

2 and 3) Method 2.10 Sec. 2.2.4 
Audits    

Semi Annual Flow Rate Audit Twice a calendar year and 5- 
7 months apart < + 10.1% of audit standard 1, 2) Part 58, App A, Sec. 3.3.3 

3) Method 2.10 Sec. 7.1.5 
Monitor Maintenance    

Inlet/downtube Cleaning every 90 days and 4 times a 
calendar year cleaned 1, 2 and 3) Method 2.10 Sec. 6.1.2 

Manufacturer-Recommended 
Maintenance per manufacturers’ SOP per manufacturers’ SOP  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

PM10 Low Volume STP Filter-Based Local Conditions Validation Template 
 

1) Criteria (PM10 Lo-Vol 
STP) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

CRITICAL CRITERIA- PM10 Lo-Vol Filter Based STP 
Field Activities 

 
Sampler/Monitor 

 
NA Meets requirements listed in FRM/FEM/ARM 

designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

Sample Recovery all filters <7 days 9 hours from sample end date 1, 2 and 3) 40 CFR Part 50 App L Sec. 10.10 

Pre-sampling all filters < 30 days before sampling 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.3.5 

Sampling Instrument    

Average Flow Rate every 24 hours of op average within < 5.1% of 16.67 liters/minute 1, 2 and 3) Part 50 App L Sec. 7.4.3.1 

Variability in Flow Rate every 24 hours of op CV < 2.1% 1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.3.2 

 
One-point Flow Rate Verification 

 
every 30 days each seperated 

by 14 days 

 
< + 4.1% of transfer standard 

< + 5.1% of flow rate design value 

1) 40 CFR Part 50, App. L, Sec. 9.2.5, 40 CFR Part 58, 
App A Sec. 3.3.1 
2) Part 58, App A, Sec. 3.3.1 
3) 40 CFR Part 50, App. L, Sec. 9.2.5 & 7.4.3.1 

Design Flow Rate Adjustment at one-point or multi-point 
verification/calibration < + 2.1% of design flow rate 1, 2 and 3) 40 CFR Part 50, App. L, Sec. 9.2.6 

Individual Flow Rates every 24 hours of op no flow rate excursions > +5.1% for > 5 min. 1/ 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.3.1 

Filter Temp Sensor every 24 hours of op 
no excursions of > 5o C lasting longer than 30 min 

1/ 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.11.4 

 
External Leak Check 

Before each flow rate 
verification/calibration and 
before and after maintenance 

 
< 80.1 mL/min (see comment #1) 

1) 40 CFR Part 50 App L, Sec. 7.4.6.1 
2) 40 CFR Part 50, App. L Sec. 9.2.3 Method 2-12 Sec. 
Table 8-1 
3) 40 CFR Part 50, App. L, Sec. 7.4.6.1 

 
Internal Leak Check 

 
every 5 sampling events 

 
< 80.1 mL/min 

1) 40 CFR Part 50, App. L, Sec. 7.4.6.2 
2) Method 2-12 Table 8-1 
3) 40 CFR Part 50, App. L, Sec. 7.4.6.2 

Laboratory Activities 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 

1) Criteria (PM10 Lo-Vol 
STP) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

 
 

Post-sampling Weighing 

 
 

all filters 

Protected from exposure to temperature 
<10 days from sample end date if shipped at 

ambient temp, or 
<30 days if shipped below avg ambient (or 4o C or 

below for avg sampling temps < 4o C ) from 
sample end date 

1, 2 and 3) 40 CFR Part 50 App L Sec. 8..3.6 

Filter Visual Defect Check 
(unexposed) all filters Correct type & size and for pinholes, particles or 

imperfections 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 10.2 

Filter Conditioning Environment    

Equilibration all filters 24 hours minimum 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.5 
Temp. Range all filters 24-hr mean 20.0-23.0o C 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.1 
Temp.Control all filters < 2.1o C SD* over 24 hr 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.2 SD use is 

recommendation 
Humidity Range  

all filters 
24-hr mean 30.0% - 40.0% RH or 

<5.1% sampling RH but > 20.0%RH 

1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.3 

Humidity Control all filters < 5.1% SD* over 24 hr. 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.2.4 SD use is 
recommendation 

Pre/post Sampling RH all filters difference in 24-hr means < + 5.1% RH 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.3.3 
Balance all filters located in filter conditioning environment 1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.3.2 

OPERATIONAL EVALUATIONS TABLE PM10 Lo-Vol Filter Based STP 
Field Activities 

Sampling Instrument    

Routine Verifications    

 
One-point Temp Verification 

 
every 30 days 

 
< + 2.1oC 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2) Method 2.12 Sec. 7.4.5 and Table 6-1 
3) Recommendation 

 
Pressure Verification 

 
every 30 days 

 
< + 10.1 mm Hg 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2) Method 2.12 Sec 7.4.6 and Table 6-1 
3) Recommendation 

Annual Multi-point Verifications/Calibrations   

Temperature multi-point 
Verification/Calibration 

on installation, then every 365 
days and once a calendar year < + 2.1oC 1) 40 CFR Part 50, App. L, Sec. 9.3 

2 and 3) Method 2.12 Sec. 6.4.4 and Table 6-1 
 
 

Pressure Verification/Calibration 

 
on installation, then every 365 
days and once a calendar year 

 

< + 10.1 mm Hg 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2 and 3) Method 2.12 Sec. 6.5 
Sampler BP verified against independent standard 
verified against a lab primary standard that is certified as 
NIST traceable 1/year 

 
 



 

 

 
 
 

1) Criteria (PM10 Lo-Vol 
STP) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

 
Flow Rate Multi-point 
Verification/ Calibration 

Electromechanical 
maintenance or transport or 

every 365 days and once a 
calendar year 

 
< + 2.1% of transfer standard 

1) 40 CFR Part 50, App. L, Sec. 9.2. 
2) 40 CFR Part 50, App. L, Sec. 9.1.3, Method 2.12 
Sec. 6.3 Table 6-1 
3) Recommendation 

Other Monitor Calibrations per manufacturers’ op manual per manufacturers’ operating manual 1, 2 and 3) Recommendation 
Precision    

Collocated Samples every 12 days for 15% of sites CV < 10.1% of samples > 3.0 µg/m3 
1) and 2) 40 CFR Part 58 App A Sec. 3.3.4 
3) Recommendation 

Accuracy    

Temperature Audit every 180 days and at time of 
flow rate audit < + 2.1oC 1, 2 and 3) Method 2.12 Sec. 11.2.2 

Pressure Audit every 180 days and at time of 
flow rate audit < +10.1 mm Hg 1, 2 and 3) Method 2.12 Sec. 11.2.3 

 
Semi Annual Flow Rate Audit Twice a calendar year and 5-7 

months apart 
< + 4.1% of audit standard 

< + 5.1% of design flow rate 

1 and 2) Part 58, App A, Sec. 3.3.3 
3) Method 2.12 Sec. 11.2.1 

Monitor Maintenance    

Inlet Cleaning every 30 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.3 
Downtube Cleaning every 90 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.4 
Filter Chamber Cleaning every 30 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.3 
Circulating Fan Filter Cleaning every 30 days cleaned/changed 1, 2 and 3) Method 2.12 Sec. 8.3 
Manufacturer-Recommended 
Maintenance 

per manufacturers’ SOP per manufacturers’ SOP  

Laboratory Activities 
Filter Checks    

 
Lot Blanks 

 
9 filters per lot 

 
< +15.1 µg change between weighings 

1, 2, 3) Recommendation and used to determine filter 
stability of the lot of filters received from EPA or 
vendor. Method 2.12 Sec. 10.5 

Exposure Lot Blanks 3 filters per lot < + 15.1 µg change between weighings 1, 2 and 3) Method 2.12 Sec. 10.5 
Used for preparing a subset of filters for equilibration 

Filter Integrity (exposed) each filter no visual defects 1, 2 and 3) Method 2.12 Sec. 10.3 and 10.7 
Lab QC Checks    

Field Filter Blank 10% or 1 per weighing session < + 30.1 µg change between weighings 1) 40 CFR Part 50, App. L Sec. 8.3.7.1 
2 and 3) Method 2.12 Table 7-1 & Sec. 10.5 

Lab Filter Blank 10% or 1 per weighing session < + 15.1 µg change between weighings 1) 40 CFR Part 50, App. L Sec. 8.3.7.2 
2 and 3) Method 2.12 Sec. 10.5 

 
Balance Check (working standards) 

 
beginning, 10th sample, end < + 3.1 µg from certified value 

1, 2 and 3) Method 2.12 Sec. 10.6 
Standards used should meet specifications in Method 
2.12, Sec. 4.3.7 

Routine Filter re-weighing 1 per weighing session < + 15.1 µg change between weighings 1, 2 and 3) Method 2.12 Sec. 10.8 

 



 

 

 
 
 

1) Criteria (PM10 Lo-Vol 
STP) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

Microbalance Audit every 365 days and once a 
calendar year 

< + 0.003 mg or manufacturers specs, whichever is 
tighter 

1, 2 and 3) Method 2.12 Sec. 11.2.7 

Lab Temp Check Every 90 days < + 2.1oC 1, 2 and 3) Method 2.12 Sec. 10.10 
Lab Humidity Check Every 90 days < + 2.1% 1, 2 and 3) Method 2.12 Sec. 10.10 
Verification/Calibration    

 
Microbalance Calibration 

 
At installation every 365 days 

and once a calendar year 

 
Manufacturer’s specification 

1) 40 CFR Part 50, App. L, Sec. 8.1 
2) 40 CFR Part 50, App. L, Sec. 8.1 and Method 2.12 
Sec. 10.11 
3) NA 

    

Lab Temperature Certification every 365 days and once a year < + 2.1oC 1, 2 and 3) Method 2.12 Sec. 4.3.8 and 9.4 
Lab Humidity Certification every 365 days and once a year < + 2.1% 1, 2 and 3) Method 2.12 Sec.4.3.8 and 9.4 
Calibration & Check Standards -    

Working Mass Stds. Verification 
Compared to primary standards 

Every 90 days < + 2.1 ug 1, 2 and 3) Method 2.12 Sec. 9.7 

Primary standards certification every 365 days and once a 
calendar year 0.025 mg tolerance (Class 2) 1, 2 and 3) Method 2.12 Sec. 4.3.7 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Pb High Volume (TSP) Local Conditions Validation Template 
 
 

 
1) Criteria 

 
2) Frequency 

 
3) Acceptable Range 

 
4) Information/Action 

CRITICAL CRITERIA- Pb in TSP Local Conditions 
Field Activities 

 
Sampler/Monitor 

 
NA 

 
Meets requirements listed in FRM/FEM/ARM 

designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 
Also described in 40 CFR Part 50 App B Sec. 7.2 

Filter Holding Times    

Sample Recovery all filters ASAP 1, 2 and 3) 40 CFR Part 50 App B Sec. 6.3 

Sampling Period all filters 1440 minutes + 60 minutes 
midnight to midnight local standard time 

1, 2 and 3) 40 CFR Part 50 App B Sec. 8.15 

Sampling Instrument    

Average Flow Rate every 24 hours of op 1.1-1.70 m3/min (varies with instrument) in 
actual condition 

1, 2 and 3) 40 CFR Part 50 App B Sec. 8.8 

One-point Flow Rate Verification every 90 days and 4 times a 
calendar year < +7.1% from transfer standard 1 and 2) 40 CFR Part 58 App A Sec. 3.4.2 

3) Method 2.2 Sec. 2.6 
Lab Activities 

Filter    

 
Visual Defect Check (unexposed) 

 
all filters 

Initial backlight inspection- no pinholes or 
imperfections. Visual inspection prior to shipping 

to analytical lab 

1, 2 and 3) 40 CFR Part 50 App B Sec. 8.2 

Collection Efficiency all filters 99 % 1, 2 and 3) 40 CFR Part 50 App B Sec. 7.1.4 
Pressure Drop Range all filters 42-54 mm Hg 1, 2 and 3) 40 CFR Part 50 App B Sec. 7.1.5 
pH all filters 6-10 1, 2 and 3) 40 CFR Part 50, App B Sec. 7.1.6 

 
Pb Content all filters pre-sampling batch 

check 

 
< 75 µg/filter 

1, 2 and 3) 40 CFR Part 50, App G Sec. 6.1.1.1 
Method 2.8 Sec. 6.2.1. More information relative to 
whether filters should be corrected for blanks. 

Calibration Reproducibility Checks Beginning, every 10 samples 
and end + 5% of value predicted by calibration curve 1, 2 and 3) 40 CFR Part 50, App G Sec. 9.3 

May be FEM dependent 
Initial Calibration Blank Before first sample < 0.001 µg/mL 1, 2 and 3) 40 CFR Part 50, App G Sec.8.8 

    

 
 
 
 
 
 
 
 
 
 



 

 

 
 
 

 
1) Criteria 

 
2) Frequency 

 
3) Acceptable Range 

 
4) Information/Action 

Reagent Blank Every analytical batch < LDL 1, 2 and 3) Recommendation 
Daily Calibration Daily (on day of analysis) until good agreement is obtained among replicates 1, 2 and 3) Method 2.8 Sec. 2.8.5 

OPERATIONAL EVALUATIONS TABLE Pb in TSP Local Conditions 
Field Activities 

Verification/Calibration    

System Leak Check During precalibration check Visual and Auditory inspection with faceplate 
blocked 

1, 2 and 3) Recommendation 

 
FR Multi-point 
Verification/Calibration 

After receipt, after motor 
maintenance or failure of 1- 

point check and 
every 365 days and once a 

calendar year 

 
5 points over range of 1.1 to 1.7 m3/min 

<+ 5.1% limits of linearity 

1, 2 and 3) Method 2.2 Sec. 2.6 

Precision    

 
Collocated Samples 

15% of each method code in 
PQAO 

Frequency - every 12 days 

CV < 20.1% of samples > 0.02 µg/m3 (cutoff 
value) 

1 and 2) 40 CFR Part 58 App A Sec. 3.3.4.3 
3) Recommendation for early evaluation of DQOs 

Semi Annual Flow Rate Audit every 180 days and twice a 
calendar year < + 7.1% of audit standard 1 and 2) 40 CFR Part 58, App A, Sec. 3.4.3 

3) Method 2.2 Table 8.2 
Monitor Maintenance    

Inlet cleaning every 90 days and 4 times a 
calendar year cleaned 1, 2 and 3) Recommendation 

Motor/housing gaskets ~400 hours Inspected replaced 1, 2 and 3) Method 2.2 Sec. 7 
Blower motor brushes 400-500 Replace 1, 2 and 3) Method 2.2 Sec. 7 
Manufacturer-Recommended 
Maintenance per manufacturers’ SOP per manufacturers’ SOP NA 

Lab Activities 
Analysis Audits 6 strips/quarter 

3 at each concentration range <10.1% (percent difference) 1 and 2) 40 CFR Part 58, App A, Sec. 3.4.6 
3) Recommendation 

Field Filter Blank 1/quarter < LDL 1, 2 and 3) Recommendation 
Lab Blanks 1/ sample run < LDL 1, 2 and 3) Recommendation 
Control Standards ( 1 µg Pb/ml and 
a standard between 1-10 µg Pb/ml) 

1st, every 10 samples and last 
sample. 

Deviation of < 5.1% from value predicted by 
calibration curve 

1, 2 and 3) Method 2.8 Sec. 5.7.3 

 
 
 
 
 
 
 
 



 

 

PM10 -Pb Low Volume Filter-Based Local Conditions Validation Template 
 
1) Criteria (PM10-Pb Lo- 

Vol ) 
 

2) Frequency 
 

3) Acceptable Range 
 

Information /Action 
CRITICAL CRITERIA- PM10-Pb Filter Based Local Conditions 

Field Activities 
 

Sampler/Monitor 
 

NA Meets requirements listed in FRM/FEM 
designation 

1) 40 CFR Part 58 App C Sec. 2.1 
2) NA 
3) 40 CFR Part 53 & FRM/FEM method list 

 
Filter Holding Times 
Sample Recovery 

 
 

all filters 

 
 

ASAP 

1, 2 and 3) 40 CFR part 50 App B Sec. 6.3 
 

If filters are used for more than one purpose (i.e.,Pb 
and PM10) the sample recovery is dictated by the 
most stringent requirement. 

 
Filter Holding Times 
Pre-sampling 

 
 

all filters 

 
 

< 30 days before sampling 

1, 2 and 3) 40 CFR Part 50, App. L Sec. 8.3.5 
 

Required only if filters will be used for PM10c 
mass as well as Pb. If only used for Pb then 30 day 
pre-sampling holding time not required 

 
Sampling Period (including 
multiple power failures) 

 
 

all filters 

 
1440 minutes + 60 minutes 

midnight to midnight local standard time 

1, 2 and 3) 40 CFR Part 50 App B Sec. 8.15 
 

If filters are used for more than one purpose (i.e.,Pb 
and PM10) the sample recovery is dictated by the 
most stringent requirement. 

Sampling Instrument    

Average Flow Rate every 24 hours of op average within 5% of 16.67 liters/minute 1, 2 and 3) 40 CFR Part 50 App L Sec. 7.4.3.1 

Variability in Flow Rate every 24 hours of op CV < 2% 1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.3.2 

 
One-point Flow Rate Verification 

 
every 30 days 

 
< + 4.1% of transfer standard 

< + 5.1% of flow rate design value 

1) 40 CFR Part 50, App. L, Sec. 9.2.5, 40 CFR Part 
58, Appendix A Sec. 3.4.1 
2) Recommendation 
3) 40 CFR Part 50, App. L, Sec. 9.2.5 

Design Flow Rate Adjustment After multi-point calibration or 
verification < + 2.1% of design flow rate 1, 2 and 3) 40 CFR Part 50, App. L, Sec. 9.2.6 

 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

1) Criteria (PM10-Pb Lo- 
Vol ) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

Individual Flow Rates every 24 hours of op no flow rate excursions > +5% for > 5 min. 1/ 1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.3.1 

Filter Temp Sensor every 24 hours of op 
no excursions of > 5o C lasting longer than 30 min 

1/ 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 7.4.11.4 

 
External Leak Check 

Before each flow rate 
verification/calibration and 

before and after PM2.5 separator 
maintenance 

 
< 80.1 mL/min (see comment #1) 

1) 40 CFR Part 50 App L, Sec. 7.4.6.1 
2) 40 CFR Part 50 App L Sec. 9.2.3 and Method 2- 
12 Sec. 7.4.3 
3) 40 CFR Part 50, App. L, Sec. 7.4.6.1 

 
Internal Leak Check 

 
If failure of external leak check 

 
< 80.1 mL/min 

1) 40 CFR Part 50, App. L, Sec. 7.4.6.2 
2) Method 2-12 7.4.4 
3) 40 CFR Part 50, App. L, Sec. 7.4.6.2 

Laboratory Activities (XRF Analysis) 
    

Filter Visual Defect Check 
(unexposed) all filters Correct type & size and for pinholes, particles or 

imperfections 
1, 2 and 3) 40 CFR Part 50, App. L Sec. 10.2 

Pb blank filter Acceptance Testing ~ 20 test filters per lot 90% of filters < 4.8 ng Pb/cm2 1, 2 and 3) 40 CFR Part 50 App Q Sec. 6.1.2 
OPERATIONAL EVALUATIONS TABLE- PM10-Pb Filter Based Local Conditions 

Field Activities 
Routine Verifications   

 
One-point Temp Verification 

 
every 30 days 

 
<+ 2.1oC 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2) Method 2.12 Table 6-1 
3) Recommendation 

 
Pressure Verification 

 
every 30 days 

 
<+ 10.1 mm Hg 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2) Method 2.12 Table 6-1 
3) Recommendation 

Annual Multi-point Verifications/Calibrations   

Temperature multi-point 
Verification/Calibration 

on installation, then every 365 
days and once a calendar year <+ 2.1oC 1) 40 CFR Part 50, App. L, Sec. 9.3 

2 and 3) Method 2.12 Sec. 6.4 
 
 

Pressure Verification/Calibration 

 
on installation, then every 365 
days and once a calendar year 

 

<+ 10.1 mm Hg 

1) 40 CFR Part 50, App. L, Sec. 9.3 
2 and 3) Method 2.12 Sec. 6.5 
Sampler BP verified against independent standard 
verified against a lab primary standard that is 
certified as NIST traceable 1/year 

 
Flow Rate Multi-point Verification/ 
Calibration 

Electromechanical 
maintenance or transport or 

every 365 days and once a 
calendar year 

 
<+ 2.1% of transfer standard 

1) 40 CFR Part 50, App. L, Sec. 9.2. 
2) 40 CFR Part 50, App. L, Sec. 9.1.3, Method 2.12 
Sec. 6.3 and Table 6-1 
3) Recommendation 

Other Monitor Calibrations per manufacturers’ op manual per manufacturers’ operating manual 1, 2 and 3) Recommendation 
Precision    

 
 
 
 



 

 

 
 

1) Criteria (PM10-Pb Lo- 
Vol ) 

 
2) Frequency 

 
3) Acceptable Range 

 
Information /Action 

 
Collocated Samples 

15% of each method code in 
PQAO 

Frequency - every 12 days 
CV < 20.1% of samples > 0.02 µg/m3 (cutoff value) 

1 and 2) 40 CFR Part 58 App A Sec. 3.4.4 
3) Recommendation for early evaluation of DQOs 

Accuracy    

Temperature Audit every 365 days and once a 
calendar year <+ 2.1oC 1, 2 and 3) Method 2.12 Sec. 11.2.2 

Pressure Audit every 365 days and once a 
calendar year <+10.1 mm Hg 1, 2 and 3) Method 2.12 Sec. 11.2.3 

Semi Annual Flow Rate Audit Twice a calendar year and 5-7 
months apart 

<+ 4.1% of audit standard 
<+ 5.1% of design flow rate 

1 and 2) 40 CFR Part 58 App A, Sec. 3.4.3 
3) Method 2.12 Sec. 11.2.1 

Monitor Maintenance    

Impactor (WINs) every 5 sampling events cleaned/changed 1, 2, and 3) Method 2.12 Sec. 8.2.2 

Very Sharp Cut Cyclone every 30 days cleaned/changed 1, 2 and 3) Method 2.12 Sec.8.3.3 
Inlet Cleaning every 30 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.3 
Downtube Cleaning every 90 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.4 
Filter Chamber Cleaning every 30 days cleaned 1, 2 and 3) Method 2.12 Sec. 8.3 
Circulating Fan Filter Cleaning every 30 days cleaned/changed 1, 2 and 3) Method 2.12 Sec. 8.3 
Manufacturer-Recommended 
Maintenance per manufacturers’ SOP per manufacturers’ SOP  

Laboratory Activities (XRF Analysis) 
Analysis Audits 6 filters/quarter 

3 at each concentration range <10.1% (percent difference) 1 and 2) 40 CFR Part 58, App A, Sec. 3.4.6 
3) Recommendation 

Field Filter Blank 1/quarter < 0.01 µg/m3 
1) 40 CFR Part 50 App Q Sec. 6.1.2.1 
2 and 3) Recommendation 

Lab Filter Blank 1/ sample run <.003 µg/m3 
1 40 CFR part 50 App Q Sec. 6.1.2.1 
2 and 3) Recommendation 

Thin Film Standards (standard 
reference materials) Beginning and end of each 

analytical run 

XRF conc. + 3x the 1 sigma uncertainty overlaps 
the NIST certified conc. + 1x its reported 

uncertainty. 

1) 40 CFR Part 50 App Q Sec. 6.2.3 
2 and 3) recommendation 

Run time quality control standards 
 
Checking peak areas, background 
areas, centroid and FWHM 

 
Beginning and end of each 

analytical run 

 
Target value 3 SD 

1, 2,and 3) Recommendation 
 

Target values and SD of QC samples established 
prior to analysis. 

 
XRF analyzer calibration 

Every 365 days and 1/ 
calendar year or when 

significant repairs or changes 
occur or QC limits exceeded 

XRF conc. + 3x the 1 sigma uncertainty overlaps 
the NIST certified conc. + 1x its reported 

uncertainty. 

1 and 2) 40 CFR Part 50 App Q Sec. 6.2.4 
3) Recommendation 

Background Measurement and 
Correction 

20 clean blank filters 
for each filter lot used NA 1 and 2) 40 CFR Part 50 App Q Sec. 6.2.4.2 



 

 

3rd Levels – Common Mistakes to Check For 
 

• If calibrations are poor verify that there’s a note in the data validation log explaining why data 
were or were not invalidated based on calibration results. 

• Verify that the data validation log has enough detail documenting issues.  Don’t just state that 
there was an issue, say why.  Spell out your thought process behind invalidating data. 

• Verify that times when it appears that the site operator was on site but it wasn’t recorded in the 
station logs are annotated with “site visit?”. 

• Check that if a calibration was performed on a parameter during a SAM (such as winds) the 
parameter is invalidated during the appropriate hours even if it’s not flagged. 

• Check that codes are consistent from 1 month to the next (e.g nightly cals). 
• Check that if a gaseous parameter was invalidated due to the minute trace the minute trace is 

printed and in the misc. folder. 
• Check that all gases are above the minimum threshold and solar data are >= zero. 
• Review power failure logs not just power failure flags to determine which hours to code with PF. 
• Verify that the correct codes were used for an audit versus a regular site visit. 
• Don’t ignore comments in the station logs – thoroughly investigate and document.  When done 

put a note in the data validation log as to what you discovered. 
• Erase marks for level 0 review. 
• Check station temperature limits and verify that all gaseous analyzer are operating within 

approved limits. 
• Check validation codes to make sure they match the stackplot annotions. 
• Make sure any calibration data that are -999 are invalidated in the calibration table in the 

AQDBMS. 
 

*Data validation note – If you find a problem when working on a preliminary or 3rd level validation 
that would not be noticeable during daily stackplot review, check to see if the problem is still 
occurring and if so open a problem report. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Calibration Shapes 
Multipoint Calibration (CA) 
 

 
 
 
 
 



 

 

Span/Zero and Precision (ZS and PC) 
 

 
 
 
 
 
 
 
 



 

 

Precision/Span/Zero (SC) 
 

 
 
 
 
 
 
 
 
 
 



 

 

Items to Check for Evidence of Moisture in a BAM 
 

• Erratic readings or unusual spikes 
• High RH or precip 
• High winds 
• Photos showing blowing snow or whiteout conditions 
• Water in the inlet jar 
• Increase or fluctuations in the BAM RH 
• Error codes, especially any that are RH related 
• Pictures of the inlet with snow or water in it 
• Pictures of the BAM tape showing moisture damage 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Minute Trace Drop 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Noise Example 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Notes on NO, NOx, NO2 Data Validation 

 
1. The instrument is only capable of measuring NO.  NOx is determined by converting any ambient 

NO2 to NO.  This converted NO is then combined with the original NO and measured as NOx.  
NO2 is a calculation (NO2 = NOx – NO.)  The instrument assumes anything it measures besides 
NO is NO2.  

 
2. If NO is invalidated for any reason, NOx and NO2 must be invalidated with the same invalidation 

code.  NOx and NO2 can be invalid but NO be valid. 
 

3. When making data adjustments to any one of these parameters (NO, NOx or NO2) the relationship 
between the other parameters must be considered. 

 
Rule of thumb for NO, NOx, and NO2 data adjustments: 

• When NO and NOx calibration results are both outside of acceptable limits both 
parameters should be adjusted by the same amount.  NO2 values do not need adjustment. 

• If only one of the parameters (NO or NOx) is outside of tolerance then that parameter plus 
NO2 need to be adjusted.  

 
4. During a span calibration event the NO2 response should be zero.  The results should be NOx = 

400, NO = 400, NO2 = 0.  The NO2 output is challenged by adding ozone to an NO mixture, 
converting some of the NO to NO2.  This is known as a GPT (gas phase titration of NO with 
ozone).  NOx values should remain stable throughout a GPT.  NO and NO2 values will be inverse 
(NO will fall, NO2 will increase) as ozone is added to an NO gas dilution.  A NO2 precision check 
will result in NOx = 400, NO = 310, NO2 = 90.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Revised Min/Max Adjustments 
 

Parameter 
Max 

Value 
Max 

Adjust 
Min 

Value 
Min 

Adjust 
SWS (Climatronics) none none 0.2 none 
SWS (RM Young) none none 0 none 

VWS none none 0 none 
VWD 360 none 0 none 
SWD 360 none 0 none 

SDWD 104 none 0 none 
TMP none none none none 
DTP none none none none 
RH 100 105 0 -5 

RNF none none 0 none 
STP none none none none 
SOL none none 0 -14 

FLOW none none 0 -1 
O3CAL none none 0 -30 
WET 100 none 0 -5 
UV none none none none 
O3 none none 0 -10 

SO2 none none 0 -2 
SO2 5-minute none none 0 -2.49 

SO2 5-minute (trace 
level) none none 0 -0.249 

NO/NO2/NOX none none 0 -4 
PM (TEOM) none none -50 none 

PM10 (METONE BAM) none none -5 none 
PM2.5 (METONE BAM) none none -10 none 
PMC (METONE BAM) none none -10 none 
PM10 (TECO BAM) none none -8 none 

PM10 (TEI BAM) none none -8 none 
PM (E-Sampler) none none -10 none 

PM (E-BAM) none none -10 none 
 

  



 

 

Temperature Limits – Gas 
 

Parameter Instrument Type 

Lower 
Temperature 

Limit (°C) 

Upper 
Temperature 

Limit (°C) 

Ozone 

Dasibi 1003 20 30 
TECO 49 5 40 
Teledyne API 400E 5 40 
Monitor Labs 8810 20 30 
Meloy 0A325-2R 20 30 
McMillan 1100-1 20 30 
2B N/A N/A 

Sulfur Dioxide 

TECO 43 20 30 
Thermo 43I-TLE 20 30 
API 100EU 5 40 
Monitor Labs 8850 20 30 

Oxides of 
Nitrogen 

TECO 42, 42C 15 35 
TECO 42S 20 30 
Teledyne API Model 200A 5 40 
Teledyne API Model 200E 5 40 
Teledyne API Model 200EU 20 30 
Teledyne API T500U 5 40 

Carbon 
Monoxide 

Thermo Electron 48 or 48C 20 30 
Thermo 48I-TLE 20 30 
API 300EU 10 40 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Validation Acceptance Criteria by Project 
 

  

NPS 
WDEQ-

AQD 
Tier 1 

WDEQ-
AQD 
Tier 2 

WDEQ-
AQD 
PSD 

WDEQ-
AQD 

NCore 

Garfield 
County 

CDPHE-
APCD WARMS 

Aethon 
Energy, 

Wyoming 

Warren 
E&P 
Inc. 

Clean 
Harbors 

T/dT Temperature (deg C)  (immersible) 1.0 1.0 0.54 0.54 0.54 1.0 0.54 1.0 1.0   1.0 

T/dT Vertical Temperature (deg C)  N/A N/A 0.14 0.14 0.14 N/A 0.14 N/A 0.14     

Station Temperature (deg C)  2.0 2.0 2.0 2.0 2.0 2.0   2.0 2.0 2.0   

Barometric Pressure (mmHg)  3 2.25 2.25 2.25 2.25 2.25   2.25 2.25 2.25   

AT Temperature (deg C) (collocated) 1.0 1.0 N/A N/A N/A 1.0 0.5 1.0 N/A 1.0   

Relative Humidity (% RH)  10% 10% 10% 7% 7% 10%   10% 10% 10%   

Wind Speed (m/s)  0.25 0.25 0.25 0.20 0.25 0.25 0.2 0.25 0.25 0.25 0.25 

Wind Speed (%)  5% 5% 5% N/A 5% 5% 5% 5% 5% 5% 5% 

WS Starting Threshold* * * * * * * * * * * * 

WD Maximum Total Alignment (degrees)  5.0 5.0 5.0 5.0 5.0 5.0 5.0 5.0 5.0 5.0 5.0 

Vertical Wind Speed (m/s)  N/A N/A N/A 0.2 0.2             

UV Mean Difference (%)  N/A N/A N/A 5.0% N/A             

Rainfall (%)  10% 10% 10% 10% 10% 10% 10% 10% 10%   10.0% 

Solar Mean Difference (%)  10% 10% 10% 10% 5%   10% 10% 10%     
 

        * Wind speed starting threshold acceptance criteria is sensor dependent 
 
 
 
 
 
 
 
 
 

- continued - 
 
 
 
 
 



 

 

Validation Acceptance Criteria by Project (continued) 
 

  

Evraz 
Rocky 

Mountain 
Steel 

Sinclair 
Casper 

Refining 
Co 

Mountain 
Cement 

Colorado 
BLM- 

Paonia 

Colorado 
BLM- 
White 
River 

City of 
Aspen 

US 
Forest 
Service 

Extraction 
Oil & Gas PSD SLAMS 

T/dT Temperature (deg C)  (immersible) 0.54   1.0 1.0       0.54 0.54 1.0 

T/dT Vertical Temperature (deg C)  0.14     N/A       0.14 0.14 0.14 

Station Temperature (deg C)  2.0 2.0   2.0 2.0 2.0 2.0 2.0 2.0 2.0 

Barometric Pressure (mmHg)  2.25 2.25   2.25 3     2.25 2.25 2.25 

AT Temperature (deg C) (collocated) N/A 1.0 1.0 1.0 1.0   1.0 0.5 0.5 1.0 

Relative Humidity (% RH)  7% 10%   10% 10%   10% 7% 7% 10% 

Wind Speed (m/s)  0.20 0.25 0.25 0.25 0.25   0.25 0.20 0.20 0.25 

Wind Speed (%)  N/A 5% 5% 5% 5%   5% N/A N/A 5% 

WS Starting Threshold* * * * * * * * * * * 

WD Maximum Total Alignment (degrees)  5.0 5.0 5.0 5.0 5.0   5.0 5.0 5.0 5.0 

Vertical Wind Speed (m/s)                0.2 0.2   

UV Mean Difference (%)                  5.0%   

Rainfall (%)  10.0%     10.0% 10.0%   10.0%   10.0% 10.0% 

Solar Mean Difference (%)  5.0%     10.0% 10.0%   10.0%   5.0% 10.0% 

           * Wind speed starting threshold acceptance criteria is sensor dependent 
        

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Validation Rules by Parameter 
 

Scalar Wind Speed 
(SWS) 

Acceptable values are 0.2 m/s and higher for Climatronics, 0.0 m/s and higher for RM Young. 

Value can be equal to, but never less than VWS. 

If SWS is invalidated for any reason VWS must be invalidated with the same invalidation code.  
VWD and SDWD must also be invalidated with the same invalidation code.  If the SWS failure is 
due to a datalogger failure then all wind parameters are likely invalid. 

Vector Wind Speed 
(VWS) 

Acceptable values are 0.0 m/s and higher. 
VWS can never be greater than SWS since VWS has a directional component. 
VWS is calculated directly from VWD and SWS and cannot be invalidated by itself (unless due to a 
RF).  If invalidated it is because either SWS or VWD is invalid. 

Scalar Wind Direction 
(SWD) 

If SWD is invalidated for any reason VWS, VWD and SDWD must be invalidated with the same 
validation code. 

Vector Wind Direction 
(VWD) 

If VWD is invalidated for any reason VWS and SDWD must be invalidated with the same validation 
code (unless the site is also monitoring SWD and SWD is used to compute VWS). 

Standard Deviation of 
Wind Direction 
(SDWD) 

SDWD is not a direct measurement, it is a calculation of how much the wind drection deviates from 
the average for the hour and cannot be invalidated by itself (unless due to a RF). 

If SDWD is flagged <, but SWS and VWD are flagged >, SDWD is valid for that hour. 

If WD is invalid for any reason, SDWD must be invalidated with the same invalidation code. 

SDWD has to have only one valid minute of VWD to calculate from a Campbell datalogger. 

Temperature 
(TMP) 

If TMP is invalidated for any reason DTP must be invalidated with the same invalidation code. 

Temperature sensor is generally located at a height 10m. 

Delta Temperature 
(DTP) 

DTP is the difference between the upper and lower temperature probes (top - bottom). 
The lower temperature probe is generally located at a height 2m. 
When the 2m sensor is invalid it is possible for TMP to be valid but not DTP. 
DTP is invalid whenver either the 10m or 2m sensor is bad. 

Relative Humidity 
(RH) 

Values are accepted to a maximum of 105%.  If the value for an hour is greater than 105% that 
data point is invalidated with 'IM'.  Values between 100% and up to 105% are adjusted to 100%. 

Values are accepted to a minimum of -5%.  If the value for an hour is less than -5% that data point 
is invalidated with 'IM'.  Values between 0% and as low as -5% are adjusted to 0%. 

Solar Radiation 
(SOL) 

Night time values are accepted to within 1% of full scale of the instrument.  (In most cases full 
scale is 1396 w/m2, so values are accepted to within +/- 14 w/m2.) 

Any night time value that is outside of +/- 1% of full scale causes the entire day to be invalidated 
with 'IM'. 

Night time values between 0 and -14 (or between 0 and -1% of full scale) are adjusted to 0.  Night 
time values between 0 and 14 (or between 0 and 1% of full scale) are not adjusted. 

 
- continued - 

  



 

 

 
 

Validation Rules by Parameter (continued) 
 

Flow 
(CASTNet)(FLOW) 

Flow rates should be either 3.0 lpm or 1.5 lpm.  Flow rates lower than the expected value are left 
valid as long as the reported value is accurate. 

 

Flow values are invalidated with 'MT' when the operator is on site to the replace the filter, and the 
channel is not flagged.  If the channel is flagged, validate/invalidate based on the the flag, 
regardless of the hourly average. 

Flow  Flow values are accepted to a minimum of -1.  Values between -1 and 0 are zero adjusted.  Values 
less than -1 are invalidated. 

 

Other than the reasons listed above, data are only invalidated if there is a known instrument 
malfunction that effects the accuracy of the value reported.  Instrument malfunctions that effect the 
flow rate but do not affect the accuracy of the reported value are left as valid. 

 
If the site operator forgets to turn the pump back on after a filter replacement the data are left as 
valid and the filter analyzed for passive flow. 

 If a filter is not in place the data are coded as 'NA'. 

 An acceptable leak check is an MFC display value no more than 0.10 

Station Temperature 
(STP) 

Left valid unless there is a known instrument problem.  The 75% rule doesn't apply and therefore 
flags on this parameter are generally ignored unless they are caused by a problem that would 
provide an inaccurate hourly average. 

Station temperature is monitored only to verify that any gas analyzer on site is operating within 
manufacturer specifications. 

Ozone 
(O3) 

Values are accepted to a minimum of -10 ppb (-2% of full scale).  Any value between 0 ppb and -
10 ppb is zero adjusted.  Any value less than -10 ppb is invalidated. 

There is no maximum acceptance limit, although all high values are thoroughly investigated. 

Station temperature must be within the limits set by the manufacturer of the ozone analyzer for 
ozone to be valid. 

Ozone Calibrator 
(O3CAL) 

Left valid during all calibration events. 
< flags are ignored unless ozone is down the same hour for maintenance (not a calibration) in 
which case O3 cal is also invalidated with MT. 

Generally only invalidated during power failures or when there is a known problem with the 
instrument that is causing it to read any value other than zero when the instrument is inactive. 

Sulfur Dioxide 
(SO2) 

Values are accepted to a minimum of -2% of full scale.  Any value between 0 and -2% of full scale 
is zero adjusted.  Any value less than -2% of full scale is invalidated. 

Station temperature must be within the limits set by the manufacturer of the SO2 analyzer for SO2 
to be valid. 

Carbon Monoxide 
(CO) 

Values are accepted to a minimum of -2% of full scale.  Any value between 0 and -2% of full scale 
is zero adjusted.  Any value less than -2% of full scale is invalidated. 

Station temperature must be within the limits set by the manufacturer of the CO analyzer for CO to 
be valid. 

Particulate Matter 
(PM2.5, PM10) Negative values are accepted (to what point?) 

Nitrous Oxides 
(NO, NOX, NO2) 

Values are accepted to a minimum of -2% of full scale.  Any value between 0 and -2% of full scale 
is zero adjusted.  Any value less than -2% of full scale is invalidated. 

Station temperature must be within the limits set by the manufacturer of the NOx analyzer for NOx 
to be valid. 

If NO is invalidated for any reason NOx and NO2 must be invalidated with the same invalidation 
code. 

 



 

 

 
 

Zero-Adjust Thresholds 
 

Non-Trace Level 
   

Pollutant Analyzer 
Method 
Code 

MDL (in 
AQS) 

min. value 
allowed in 

AQS 

ARS adjust 
threshold 

(ppb) Comments 
NO TECO 42C, 42i 74 10 -10 3 

 NO2 TECO 42C, 42i 74 1 -1 3 
 NOX TECO 42C, 42i 74 10 -10 3 
 NO API 200A, 200E 99 5 -5 3 
 NO2 API 200A, 200E 99 2.7 -2.7 3 
 NOx API 200A, 200E 99 5 -5 3 
 O3 2B 901 0.0015 -0.0015 

 
I'm assuming these units are ppm 

O3 TECO 49, 49C, 49i 47 0.005 -0.005 3 I'm assuming these units are ppm 
O3 API 400/400A/400E 87 0.005 -0.005 3 I'm assuming these units are ppm 
SO2 TECO 43C 9 2 -2 2 

 SO2 API T100 100 0.4 -2 2 
 SO2 API 100 100 0.4 -2 2 
 CO API 300E 93 0.5 -0.5 0.5 ppm 
 CO TECO 48 54 0.5 -0.5 0.5 ppm 
 

NMHC Baseline-MOCON 11 1 -1 
 

These units are ppb, which makes 
our cut-off -0.001 

CH4 Baseline-MOCON 11 0.1 -0.1 
 

-0.0001 ppm 
THC Baseline-MOCON 11 200 -200 

 
-0.2 ppm 

       Trace Level 
    

Pollutant Analyzer 
Method 
Code 

MDL (in 
AQS) 

min. value 
allowed in 

AQS 
  NO 200EU 599 0.05 -0.2 
  NO2 200EU 599 0.05 -0.2 
  NOx 200EU 599 0.05 -0.2 
  NO TECO 42i TLE 674 0.05 -0.05 
  NO2 TECO 42i TLE 674 0.05 -0.05 
  NOy TECO 42i TLE 674 0.05 -0.05 
  NO API 200EU 699 0.05 -0.2 
  NO2 API 200EU 699 0.05 -0.05 
  NOy API 200EU 699 0.05 -0.05 
  NO2 API T500U 212 0.04 -0.04 
  SO2 API 100EU 600 0.2 -0.2 
  SO2 TECO 43i TLE 560 0.2 -0.2 
  CO API 300EU 593 0.02 -0.02 
  CO Thermo 48i TLE 554 0.04 -0.4 
   

 
 



 

 

Procedures for Zero Corrections of Data from non-Trace Analyzers 
 

• Review the baseline and zero checks for the month. If the zero checks and the baseline show a 
similar offset, and when these values are outside of the range described below, the data should be 
adjusted using an average of the zero response for the month. 

o NO/NOx zero/baseline acceptable range -3 to +3 ppb 
o SO2 zero/baseline acceptable range -2 to +2 ppb 
o O3 zero/baseline acceptable range -3 to +3 ppb 
o CO zero/baseline acceptable range -0.5 to +0.5 ppm 

• If the zero response and the baseline are within these limits, but the precisions are outside of 
limits and would be within if a zero correction were applied, then apply the zero correction to 
both the ambient data and the precision result. 

• When applying a correction, use whole numbers only (or 1 tenth of a decimal place for CO only). 
•  When done applying the zero correction, sort the validated values to look for values below the 

negative cut-off (see N:\Project\imc\validation training\zero adjust thresholds2.xlsx). If there are 
values below the negative cut-off, review on the monthly data grid to see if these values are 
grouped around similar times. If so, review the zeros again. Was there an outlier around this time 
that should be excluded? If so, eliminate and apply a zero correction using the next closest zero to 
the period of time being adjusted. 

• Sort validated values again to look for values below the negative threshold. If some still exist, 
these data points should be invalidated. 

• Any time data are zero corrected, the analyzer response during the precision needs to be adjusted 
by the same amount. 

• If the zero adjust you are trying to apply is more complicated than described here, please consult 
with Jessica before spending a lot of time on a zero adjust. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Procedures for Zero Corrections of Data from Trace Analyzers 
 

• Review the minimum values recorded for the month. If the ambient data are less than -5x MDL 
(see N:\Project\imc\validation training\zero adjust thresholds2.xlsx) on a non-persistent basis, the 
data should be invalidated. For example, if a Teledyne-API T200U NOx analyzer reports a NOx 
value of -0.40, the data point should be invalidated because the MDL is 0.05 and -5x MDL is -
0.25. 

• If the ambient data are less than the –MDL but greater than -5x MDL on a non-persistent basis, 
the data should be adjusted (VZ’d) to the –MDL. (e.g. if the same analyzer reports -0.15, then it 
should be adjusted to -0.05 since -0.15 is within -0.25) 

• If data are persistently below the –MDL, this is an indication that there is a baseline offset that 
should be corrected for. Nightly zeros should be reviewed to determine if a correction based on 
these can be applied. These should only be used if consistent for the month. Most likely results of 
the most recent calibration or some other method will need to be reviewed to determine an 
amount to adjust by. Please consult with Jessica and a field specialist or the project manager 
when determining the amount to adjust by. 

• When applying a correction, the amount used to adjust by should contain no more decimal 
precision than is used when reporting the parameter you are adjusting for. If it is determined the 
nightly zeros can be used for the adjustment, an average for the month should be used.  

• When done applying the initial zero correction, sort the validated values to look for values below 
the negative cut-off. If there are values below the negative cut-off, review on the monthly data 
grid to see if these values are grouped around similar times. If so, discuss with Jessica and the 
field group again to determine if a different adjustment should have been applied to this time 
period. 

• If after applying an adjustment there are still values below the –MDL, apply the procedures 
described in the first 2 bullets to determine if the values should be invalidated or adjusted to the –
MDL. 

• Any time data are zero corrected, the analyzer response during the precision needs to be adjusted 
by the same amount. 

• If the zero adjust you are trying to apply is more complicated than described here, please consult 
with Jessica before spending a lot of time on a zero adjust. 
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1.0 PURPOSE  
 
This standard operating procedure (SOP) outlines the steps of producing ambient air quality and 
meteorological data reports and data dissemination. Reporting includes preparation and distribution of the 
following report products: 

 
• Monthly data reports 
• Quarterly data reports 
• Annual data reports 
• Monthly ozone “hit list” during the summer ozone season 

 
At the direction of the client, the IMC will also report criteria pollutant, meteorological, and precision and 
accuracy data to the Environmental Protection Agency’s Air Quality System (AQS) database, and handle 
individual data requests as they are received. 
 
2.0 SUMMARY OF METHOD 
 
Reports will be generated and distributed to meet guidance and schedules as outlined in project QAPPs. A 
single report (of each selected type) will be prepared for each defined monitoring program. All reports are 
generated from data stored within ARS’ AQDB (Air Quality Database) using a customized reporting 
interface to export products as specified by the user. Most data reports are generated after the completion 
of preliminary data validation, as is shown in Figure 5-1. The user will follow the basic steps outlined in 
Section 6 of this SOP to generate the aforementioned data reports. 
 
3.0 SCOPE 
 
Activities described in this document are performed by members of ARS’ Information Management 
Center, technical assistants and database administrators/programmers. Aforementioned ARS staff 
members have been appropriately trained to perform the responsibilities associated with their roles as 
described below. 

 
4.0 ROLES AND RESPONSIBILITIES 
 
Staff positions that have data reporting responsibilities are: 
 
Information Management Section Manager 

• Oversee all reporting procedures and provide direction when required. 
• Oversee the preparation of the monthly ozone “hit list.” 
• Submit data to the Environmental Protection Agency’s (EPA) Air Quality System (AQS) 

database. 
• Perform a final review of each quarterly report prior to delivery. 
• Review final annual data reports for completeness and accuracy. 
• Verify that completed annual reports are properly distributed. 
• Maintain the required AQS codes for all sites and parameters within the monitoring network 

within the AQDBMS and in AQS. 
• Verify that all data requests are handled in a timely manner. 
• Be adequately trained in operating the EPA AQS interface and be familiar with the set of EPA-

issued AQS documentation. 
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• Be responsible for generating and submitting hourly ambient and meteorological data and 
precision and accuracy data to the EPA AQS on at least a quarterly basis. 

 
IMC Team Lead 

• Verify that preliminary and final data validation has been successfully completed for each month. 
• Oversee the preparation of the monthly data reports and forward the reports to the client. 
• Verify that data validation has been successfully completed for the reporting period for quarterly 

and annual reports. 
• Review draft and final quarterly and annual data reports for completeness and accuracy. 
• Forward completed reports to IMC section manager for review. 
• Verify that completed reports are properly distributed. 
• Oversee all annual reporting preparation and provide direction as necessary. 
• Communicate with the client regarding data requests. 
• Maintain the required AQS codes for all sites and parameters within the monitoring network 

within the AQDBMS and in AQS. 
• Be adequately trained in operating the EPA AQS interface and be familiar with the set of EPA-

issued AQS documentation. 
• Be responsible for generating and submitting hourly ambient and meteorological data and 

precision and accuracy data to the EPA AQS on at least a quarterly basis. 
 
Data Analyst/Technician 

• Prepare and forward the monthly ozone “hit list” to the client. 
• Create monthly, quarterly, and annual data reports. 
• Prepare electronic files of validated data for delivery with the quarterly and annual data reports. 
• Compile data statistics and prepare plots and graphics for quarterly and annual data reports. 
• Handle all data requests. 

 
Technical Assistant 

• Assemble and organize the information for quarterly and annual data reports. 
• Compile quarterly and annual data reports and forward to the project manager and IMC team lead 

for review. 
• Distribute quarterly and annual reports and associated data to the sponsoring agency and other 

project personnel as directed. 
 

Database Administrator/Programmer 

• The database administrator/programmer shall create custom data summaries, data listings, or 
graphics, for data requests requiring non-standard output. 
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Figure 5-1. General Data Collection, Validation and Reporting Flow Diagram  
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5.0 REQUIRED EQUIPMENT AND MATERIALS 
 
The IMC requires the following hardware and software for Level 0 validation of ambient air quality and 
meteorological data: 
 

• IMC hardware: 
— Hardware specifications for IMC servers 
— Hardware specifications for workstations 
— IMC computer support hardware: 
    -     High-quality laser printer 
 

• IMC AQDBMS software: 
— Oracle Database System 
— AQDBMS custom software: 
   -   Data validation and reporting software 

 
6.0 PROCEDURES 

 
Monthly, quarterly and annual reports are completed, when specified, in accordance with the provisions 
defined within a project QAPP. Each report is briefly described below and can be generated following the 
steps outlined in subsections 6.1 – 6.5. The generation of monthly ozone “hit lists” follows a separate 
procedure, which is outlined in Section 6.6. Examples of specific data products can be found in this 
SOP’s appendix. Handling data requests and submitting data to the EPA AQS database are discussed in 
subsequent sections. 
 
Monthly Data Reporting includes generating one data report for an entire monitoring network, or for 
individual stations within a network, as advised by the client. Data reports may contain the following 
products: 
 

• Data collection statistics by site for all parameters 
• Summary of pollutant data by site 
• Summary of selected meteorological data by site 
• Time series plots depicting all validated data for the month 

 
Quarterly Data Reporting of ambient air quality and meteorological monitoring includes a discussion of 
the background of the monitoring program and its objectives, and a discussion of the locations and 
parameters measured. One quarterly data report for each site is generated for each three-month period or 
quarter. The monitoring quarters generally follow calendar quarters, but may differ for specific projects. 
Reports generally include the following products: 

 
• Significant events (collection ≤ 90%) for each site  
• Collection statistics for all parameters  
• Stackplots of hourly averages of all monitored parameters  
• Wind roses (for each monitoring height)  
• Pollution roses for each monitored air quality parameter 
• Summary of gaseous data by site  
• Summary of particulate data by site 
• Summary of meteorological data by site  
• Summary of quality assurance/quality control documentation 
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Annual Data Reporting of ambient air quality and meteorological monitoring includes generating one 
data report for an entire network, or for individual stations within a network, as advised by the client. The 
report may include a discussion of the background of the monitoring program and its objectives, and a 
discussion of the locations and parameters measured. One annual data report for each site or network is 
generated for each year of operation. The annual reports generally follow calendar years, but may differ 
for specific projects. Reports generally include the following products: 

 
• Significant events timeline for each site (collection ≤ 90%) 
• Collection statistics for all parameters  
• Stackplots of hourly averages of all monitored parameters  
• Wind roses (for each monitoring height)  
• Pollution roses for each monitored air quality parameter 
• Summary of gaseous data by site  
• Pollutant violation summaries  
• Resource injury indices 
• Maps displaying pollutant levels at sites within a network  
• Bar charts displaying pollutant concentrations 
• Summary of particulate data by site 
• Summary of meteorological data by site 
• Summary of quality assurance/quality control documentation 

 
The Monthly Ozone “Hit List” is a list of site-specific ozone 8-hour averages > 70 ppb.  The ozone hit 
list is generated from Level 0 data at the end of every month during the ozone season, April through 
October.  
 
6.1 VERIFYING PRELIMINARY VALIDATION STATUS  
 
Before a data report can be generated, Preliminary data validation must be complete. The validation status of 
each site is tracked in the AQDBMS Data Validation Log (see Figure 6-1). 
 
The Data Validation Log is used to track the completion of each major step of the validation process. The 
master record logs the initials of the IMC staff member completing each validation step and when the step 
occurred. The Comments Table logs comments regarding data validation. Most of the output programs 
query the Data Validation Log so the correct level of validation can be applied to the output. To use the 
Data Validation Log: 

 
• Select Logs-> Data Validation Log from the AQ and Met Processing frame. 
• Select a site from the Site drop-down box. If no records for the selected site exist, a “Site not 

Found” message is displayed. Click OK. Otherwise, the most recent Master Table record and 
related comments for the selected site are displayed. 

• Select a different month and/or year from the drop-down list boxes to display previous 
month’s records for the site. 

• Records can be added as usual. 
 

 
 

 



 Standard Operating Procedure 
Information Management Center - 
Data Reporting and Dissemination 

Version:  1.1  I_IMC_RPTS_2019June_F_1.1 Page 8 of 35 
 

 
Figure 6-1.  The Data Validation Log.  

 
 
 

6.2 GENERATING REPORT PRODUCTS  
 
First, determine the specific contents needed for the report. This is dependent upon the type of report 
desired and the project for which it is being generated. Refer to the project’s QAPP for guidance on 
required report products. 
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6.2.1 STANDARD REPORT PRODUCTS 
 
The Reports interface of the AQDBMS provides a single interface for producing various types of output 
products. The initial display of the reports interface is shown in Figure 6-2.  A tab control is used to help 
the user select the specific input required for the selected product. The content of each tab updates 
dynamically to reflect the specific options available for the selected product.  
 

 
Figure 6-2. The Reports Interface. 

To use the Reports interface: 
 

• Open the reporting interface. 
• Select which database to connect to (IMC or AQDB). 
• Select a product to generate from the list displayed on the Products tab. 
• Click on each enabled tab of the tab control (right side of screen) to input the required 

information and select options specific to the selected product.  
• Click Run to run the job immediately.  
 

The tab control on the right side of the Reports interface has six tab screens. Access to each screen is 
updated when the user selects a product in the Output Products list. If the tab is disabled, its content does 
not relate to the selected product. The tab screens are discussed below: 
The Dates Tab displays one or more fields for the user to input the desired time period of data to be 
included in the output product. Usually, there are Start Date and End Date fields that require dates in 
mm/dd/yyyy format. Other products may need only a year to be entered. Figure 6-3 shows the Dates tab 
screen. 
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Figure 6-3.  The Dates Tab. 
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The Sites Tab displays a tree view of site groups as configured. Groups and/or individual sites can be 
selected to be included in the output job. Figure 6-4 shows the Sites tab screen. 
 

 
Figure 6-4.  The Sites Tab. 
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The Parameters Tab displays a list of all parameters as shown in Figure 6-5. The list can be filtered for 
only the parameters available at the selected site for the selected dates. The user can use this list to select 
which parameters to include in the report product. 
 

 
Figure 6-5.  The Parameters Tab. 
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The Options Tab displays additional options for the selected product. An example of the Options tab 
when the “Data Collection Statistics – Selected Parameters” product is selected is shown in Figure 6-6. 
Options may include the following: 
 

• Convert units to a standard reporting unit. 
• Display the date the product was generated in the footer. 
• Include a table or figure number. 
• Number of values to report. 

 

 
Figure 6-6.  The Options Tab. 
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The Destinations Tab displays options on the type of output to produce as shown in Figure 6-7. This tab 
updates dynamically depending on the product selected. Only the possible options for the selected product 
are enabled. More than one option can be selected. Destination options are: 

 
• Output to screen. This option causes the output generator to pause after each product has been 

created and display the product on the screen before going onto the next. Click the Print 
button to send the output product to the printer. Click the Continue button to close the on-
screen display. 

• Output to printer. This option sends the output directly to the currently selected printer. 
• Output to PDF file. This option uses the Adobe Portable Document File (PDF) Writer to 

create PDF files of the output. When the checkbox is selected, an input field displays 
prompting the user to enter a destination folder for the generated PDF files. 

• Output to text file. This option writes the output to ASCII text files. When the checkbox is 
selected, an input field displays prompting the user to enter a destination folder for the text 
files.  

• Output to designer. This option causes the report product to open in the designer view where 
the user then has the ability to make formatting changes such as to the margins or the width 
of a field in a table.  
 

 
Figure 6-7.  The Destinations Tab. 
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6.2.2  GENERATING REPORT MAPS (GPMP Annual Report only) 
 
Maps are generated by importing the latitude and longitude coordinates of each site from the AQDBMS 
Site Configuration Table into MapViewer mapping software. The site locations are plotted on a map of 
the United States along with their corresponding values that are being summarized on the map. 
 
6.2.3 AQDBMS GRAPHICS PRODUCTS 
 
Four programs are available to create graphical representations of AQDBMS data directly from the 
database. The AQDBMS graphics programs provide the following common features: 
 

• Execution directly from the AQDBMS or the Windows desktop 
• Single-site plot vs. submit file option to create multiple-site plots 
• Printer destination and setup selection 
• Start and end date selection 
• Monthly, quarterly, and annual plots (except One-Year and Three-Year Summary plots) 
• Plot title customization 
• Plotting scale adjustment 
• Force Final Validation footnote for historical data 
• Automatic printing option 
• Windows metafile output 

 
6.2.3.1 Description of AQDBMS Products 

 
• A Rose Plot summarizes the relationship between wind speed or a user-selected pollutant 

parameter in a standard wind rose. 
• The Three-Year Summary Plot summarizes user-selected pollutant parameters in a bar chart that 

compares the second highest 1-hour average on a monthly basis. 
• The Diurnal Plot summarizes user-selected pollutant parameters in a line graph that bins the 

values by time of day. 
• A Summary by Month Plot summarizes user-selected pollutant parameters in a bar chart that 

compares highest hourly averages, highest 9-hour averages, and monthly averages by month. 
 
These graphics products query data directly from the AQDBMS. Options unique to each of these products 
are described in the subsections following this. 
 
6.2.3.1.1 Creating Plots From the AQDBMS Graphics Programs 

 
The AQDBMS graphics programs may be run directly from a Windows desktop icon.  To create a plot: 

 
• Double-click the icon for the desired graphics product on the Windows desktop. 
• Select a site from the Select Site drop-down list box. 
• Enter the start and end dates for the period to be plotted in the Start and End boxes. 
• Click the Get Parameter List button. The program retrieves a parameter code list for the selected 

site/period. 
• Select the parameter to be plotted from the Available Parameter List drop-down list box. 
• Select applicable options. Each type of plot has one or more options that can be changed. 
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• To print the plot automatically, click the AutoPrint checkbox. 
• Click the Draw Plot button. The program retrieves and plots the data. 
• If needed, modify the default graph scaling values, then click the Redraw button. 
• Click the Print button to print the plot. 

 
6.2.3.1.2 Creating Plots for Multiple Sites from the AQDBMS Graphics Programs 

 
Plots can be created for multiple sites/parameters for the same time period. To create multiple plots in a 
single run, a submit file containing a list of the site/parameters to be plotted is created in advance. The 
sites/parameters included in a submit file will be plotted with common options. Sites with parameters that 
do not use common options – such as a scaling change – must be run in a single site mode. Create 
separate submit files for each of the graphics products. 
 
To create a submit file: 
 

• Open a new file in a text file editor such as Windows Notepad (do not use a word processor such 
as Microsoft Word). 

• On the first line of this file: 
— Type a four-character site abbreviation followed by a comma <,>. 
— Type a parameter abbreviation followed by a hyphen <-> and a comma <,>. 
— Type a Y followed by a comma <,>. 
— Type three more commas, then press <Enter>. For example, type BIBE,O3-4,Y,,,, to plot 

ozone data for Big Bend National Park. 
• Repeat the above step for each combination of site/parameter that you want to include in the 

batch of plots. 
• Select Save As from the File menu. Save the file in the folder and with the filename of your 

choice. 
 
To create plots for multiple sites: 
 

• Double-click the icon for the desired graphics product on the Windows desktop. 
• To print to pdf (or to create pdfs): 

— Under the options box, choose AutoPDF. 
— Select the desired pdf destination. 
— Enter the start and end dates for the period to be plotted in the Start and End boxes. 
— Select applicable options. Each type of plot has one or more options that can be changed. 
— To not automatically print the plots, click the AutoPrint checkbox to deselect the auto 

printing feature. 
— From the File menu, select Run a Submit File. 
— Select the submit file you previously created and saved from the File-open dialogue box and 

click OK. 
— Click Print. 

 
6.3 COMPILING DATA REPORTS 
 
Monthly Data Reports 
 

• A cover page is generated and saved as a .pdf file. 
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• Data products are exported as .pdf files from the AQDBMS. 
• The cover page and data products are merged in Adobe Acrobat to compile the final report. 

 
Quarterly Data Reports 
 

• A word document template is utilized for most quarterly reports. A Technical Assistant will 
prepare word documents by updating the reporting period and making any other necessary 
changes to the text, tables and figures associated with parameter or instrumentation changes at 
monitoring sites, or the addition/removal of sites within a monitoring network at the discretion of 
the IMC Team Lead.  

• A Data Analyst will update the word document to communicate significant events via an 
Operational Summary and check the entire document for accuracy.   

• The Technical Assistant will proofread the document for spelling, grammar and formatting issues 
and make any necessary corrections. The document will be saved as a .pdf file and all data 
products will be appended. Page numbers will be added and the data summary will be submitted 
to a Data Analyst for review. 

 
Annual Data Reports 
 

• A word document template is utilized for most annual reports. A Technical Assistant will prepare 
word documents by updating the reporting period and making any other necessary changes to the 
text, tables and figures associated with parameter or instrumentation changes at monitoring sites, 
or the addition/removal of sites within a monitoring network at the discretion of the IMC Team 
Lead.  

• A Data Analyst will update the word document to communicate significant events via an 
Operational Summary and check the entire document for accuracy.   

• The Technical Assistant will proofread the document for spelling, grammar and formatting issues 
and make any necessary corrections. The document will be saved as a .pdf file and all data 
products will be appended. Page numbers will be added and the data summary will be submitted 
to a Data Analyst for review. 

 
6.4 REVIEWING DATA REPORTS 
 
Data summary reports are reviewed by multiple IMC staff or project-related personnel. If errors are 
found, corrections are made and the affected report contents are regenerated. 
 
6.5 CORRECTING DATA REPORTS 
 
Corrections are made by regenerating products as needed until all products are correct. Products that have 
been regenerated are given to the Technical Assistant to replace in the final report. 
 
6.6 DISTRIBUTING DATA REPORTS 
 
Once the reports have been compiled, assembled, and reviewed they are ready for distribution. Copies are 
distributed as designated by sponsoring organization personnel. Copies may be hard copy or electronic 
and delivered on CD or via an upload process. An electronic copy is also maintained by the project 
manager on the ARS network. 
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Where required by the sponsoring agency, a digital copy of all validated data (and also raw data if 
requested) will be delivered in conjunction with the reports. The data will be provided electronically 
unless another media is requested by the sponsoring agency. 
 
6.7 GENERATING THE MONTHLY OZONE HIT LIST (GPMP ONLY)  
 
The monthly ozone “hit list” is a list of site-specific ozone 8-hour averages > 70 ppb. The ozone hit list is 
generated from Level 0 data at the end of every month during the ozone season, April through October. 
The monthly ozone hit list is distributed by e-mail to the client by the 5th of the month. 
 
Since the data have not yet been validated prior to delivering the report, the data analyst/technicians 
generate and review a list of high values to identify and exclude values recorded during obvious non-
ozone events such as daily zero/span calibrations.  To generate the ozone hit list, launch the IMC 
application: 
 

• From the Reports menu, select Episodes with 1-Hour Ozone Concentrations ≥ 100  ppb 
and > 124 ppb. 

-  Under the Dates tab, enter the month that just passed. 
-  Under the Sites tab, select Current IMC Sites. 
-  Under the Options tab, leave the defaults at Validation Table and Place groups/sites 
    on one report. 
-  Under the Output tab, select Output to PDF File. 

• Review the report and check that all values in exceedance are real values and not calibrations, 
instrument warm-ups, or other problem. This is determined by viewing stackplots and 
looking at O3 and O3CAL values together in the validation area of the database. If there is an 
invalid exceedance, invalidate the hour(s) in the database temporarily with a “TI” 
(Temporarily Invalid) code. 

• Run the report again. Double-check that all invalid values have been removed. 
• Repeat the above three steps with the report Episodes with 8-Hour Average Ozone 

Concentrations > 70 ppb. 
• Run the report Summer High Ozone List. Direct the output to a text file on the network. 
• Enter the values from the Summer High Ozone List report into the .csv file on the network. 

Update any changes to previous months that may have occurred since the last revision. 
• Incorporate values for client requested state-operated sites by exporting ozone data from 

AirNow. 
• E-mail the following files to the client: 

— The .csv file that lists the ozone exceedances 
— Episodes with 1-Hour Ozone Concentrations ≥ 100 ppb and > 124 ppb for current 

month 
— Episodes with 8-Hour Average Ozone Concentrations > 70 ppb for current month 

• Continue updates at the beginning of each month until all data are final through October. 
 

6.8 DATA REQUESTS 
 
Data requests are received by the client or IMC and forwarded to the data analyst/technician to fill. The 
following subsections detail the steps taken to complete data requests. 
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6.8.1 THE DATA RETRIEVAL WEB SITE 
 
Most requesters are directed to the project-specific data request Web site, where they can retrieve the data 
they need. Many data requests are filled this way. Non-standard methods, including download via FTP 
site, transmit via e-mail, or delivery via CD, are used on a case-by-case basis, depending on the nature of 
the request. 
 
6.8.2 AUTHORIZATION OF DATA REQUESTS 
 
Data requests that can be handled through the standard output interface require only that the client be 
advised. Some data requests, for example those made via the NPS ARD, have an implied authorization. 
The client must authorize each non-standard data request before processing the request. Otherwise, details 
of the data request are forwarded to the client for authorization. 
 
Some data requests can be unusually complex or require large volumes of data or non-standard output. In 
these cases, the IMC section manager must estimate the amount of time and materials needed to fill the 
request and communicate this information to the client. Doing so will allow the client to judge if filling 
the request is an appropriate use of the data analyst/technicians’ time or if the scope of the request needs 
to be negotiated with the requestor. 
 
6.8.3 GENERATING DATA FILES FOR DATA REQUESTS 
 
Data requests that are not processed through the Data Retrieval Web site are made by the data 
analyst/technician via the reporting interface following the same steps that are used to generate report 
products. See section 6.2 for detailed instructions on generating data files. 
 
6.8.4 OTHER TYPES OF DATA REQUESTS 
 
Some data requests may include requests for standard monthly or annual report tables or plots. Standard 
output can be generated by the reporting interface application at any time. Data requests may also include 
requests for custom data summaries or lists meeting certain criteria or graphics. In these cases, the data 
analyst/technicians work with the database administrator/programmer to generate the necessary output.  
 
6.8.5 DELIVERING DATA REQUESTS 
 
Data requests are delivered in one of the following ways depending on the volume of data and/or how the 
recipients want to receive the data: 
 

• Downloaded by the recipient from the ARS FTP site. 
• Transmitted via an e-mail attachment. 
• Written to CD-ROM and mailed. 

 
If the data files are to be downloaded from the ARS FTP site: 
 

• The files are uploaded to the site. 
• An-e-mail message is sent, which includes instructions for downloading the files. 
• The files are removed from the FTP site after it is confirmed that the recipient has successfully 

retrieved them. 
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If the data files are transmitted via an e-mail attachment: 
 

• The data file(s) are attached to the e-mail message and the message is sent. 
 

If data files are written to CD:  
 

• The data analyst/technician copies the files to the appropriate media and labels each piece as to its 
contents. 

• The data analyst/technician prepares a cover letter and the package is sent first class mail unless 
directed otherwise by the client.   

 
6.9 SUBMITTING DATA TO THE EPA AQS DATABASE 
 
6.9.1 COMMUNICATIONS REQUIREMENTS 
 
Submitting data to AQS requires connecting directly to AQS by accessing the Internet using DSL, cable, 
T1, or other high-speed connection. 
 
6.9.2 EPA AQS TRAINING AND DOCUMENTATION 
 
The EPA provides regularly scheduled training sessions on the EPA AQS.  The IMC manager and/or 
IMC Team Lead will attend training sessions as needed to keep skills and knowledge current. In addition, 
the IMC holds a complete set of EPA issued documentation on AQS. The IMC manager and/or IMC 
Team Lead is familiar with and will use this documentation as a supplement to this SOP and when 
working within AQS. 
 
6.9.3 METHODS 
 
Hourly average ambient air quality and meteorological data at the Final validation level are submitted to 
AQS on a regular basis. Precision data from criteria pollutant analyzer precision checks and accuracy data 
from external audits of criteria pollutant analyzers are submitted as needed. 
 
The steps required to submit data to the EPA AQS database are: 
 

• Create and verify the accuracy of AQS transaction files for hourly average ambient air quality 
and meteorological data. 

• Create and verify the accuracy of AQS transaction files for precision data from criteria 
pollutant analyzer precision checks. 

• Create and verify the accuracy of AQS transaction files for accuracy data from audit reports 
on criteria pollutant analyzers. 

• Transfer the files to AQS using ENSC (Exchange Network Services Center). 
• Load data into the AQS database, successfully run the AQS statistical analysis programs, and 

post data to the AQS database (this is done automatically by the AQS system once a file is 
successfully transferred). 

 
The following subsections provide detailed steps to complete data submittal to AQS. You may also refer 
to the Air Quality System User Guide (EPA, 2006) for comprehensive instructions. 
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6.9.3.1 GENERATING AQS FILES FROM THE AQDBMS 
 
6.9.3.1.1 Hourly Average Files 
 
Hourly average ambient air quality and meteorological data must be formatted as AQS Type RD 
transactions to be submitted to AQS.  A program in the AQDBMS generates Type RD transaction files. 

 
To generate transaction Type RD AQS files: 
 

• From the reporting interface, select either AQDB or IMC from the drop-down menu 
depending on which database the desired sites reside within. 

• Under the Products tab, select Export AQS data. 
• Select the sites, parameters (defaults to select all parameters with AQS codes), and dates of 

the data set to use. 
• Under the Destination tab, select Output to text file. 
• Click on text file folder to select a path to save the file on the network and enter the desired 

file name. 
• Click the Run button. 

 
Notes: 
 

• The program looks up each selected site in the Site Configuration Table. This is where the 
AQS site code (state, county, and site number) is stored. If this information is not filled in, a 
message is displayed and that site will not be written to the AQS data file.  If the information 
is wrong, problems will occur in AQS. 

 
• If a site does not exist for the entire period that was selected, only the period where a record 

exists in the database will be written to the file (i.e., nothing will be written for the times when 
there are no records). If a record does exist, however, even if it’s coded NA, it will be written 
to the file. Likewise, if a parameter is chosen and a site does not have that monitor, then that 
parameter will be skipped. 

 
• Each parameter’s associated AQS code, method code, and POC code is defined in the 

Parameter Codes Table, under table maintenance. 
 
6.9.3.1.2 1-Point AQS Files 
 
The routine precision (1-point QC) checks conducted on criteria pollutant instruments at sites are 
submitted to AQS as QA transactions. A product in the reporting interface generates QA transaction files. 
 
To generate transaction Type QA AQS files: 
 

• From the reporting interface, select either AQDB or IMC from the drop-down menu 
depending on which database the desired site resides within. 

• Under the Products tab, select Export AQS 1-Point QC data. 
• Select the sites, parameters, and dates of the data set to use. 
• Under the Destination tab, select Output to text file. 
• Click on text file folder to select a path to save the file on the network and enter the desired 

file name. 
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• Click the Run button. 
 
6.9.3.1.3 Annual PE AQS Files 
 
Data from audits conducted on criteria pollutant analyzers at sites are submitted to AQS as QA 
transactions. A program in the AQDBMS generates QA transaction files. 
 
To generate transaction Type QA AQS files: 
 

• From the reporting interface, select either AQDB or IMC from the drop-down menu 
depending on which database the desired site resides within. 

• Under the Products tab, select Export AQS QA Annual Performance Evaluation (PE). 
• Select the sites, parameters, and dates of the data set to use. 
• Under the Destination tab, select Output to text file. 
• Click on text file folder to select a path to save the file on the network and enter the desired 

file name. 
• Click the Run button. 

 
6.9.3.2 TRANSFERRING AND POSTING DATA TO AQS VIA ENSC 
 
Once the AQS data file is generated and deemed accurate by the IMC manager or IMC Team Lead, it is 
ready to be uploaded to the AQS database. Files are transferred using the program ENSC. To transfer files:  
 

• Log in to your ENSC account on any high-speed Internet connection, using your current ID 
and password, at https://enservices.epa.gov/login.aspx. 

• Select the ‘Exchange Network Services’ tab. Make sure the ‘send information’ option is 
selected and click ‘continue’. 

• Click on ‘Browse Services Directory’ and select the ‘Send Info’ option next to ‘AQS’ in the 
service transaction column. At this point the web site will confirm the selection you have 
made. Select ‘Continue’. 

• Using the ‘Browse’ button, select the file to be uploaded to AQS and click ‘Continue’. 
• A form will display; select the appropriate screening group, file type, final processing step, 

and whether or not you’d like the processing to stop if an error occurs. Click ‘Continue’. 
• Enter your e-mail address to be notified when the file has transferred and the records have 

posted to AQS. 
• Select ‘Continue’ and then select ‘send data’. 
 

The system will send an e-mail confirming that the files have been successfully transferred to AQS. The 
AQS system automatically processes the file and posts the records. When this process is complete you 
will receive an e-mail from AQS summarizing the processing results (see Figure 6-8). If all records post 
successfully there is no need to login to AQS. 

https://enservices.epa.gov/login.aspx
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Figure 6-8.  Example E-Mail Summarizing AQS Processing Results. 
 
 
6.9.3.3 MANUALLY POSTING AND CORRECTING RECORDS IN AQS 
 
If the AQS Processing Summary e-mail shows that records failed to stage, load or post, the records will 
need to be manually processed or corrected in the AQS system. 
 
6.9.3.3.1 Loading Records into AQS 
 

• Log in to your AQS account on any high-speed Internet connection. 
• Enter your current ID and password, and aqsprod for database. 
• Logging in will automatically take you to Session. Highlight the appropriate screening group, 

press OK, and then go to the Batch menu. 
• Under the Batch Load tab, highlight the appropriate file from the list. 
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The buttons under the process control section of the batch window can be used to manually process a file 
in AQS. Under the Batch Load tab, highlight the appropriate file from the History and Status list and click 
Load File. When the file has loaded, the process status will display ‘Load Completed’. Select the Stat 
CR Report button. Again, when the process is complete the process status will indicate this by displaying 
‘Stat CR Completed’. The final step is to select the Post File button. When the records are done posting, 
the process status will show ‘Post Completed’. 

 

 
Figure 6-9.  Batch Screen in AQS.  

 
 
6.9.3.3.2 Correcting Records in AQS 
 
The number of records that load and the number of records that fail to load will display under the load 
portion of the batch window. If records fail to load the following steps should be followed to correct the 
records and to ensure that they post successfully: 
 

• Select ‘Correct’ from the main menu and then select the type of transaction record that you are 
attempting to correct. Next select the ‘execute query’ button. The query will return a list of all 
records that failed to load. (see figure) The error message at the bottom of the window will 
describe the problem with each record. Correct each record and then select the ‘save’ button. 
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• Return to the batch window and manually process the records using the process described above. 
If there are still errors, continue to make corrections until the data load completely without 
errors. 
 

Figure 6-10.  Correct Screen in AQS. 
 
 
When complete, go to the Batch Reports tab, and click on Raw Data Inventory. This will provide you 
with a report of all posted data – keep this report for future reference. This report only works for raw data 
(not precision or accuracy data). 
 
 
 
7.0 REFERENCES 
 
Air Resource Specialists, Inc. (ARS), 2012, Air Quality Data Base Management System (AQDBMS) 
User’s Guide. 
 
Environmental Protection Agency (EPA), Air Quality System User Guide (Version 1.0.0,  
July 31, 2013).  
https://www.epa.gov/aqs/aqs-users-guide-0 
 
  

https://www.epa.gov/aqs/aqs-users-guide-0
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8.0 DEFINITIONS AND ACRONYMS 
 

AQDB  Air Quality Database 
AQDBMS Air Quality Database Management System 
AQS  Air Quality System 
ARS  Air Resource Specialists 
ASCII  American Standard Code for Information Interchange 
 
CD  Compact Disc 
DSL  Digital Subscriber Line 
ENSC  Exchange Network Services Center 
EPA  Environmental Protection Agency 
 
FTP  File Transfer Protocol 
GPMP  Gaseous Pollutant Monitoring Program 
IMC  Information Management Center 
NPS ARD National Park Service Air Resources Division 
 
PDF  Portable Document Format 
POC  Parameter of Occurrence 
 
QA  Quality Assurance  
QAPP  Quality Assurance Project Plan 
QC  Quality Control 
SOP  Standard Operating Procedure 
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APPENDIX 
 

Report Products 
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Example Data Collection Statistics by Site for All Parameters. 
 
 

 
 

Example Summary of Ozone Data by Site. 
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Example Time Series Plot by Site. 
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Example Summary of Selected Meteorological Data by Site. 

 
 
 

 
 

Example Collection Statistics Summary.  
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Example Wind Rose Summary.  
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Example Meteorological Data Summary. 
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Example Pollutant Violation Summary. 
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Example Map of Pollutant Levels at Network Sites. 
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Example Ozone Hit List. 
 

Park Code Unit Site Apr May June July Aug. Sept. Oct. Total Max 8-hr 4th highest 8-hr
CACO Cape Cod State Site 0 0 4 1 0 0 0 5 88 77
CANY Canyonlands Island in the Sky 0 1 1 0 0 0 0 2 79 72
CAVE Carlsbad Caverns Maintenance Area 0 0 0 0 1 0 0 1 76 72
CHIR Chiricahua Entrance Station 0 1 0 0 0 0 0 1 76 74
COWP Cowpens National Battlefield 0 0 0 1 0 0 0 1 77 66
CUGA Cumberland Gap Hensley Settlement 0 0 2 0 0 0 0 2 80 74
DEVA Death Valley Park Village 0 0 1 0 0 0 0 1 77 73
DETO Devil's Tower Joyner Ridge Trail 0 0 0 3 1 0 0 4 80 77
DINO Dinosaur West Entrance Housing 0 0 2 0 2 0 0 4 84 76
GRCA Grand Canyon The Abyss 0 1 1 0 0 0 0 2 80 73
GRBA Great Basin Maintenance Yard 0 3 1 0 0 0 0 4 80 76
GRSM Great Smoky Mountains Clingman's Dome 0 0 3 0 0 0 0 3 87 71
GRSM Great Smoky Mountains Cove Mountain 0 0 2 0 0 0 0 2 81 72
GRSM Great Smoky Mountains Look Rock 0 0 3 0 0 0 0 3 78 75
GRSM Great Smoky Mountains Purchase Knob 0 0 2 0 0 0 0 2 78 70
JOTR Joshua Tree Black Rock 1 18 14 7 6 1 0 48 97 95
JOTR Joshua Tree Cottonwood Canyon 0 0 3 0 0 0 1 3 82 76
JOTR Joshua Tree Pinto Wells 0 3 5 0 0 0 0 8 80 79
KIMO Kings Mountain Browns Mountain 0 0 2 0 0 0 0 2 77 72
LAVO Lassen Volcanic Manzanita Lake Fire Stn. 2 0 0 1 0 0 0 3 81 71
MOJA Mojave Kelso Mountains 0 7 6 0 0 0 0 13 83 80
MACA Mammoth Cave Houchin Meadow 0 0 5 2 3 0 0 10 90 81
PEFO Petrified Forest South Entrance 0 0 1 0 0 0 0 1 78 73
PINN Pinnacles SW of East Entrance Stn. 0 0 0 1 0 0 0 1 80 72
ROMO Rocky Mountain Long's Peak 2 4 3 4 1 0 0 14 90 79
SCBL Scott's Bluff National Monument Visitor Center 0 0 0 0 1 0 0 1 86 68
SEKI Sequoia and Kings Canyon Ash Mountain 0 11 13 20 22 14 2 82 103 95
SEKI Sequoia and Kings Canyon Lower Kaweah 0 2 9 11 15 5 0 42 90 87
SHEN Shenandoah Big Meadows 0 0 2 0 0 0 0 2 82 72
WICA Wind Cave Visitor Center 0 0 1 0 0 0 0 1 76 67
YOSE Yosemite Glacier Point 0 0 0 5 0 3 0 8 89 80
YOSE Yosemite Turtleback Dome 0 0 1 5 1 1 1 10 92 81
ZION Zion Dalton's Wash 0 2 1 0 0 0 0 3 80 75
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1.0 PURPOSE 

Instructions provided herein outline the steps performed during a routine maintenance and 
calibration visit to an ambient air monitoring station operated by Air Resource Specialists, Inc. 
(ARS).  
 

2.0 SUMMARY OF METHOD 
The primary purpose of a site visit is to assure quality data capture and minimize data loss by 
performing routine maintenance and calibration of instrumentation, complying with applicable 
quality assurance requirements, and providing site operator training and support. 
  

3.0 SCOPE 
Activities described in this document are performed by ARS field technicians or specialists 
during routinely scheduled or emergency visits to monitoring stations. ARS field staff have been 
appropriately trained in site operations and possess the required technical knowledge and abilities 
to perform the activities described below. 
 

4.0 ROLES AND RESPONSIBILITIES 

Program or Project Manager 

• Establish schedule of instrument maintenance and calibrations in accordance with the site 
or network specific QAPP 

• Review with the field specialists the requirements of maintenance, known technical 
problems, and review of recently collected data 

Fields Operations Manager 
• Coordinate site visit schedules 
• Conducts field technician/specialist training and assessments 

Field Technician or Specialist 
• Coordinate scheduled visit with client as directed by project manager or field supervisor 
• Complete all required documentation 
• Verify all transfer standards to be used are in current certification with appropriate 

documentation 
• Perform as-found verification checks 
• Perform any required instrument maintenance, repair and calibration 
• Perform as-left verification checks 
• Document all calibration results and maintenance procedures 
• Verify and update site inventory and photographic documentation 
• Complete equipment maintenance and repair records 
• Summarize visit in written trip report within 30 days 

Station Operator 
• Be available for assistance and training 
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5.0 REQUIRED EQUIPMENT AND MATERIALS 

• All forms and documents presented in Appendix A 
• Trip Report Template (MS Word) and Calibration Forms (MS Excel) 
• Transfer standards in current certification 
• Operation manuals for equipment in use 
• Spare parts as required 
• Items listed in the Site Maintenance Preparation Checklist (included in Appendix A). 

 
6.0 PROCEDURES 

 
6.1 PRE-VISIT PREPARATION 

The field specialist will contact the station operator and discuss any special arrangements that 
need to be made. The field specialist will complete the Site Maintenance Preparation Checklist 
(included in Appendix A). The field specialist will verify that all calibration standards are in 
current certification. 

  
 6.2 MAINTENANCE AND CALIBRATION VISIT PROCEDURES 

Following completion of the as-found calibration verification checks, perform any scheduled or 
required maintenance or repair to the sensors, analyzers and/or monitors. Refer to the operations 
manual for the make and model of instrument in use for more specific information. 

 
Pre-Maintenance Verification Checks 

• Upon arrival and prior to any repairs or adjustments, a complete verification of the 
instrument is performed. 

Preventative Maintenance or Repair 

• Perform routine maintenance in accordance with the project schedule or manufacturer 
recommendations. 

• Perform calibration or replacement of any instrumentation operating outside field 
acceptance criteria, as indicated by the calibration forms. 

Post-Maintenance Verification Checks 

• Following any modification to the system, a complete verification of instrument 
operation is required. 

Shelter, Tower, and Support Systems 

• Inspect integrity of monitoring shelter (internal and external) including the roof, siding, 
door, caulking, weather stripping, floor, walls, racks, etc. 

• Inspect integrity of electrical outlets, lights, grounding, and polarity. 
• Inspect heating/cooling systems for proper operations and check thermostat function. 
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• Inspect fencing around site, if applicable, to ensure livestock and/or wildlife are 
prevented from damaging equipment. 

• Clean shelter interior (empty trash, wipe down surfaces, tidy wires, etc). 
• Inspect meteorological tower, including supports, guys, hardware. 
• Correct any condition considered unsafe. 
• Verify proper operation of lightning protection system. 
• Verify proper operation of cellular or satellite communication. 
• Verify intake and exhaust manifold (if applicable) and replace intake manifold pump 

diaphragm annually. Clean and maintain as necessary. 
• Verify proper datalogger operation. 

 
6.3 SITE OPERATOR TRAINING 

Following the completion of all verification checks, maintenance, and calibration (if required), 
spend as much time as necessary with the station operator(s) to ensure that operators have a 
complete and working knowledge of their required duties.  

• Observe operator perform a complete station check and review techniques for weekly 
checklist procedures. 

• Review operator log notes, station checklists and overall station documentation. 
• Review any new procedures with the operator, or procedures for which the operator 

needs assistance or clarification. 
• Verify on-site SOPs are current. Notify the project manager and QA manager if there are 

any deficiencies or changes in instrumentation that would require updated SOPs. 
• Verify the operator has an adequate supply of all required forms and consumable supplies 
• Note any operator questions or comments. 
• Obtain site operator signature on Tailgate Form (included in Appendix A), indicating 

training was conducted. 
 
6.4 INVENTORY AND PHOTOGRAPHIC DOCUMENTATION 

Inventory 

• Verify the manufacturer, description, model number, serial number, and property number 
of all monitoring site equipment against the equipment inventory database listing for the 
site. 

• Document any inconsistencies or changes in system hardware. 

Site Documentation Photographs 

• Take photographs in each cardinal direction facing shelter. 
• Take photographs in each cardinal direction facing away from shelter. 
• Take up-close photograph of shelter. 
• Take photograph of meteorological tower(s) with instrumentation. 
• Take photograph of interior instrumentation. 
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• See Appendix B for details on required photograph documentation procedures for 
CASTNET sites. 

 

6.5 POST-VISIT PROCEDURES 

Following the site visit, the field specialist will:  

• Prepare a written report, using the current MS Word template (Trip Report 
Template…..dotx) available to all field staff, describing all activities performed during the 
visit.  

• Include the MS Excel calibration forms completed in the field. 
• Return the documentation to the QA Administrative Assistant (see Appendix A). 

 Checklist 
 Tailgate Form 
 Asset Tracking Form 
 Whiteboard sheet 

• Copy site photographs to site specific folder(s) on ARS network drives 
• Submit written report and calibration forms (within 30 days) to the QA Manager and/or 

QA Officer for review. 
• Submit any equipment removed from the site to laboratory personnel for service. 

 Include a tag on all equipment describing any suspected issues with 
sensor/analyzer, or indicated routine servicing 

 Include name of Field Specialist and where the equipment was most recently in 
operation 

 Include Project Code and Project Manager 
 Complete instrument service order form 

• Follow up with laboratory and data personnel and on any equipment issues that may 
affect data validity. 

 
8.0 DEFINITIONS AND ACRONYMS 
 

ARS  Air Resource Specialists, Inc. 
AQDB  Air Quality Database 
CFR  Code of Federal Regulations 
DAS  Data Acquisition System 
EPA  U.S. Environmental Protection Agency 
IMC  Information Management Center 
MS  Microsoft 
NIST  National Institute of Standards and Technology 
PDF  Portable Document Format 
QA  Quality Assurance 
QAPP  Quality Assurance Project Plan 
QC  Quality Control 
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SLAMS State and Local Air Monitoring Stations 
SOP  Standard Operating Procedure 
 
 
Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 
 
Calibration: adjustment of the instrument or analyzer so it operates within established 
acceptance criteria (defined in the network of project specific QAPP) 
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Appendix B 
 Instructions for CASTNET Monitor Stations Photo Documentation 

Verify that there is sufficient memory available on the memory card for recording the site photographs – nominally 300 
MB, which will allow for extra photo documentation of site problems, if any. 
 
1) Take photographs during daylight hours. Do not take photos during precipitation events (rain, snow, fog, etc.). 
2) Remove site ID card from the calibration folder, place it between the top of the door and the door jam, and close 

door, so that the ID card is held in place at the top of the door. 
3) Set up and level the camera/tripod assembly at a position 8-10 meters directly in front of the shelter door.  Take 

photograph number 1 (see Table 1 Photo Documentation Work Sheet) facing the door. Make sure the site ID card 
is visible. Move closer if it is not legible from that distance. Be sure to fill out the worksheet. 

4) For the remaining photographs, do not focus the camera on the white monitoring shelter as this will cause a 
“bleaching” of other areas of the photograph.   

5) IMPORTANT: Set up and LEVEL the camera/tripod assembly at a position 25 - 40 meters south (180° from the 
shelter pointed at 0° (north).  Prior to taking the photographs, verify that all vehicles (including yours) will not be 
in the frame.  If it is not possible to take the directional photographs directly south of the shelter (obstructions, 
landscape, would result in non-representative pictures, etc) indicate in the comments of the Photo Documentation 
Worksheet and also on the site sketch the location where the pictures were taken. (e.g. 35 meters North East of 
shelter).  In all cases begin directional photographs facing 0° (north).  Take photograph number 2 (see Table 1), 
then advancing in 22.5° increments, swivel the camera clockwise taking photographs 3 through 17.   

6) Photo 18: should be taken while you are standing behind the shelter, on the same radial used to photograph the 
shelter.  This photograph will provide coverage of the area obscured by the shelter in the series of directional 
photographs.  

7) Photo 19: Shelter. 
8) Photo 20: Flow tower.  Pictures should be taken with the camera turned to vertical format, so as to include the full 

vertical length of the tower.  If a meteorological tower is present, include both towers in the frame.  If the towers 
are too far separated for this to be practical, include a photograph of the meteorological tower in frames A-Z. 

9) Photos 21 - 27: Inside the shelter and exterior of shelter door.  Include the entire area stated. These pictures are 
used frequently for troubleshooting.  

10) Photo 28: Include a picture of the site operator (and backup operator) if possible.   
11) A - Z: Within reason, take as many photographs as may be necessary to document site or equipment-related 

problems.  These pictures are not submitted to EPA, but are critical for future troubleshooting to verify pneumatic 
connections, wiring, placement, etc. and as such, should be as detailed as possible to convey this information.  

12) Photo 29: Scenic photo of the general area.  Additional scenic photographs can be recorded in frames A-Z.  These 
photos are frequently used in reports.  Please include the shelter, towers that are not leaning and omit vehicles and 
people. 

13) Photo 30: Site ID card: again to show the end of the series of photographs  
 
It is extremely important that the photos be taken in the order listed.  On completion of the photo documentation 
procedures, review the frames on the camera viewer to verify that each photograph is clear, representative of site 
conditions, and in accordance with Table 1.  
 
Before leaving the site, use Figure 1 to produce a reasonably accurate plan drawing of the CASTNET site out to 
approximately 50 yards radius.  This drawing will be useful in correlating photographs with site layout. See Figure 2 
(Sample Site Plan Field Sketch) for an example. 
 
Copy the photographs to your PC as backup, and confirm that there is sufficient memory available on the camera memory 
card to conduct photo documentation of the next site. 
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Table 1: Photo Documentation Worksheet 
Site Name and Number: Calibrator:  Date: 

Photo 
Taken? 

check for 
Yes 

Frame 

Number Direction Azimuth Comments  
 1 Site ID Card    
 2 North 0°   
 3 North Northeast 22°  
 4 Northeast 45°  
 5 East Northeast 67°  
 6 East 90°  
 7 East Southeast 112°  
 8 Southeast 135°  
 9 South Southeast 157°  
 10 South 180°  
 11 South Southwest 202°  
 12 Southwest 225°  
 13 West Southwest 247°  
 14 West 270°  
 15 West Northwest 292°  
 16 Northwest 315°  
 17 North Northwest 337°  
 18 View behind shelter  
 19 Shelter   
 20 Towers (incl. met if applicable)   

Inside Shelter 
 21 Left   
 22 Center   
 23 Right   
 24 Ceiling   
 25 Floor   
 26 Door inside   
 27 Door outside   
 28 Site Operator   

Photos of any equipment or conditions you feel should be brought to the attention of AMEC. 
 A Compressor & canisters  
 B Back of O3 analyzer  
 C Back of O3 transfer  
 D Pothead (O3 & filter pack inlets)  
 E Backplane w/ MFC and Logger  
 F NADP AMoN bucket  
 G NADP raingage  
 H NADP precip collector  
 I   
 J   
 K   
 L   
 M   
 N   
 O   
 29 Scenic View of Site  
 30 Site ID Card (again)  
    
    



Instructions CASTNET Monitor Stations Photo Documentation 

 
 
 

 1. CASTNET Site Plan Drawing – Field Sketch (use the air sampling tower as the mid-point of the sketch) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Air Sampling (Filter Pack) Tower  
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Instructions CASTNET Monitor Stations Photo Documentation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Air Sampling (Filter Pack) Tower  

Photos 2-17 (Directionals for Panorama) 
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Access Road (Gravel)

Pine Trees
Approx. 20 feet high

Oak Trees
Approx. 50 feet high
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Open Pasture

Bean Field

Low Scrub
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Approx. 20 feet high

Oak Trees
Approx. 50 feet high

Shed

Fence Line

Open Pasture

Bean Field

Low Scrub

           Figure 2.   SAMPLE CASTNET Site Plan Drawing – Field Sketch (air sampling tower is the mid-point of the sketch). 
 



Instructions CASTNET Monitor Stations Photo Documentation 
These photos are stitched together to form a panorama and published to an EPA website.  Please take them carefully!  Make sure all directions will 
be appropriate before beginning.  Horizon and tower must be level, no vehicles or people in photos.  Avoid trees/obstacles near camera position as 
these can distort significantly.  Panorama should show siting as much as possible – lower edge should be just below shelter and upper edge should 
include the filter pack inlet and nearby obstructions.  It may be necessary to position camera further from shelter (40-50m) and/or adjust height.  
Mark on the site sketch where the directional photos were taken.  Take photos near noon if possible to avoid excessive shadows and glare. 
 
STK138 – Level, but too low and too close 

  
 
STK138 – Un-level 

 
 
DCP114 – Too Low 

 
 
COW137 – Bad 

 
 



Instructions CASTNET Monitor Stations Photo Documentation 
QAK172 – Clipping from levelling 

 
 
KNZ184 – Good, remember to move vehicles 

 
 
CKT136 – Good, further from the shelter would be better 

 
 
CHE185 – Good, further from the shelter would be better, remember to move vehicles  

 
 



Standard Operating Procedure 
for Siting an Ambient Air Quality Monitoring Station 

Version:  1 F_SITING_AQSITE_F_1.0 Page 1 of 10 

Approvals 

The purpose of this review and approval is to evaluate this Standard Operating Procedure (SOP) for 
adequacy prior to issuance.  The signatories below are stating that the approach defined within this 
document is acceptable and that the affected company interests have been represented. 

Author Signature: 

Program: QA Manager – Emily Vanden Hoek 

Approval Signature: 

Program: Field Operations Manager – Mark Tigges 



 

Standard Operating Procedure 
for Siting an Ambient Air Quality Monitoring Station 

 
Version:  1 F_SITING_AQSITE_F_1.0 Page 2 of 10 
 

 
 REVISION HISTORY 

 

Review date: Changes made: Changes made by: 

10/24/2016 Initial Version 1.0 E. Vanden Hoek 

10/29/2019 Removed date reference from file name E. Vanden Hoek 

   

   

   

   

   

 
  



 

Standard Operating Procedure 
for Siting an Ambient Air Quality Monitoring Station 

 
Version:  1 F_SITING_AQSITE_F_1.0 Page 3 of 10 
 

ANNUAL REVIEW 

 
The undersigned attests that this standard operating procedure has undergone annual review for adherence to current 
practices and the latest QA/QC protocols: 

 

 

QA Manager 10/29/2019 

Signature Title Date 

   

Signature Title Date 

   

Signature Title Date 

   

Signature Title Date 

 
  



 

Standard Operating Procedure 
for Siting an Ambient Air Quality Monitoring Station 

 
Version:  1 F_SITING_AQSITE_F_1.0 Page 4 of 10 
 
1.0 PURPOSE 

Instructions provided herein outline the site selection criteria required for ambient air monitoring 
stations operated by Air Resource Specialists, Inc. (ARS).  
 

2.0 SUMMARY OF METHOD 
Proper siting of a monitoring station can help ensure that collected on-site data are valid.  The 
objective is to characterize the ambient air in proximity to the monitoring location. 
  

3.0 SCOPE 
Activities described in this document are performed by ARS field technicians or specialists 
during the site selection process. ARS field staff have been appropriately trained in site 
operations and possess the required technical knowledge and abilities to perform the activities 
described below. 
 

4.0 ROLES AND RESPONSIBILITIES 

Program or Project Manager 

• As required, review the selected site with the project-specific Contracting Officer’s 
Technical Representative (COTR) 

• Prepare project-specific siting and operational objectives, guidelines, and considerations. 
Fields Operations Manager 

• Review with the field specialist photographic documentation, maps, and other 
information to determine the suitability of the site. 

• Select the site based on the criteria outlined in this SOP and in accordance with the 
monitoring objectives outlines in the project or network specific QAPP. 

Field Technician or Specialist 
• Initiate the search for potential site by sending pertinent siting criteria and associated 

materials to a local contact (if available). 
• Conduct a siting visit if required. 
• Contact the local power and telephone companies for information concerning availability 

and installation. 
• Obtain permission to perform any site preparation that may be required. 
• Obtain permission from private or public landowners for permanent access to the 

monitoring location. 
• Obtain permits or Environmental Impact Statements if required. 
• Work with the local contact or sponsoring agency to identify a site operator, and local 

primary contact to service the equipment. 
• Forward all site selection information to the Information Management Center (IMC) for 

input into the Air Quality Database Management System (AQDB). 
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Local Site Contact 
• Locate and document potential sites upon receiving the siting criteria and associated 

materials from the field specialist. 
• Provide the field specialist with any pertinent site-related information. 
• Assist the field specialist in obtaining any site access and/or installation related 

clearances or permissions. 

5.0 REQUIRED EQUIPMENT AND MATERIALS 

• Topographic or Google Earth maps of the area of interest. 
• Camera or Smart Phone to photograph the proposed site and area 
• A list of monitoring objectives, requirements, and associated air quality monitoring 

equipment. 
• A list of local sources affecting the air in the area of interest. 
• Information about the availability of power and communications. 
• New Site/Site Relocation Form (included in Appendix A). 

 
6.0 PROCEDURES 

 
6.1 GENERAL SITE CRITERIA 

General site criteria to consider when location potential ambient air monitoring sites are: 

• The site is representative of the air mass to be monitored. 
• The site is representative of regional, not local meteorological conditions. 
• The site has year-round accessibility. 
• A power supply is available nearby. 
• The site is in open space away from obstruction. 
• The site is secure from vandalism or damage due to animals. 
• The site’s proximity to a nearby town. 
• The monitoring station will be aesthetically pleasing and will blend in with the 

surrounding environment. 
• The site is at least 500 meters (1,650 feet) from heavily traveled roadways. 
• The site is at least 2 km (1.2 miles) from major highways, airports, navigable waterways, 

and railyards. 
• The site is at least 200 meters (660 feet) from large parking lots and at least 100 meters 

from small parking lots. 
• The site is at least 500 (1,650 feet) meters from intensive agriculture operations. 
• The site is at least 200 meters (660 feet) from grazing animals or range used by livestock. 
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6.2 METEOROLOGICAL SITE CRITERIA 

 Site criteria to consider for meteorological monitoring instrumentation are: 
 

• The standard exposure height of wind instruments should be 10 meters (33 feet). 
• The distance between the instrument and an obstruction should be at least 10 times the 

height of that obstruction. 
• Wind instruments should be mounted on booms at 90° to the predominant wind direction 

(for up-valley and down-valley flows). 
• The recommended vertical heights for measuring temperature difference are 2 meters (6.6 

feet) and 9 meters. 
• The site elevation is between the highest and lowest elevations within the nearest Class I 

area. 
• Aspirated shields should be used to ventilate instruments. 
• Temperature sensors should be located at a distance of at least 4 times the height of any 

obstruction. 
• Temperature sensors should be located at least 30 meters (100 feet) from large paved 

areas. 
• Heated rain gauges should be used to properly measure frozen precipitation. 
• Rain gauges should be located at 1-2 meters above ground level so the mouth is 

horizontal to the sky. 
• Wind shields should be used where significant snowfall occurs. 
• Pyranometers (measuring incoming solar radiation) should be located where no shadows 

are cast. 
• Pyranometers should have an unrestricted view of the sky from all directions in all 

seasons at 1-2  meters above ground level. 
• Barometric pressure sensors should be located at 2 meters above ground level. 
• Wetness sensors should be located at 2 meters above ground level. 
• Approval and/or permits are obtained to clear land for site installation. 

 
6.3 GASEOUS MONITORING SITE CRITERIA 

 Monitoring site criteria to consider when locating gaseous instrumentation are detailed in the 
following subsections. 
 6.3.1 Ozone Probe Site Criteria 
 

• Vertical probe placement is 3-15 meters above ground. 
• Spacing from supporting structures is more than 1 meter. 
• Obstacle distance is at least twice the height the obstacle protrudes above the probe. 
• The probe must have unrestricted airflow. It must include the predominant wind;  270°, 

otherwise 180° if the probe is located on the side of a building. 
• Spacing between the station and roadway. 
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 Minimum Separation Distance Between Roadways and Probes or 
 Monitoring Paths for Monitoring Neighborhood and Urban Scale 

 Ozone and Nitrogen Dioxide 

Roadway average daily 
traffic, vehicles per day 

Minimum separation 

distance1 in meters 

≤ 10,000 

15,000  

20,000  

40,000  

70,000 

               ≥ 110,000 

10 

20 

30 

50 

100 

250 
  1 Distance from the edge of the nearest traffic lane. The distance 
   for intermediate traffic counts should be interpolated from the 
   table values based on the actual traffic count. 
 

• Spacing from trees should be at least 20 meters from dripline, and must be at least 10 
meters if blocking daytime wind from an urban core. 

• The probe material must be of Teflon or Pyrex glass. 
• Residence time must be less than 20 seconds. 

 
 6.3.2 Sulfur Dioxide Probe Site Criteria 
 

• Horizontal and vertical probe placement is 3-15 meters above ground and more than  1 
meter from a supporting structure.  

• Probe placement must be away from dirty, dusty areas, and if on the side of a building, 
should be on the side of the prevailing winter wind. 

• The probe should be at least 1 meter  from walls, parapets, penthouses, etc. 
• If neighborhood scale, the probe must be at a distance at least twice the height the 

obstacle protrudes above the probe. 
• The probe must have at least a 270° arc of  unrestricted airflow around vertical probes 

(180° if on the side of a building), and wind during the peak season must be included in 
the arc. 

• No furnace or incineration flues or other minor sources of SO2 should be nearby. 
• Spacing from trees should be at least 20 meters from dripline, and must be at least 10 

meters if trees act as an obstruction. 
 6.3.3 Carbon Monoxide Probe Site Criteria 
 

• Horizontal and vertical probe placement is 3 (±1½) meters above ground for microscale 
and 3-15 meters above ground for middle and neighborhood scale. 

• Spacing from obstructions is at least 270°, or 180° if the probe is located on the side of a 
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building. 
• Spacing from roads is 2-10 meters from the edge of the nearest traffic lane for 

microscale, or at least 10 meters from an intersection, preferably at midblock. See Table 
4-2 for middle and neighborhood scale. 

 
Minimum Separation Distance Between Roadways and Probes or 

Monitoring Paths for Monitoring Neighborhood Scale 
Carbon Monoxide 

Roadway average daily traffic, 
vehicles per day 

Minimum separation 

distance1 for probes or 90% of a 
monitoring path (meters) 

≤ 10,000 

15,000  

20,000  

30,000  

40,000  

50,000  

  ≤ 60,000 

10 

25 

45 

80 

115 

135 

150 
  1 Distance from the edge of the nearest traffic lane. The distance for  
   intermediate traffic counts should be interpolated from the table values 
   based on the actual traffic count. 

 
• Spacing from trees should be at least 10 meters from dripline, if tree is at least 5 meters 

above sampler and is between the probe and the road. 
 
 6.3.4 Nitrogen Dioxide Probe Site Criteria 
 

• Vertical probe placement is 3-15 meters above ground. 
• Spacing from supporting structures is more than 1 meter. 
• Obstacle distance is at least twice the height the obstacle protrudes above the probe. 
• The probe must have unrestricted airflow; 270° or 180° if the probe is located on the side 

of a building. 
• Spacing between station and roadway. 
• Spacing from trees should be at least 20 meters from dripline, if tree is above the height 

of the probe by 5 meters or more. 
• Probe material must be of Teflon or Pyrex glass. 
• Residence time must be less than 20 seconds. 
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6.4 SITE DOCUMENTATION 
The IMC maintains records of the characteristics of the sites. These records are intended to 

provide a permanent history of the following site information  
 

• Site identification 
• Site classification 
• Topographic characteristics 
• Meteorology and climatology 
• Obstructions that influence the site 
• Characteristics of the sampling probes 
• Pollutant parameter monitors 
• Site and data record histories 
• Site representativeness 
• Custody and control of data 

 
 These records will be upgraded as changes occur and will be used to document compliance with 
the Part 58 network design and siting criteria.  
 
7.0 REFERENCES 

Environmental Protection Agency, 1994, Quality Assurance Handbook for Air Pollution  
  Measurement Systems: Volume I: A Field Guide to Environmental Quality Assurance, 
 EPA-600/R-94/038a, (April 1994). 

Environmental Protection Agency, 2013, Quality Assurance Handbook for Air Pollution  
Measurement Systems: Volume II: Ambient Air Quality Monitoring Program,  EPA-454/B-13-
003 (May 2013). 
Environmental Protection Agency, 2008, Quality Assurance Handbook for Air Pollution  

  Measurement Systems: Volume IV. Meteorological Measurements (Version 2.0), 
 EPA-454/B-08-002 (March 2008). 
 

Environmental Protection Agency, 2000, Meteorological Monitoring Guidance for Regulatory 
Modeling Applications, EPA-454/R-99-005 (February 2000). 
 
Environmental Protection Agency, 2007, 40 CFR Part 58 Appendix D. 
Environmental Protection Agency, 2006, 40 CFR Part 58 Appendix E. 
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8.0 DEFINITIONS AND ACRONYMS 
 

ARS  Air Resource Specialists, Inc. 
AQDB  Air Quality Database 
CFR  Code of Federal Regulations 
DAS  Data Acquisition System 
EPA  U.S. Environmental Protection Agency 
IMC  Information Management Center 
MS  Microsoft 
NIST  National Institute of Standards and Technology 
PDF  Portable Document Format 
QA  Quality Assurance 
QAPP  Quality Assurance Project Plan 
QC  Quality Control 
SLAMS State and Local Air Monitoring Stations 
SOP  Standard Operating Procedure 
 
Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 
 
Calibration: adjustment of the instrument or analyzer so it operates within established 
acceptance criteria (defined in the network of project specific QAPP) 



 
 

 
 
 
 
 
 
 

 
APPENDIX A 

 
NEW SITE/SITE RELOCATION FORM 



Today’s Date:  Change Effective 
Date: 

 Submitted 
by: 

 

 

Site 
Name:  Site Abbrev:  AQDB 

Site No.  

Street 
Address:  

City:  County:  

State:  Time Zone:  AQS ID: (XX-XXX-XXXX) 

Latitude:  Longitude:  Elevation: m / ft 

Camera: Y / N If Y, azimuth:             ° Station Type: 
(SLAMS/PSD/NCore/etc.)  

 

Location Setting: 
(circle one) Urban  /   Suburban  /  Rural 

Method of 
determining 

lat/long: 
 

Nearest Road: Name: 
Approximate  
Traffic Count: 

Type: 
(circle one) 

   Arterial  /   Expressway  /  Freeway   /  Through Street or Highway 
 

   Local Street or Highway  /  Major Street or Highway  

 
Predominant Land Use:  Obstructions: Topographic 

Features: General Terrain: 

(Industry, Residential, 
Commercial or Agriculture) Height (m) Distance (m) (hills, valleys, 

rivers, etc.)  
(flat, rolling, 
rough, etc.) 

North      

East      

South      

West      
 

Datalogger Type:  Comm Type:  

Telephone Number or IP Address(es): 

Logger IP Address:  

DataView IP Address:  

Camera IP Address:  

Other/phone number:  
 

Notes: 

 



Collected Parameters: 

Name: Abbrev: Units: AQDB ParCode: Channel Type: 
(analog, RS232, etc.)  

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      
 

  



Cardinal Direction Photos From Site 

From North From East 

From South From West 
 

Cardinal Direction Photos To Site 

To North To East 

To South To West 



 
 

 
 

  



Site Evaluation in Conformance with EPA Requirements:  

 

Site Name: __________________________________   Observed by: _______________________ 

Make and Model #:  

Carbon Monoxide Monitor: _______________________________    

Nitrogen Dioxide Monitor:   _______________________________ 

CRITERIA REQUIREMENTS* 
CRITERIA 

MET? 
Yes No 

CARBON MONOXIDE 
Horizontal and Vertical Probe 
Placement (Par. 4.1) 

3 ± 1 ½ m for microscale   

3-15 m for middle and neighborhood scale   
Spacing from Obstructions 
(Par. 4.2) 

≥ 270° or 180° if on side of building   

Spacing from Roads (Par. 4.3) 2-10 m from edge of nearest traffic lane for microscale; 
 ≥ 10 m from intersection, preferably at midblock 

  

See Table 1 for middle and neighborhood scale   
Spacing from Trees (Par 4.4) Should be ≥ 10 m from dripline of trees, if tree is ≥ 5m 

above sampler and is between the probe and the road. 
N/A 

Comments: 
 
 
 
NITROGEN DIOXIDE 
Vertical Probe Placement (Par. 
6.1) 

3-15 m above ground   

Spacing from Supporting 
Structure (Par. 6.1) 

Greater than 1 m   

Obstacle Distance (Par. 6.2) ≥ Twice the height the obstacle protrudes above probe   

Unrestricted Airflow (Par. 6.2) Must be 270° or 180° if on side of building   

Spacing between Station and 
Roadway (Par. 6.3) 

See Table 2   

Spacing from Trees (Par. 6.4) Should be ≥ 20 m from dripline of trees N/A 

Must be ≥ 10 m from dripline, if trees are an obstruction **   

Probe Material (Par. 9) Teflon or pyrex glass   
Residence Time (Par. 9) Less than 20 seconds   
Comments: 
 
 
 

* Citations from 40 CFR 58, Appendix E. 

** A tree is considered an obstruction if it protrudes above the height of the probe by 5 meters or  more. 



Site Name: __________________________________   Observed by: _______________________ 

Make and Model #:   

Ozone Monitor: ________________________________________    

Sulfur Dioxide Monitor: __________________________________ 

CRITERIA REQUIREMENTS* 
CRITERIA 

MET? 
Yes No 

OZONE 
Vertical Probe Placement  
(Par. 5.1) 

3-15 m above ground   

Spacing from Supporting 
Structure (Par. 5.1) 

Greater than 1 m   

Obstacle Distance (Par. 5.2) ≥ twice the height the obstacle protrudes above probe   

Unrestricted Airflow (Par. 5.2) Must include predominant wind. 180° if on side of building. 
Otherwise 270°. 

  

Spacing between Station and 
Roadway (Par. 5.3) 

See Table 3   

Spacing from Trees (Par. 5.4) Should be ≥ 20 m from dripline N/A 

Must be ≥ 10 m if blocking daytime wind from urban core   

Probe Material (Par. 9) Teflon or pyrex glass   
Residence time (Par. 9) Less than 20 seconds   
Comments: 
 
 
SULFUR DIOXIDE 
Horizontal and Vertical Probe 
Placement (Par. 3.1) 

3-15 m above ground   
> 1 m from supporting structure   
Away from dirty, dusty areas   
If on side of building, should be on side of prevailing winter 
wind 

N/A 

Spacing from Obstructions 
(Par. 3.2) 

≥ 1 m from walls, parapets, penthouses, etc.   

If neighborhood scale, probe must be at a distance ≥ twice 
the height the obstacle protrudes above probe 

  

≥ 270°arc of unrestricted airflow around vertical probes, 
and wind during peak season must be included in arc 

  

180° if on side of building   

No furnace or incineration flues or other minor sources of 
SO2 should be nearby 

N/A 

Spacing from Trees (Par. 3.3) Should be ≥ 20 m from dripline of trees N/A 

≥ 10 m when trees act as an obstruction   
Comments: 
 
* Citations from 40 CFR 58, Appendix E. 
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1.0 PURPOSE 

Instructions provided herein outline the steps for the proper verification, calibration, and 
maintenance of ozone analyzers operated by Air Resource Specialists, Inc. (ARS).  
 
Results from the verifications checks constitute required quality control checks, which are used to 
measure the performance of the instrument against acceptance criteria established in the network 
or site specific Quality Assurance Project Plan (QAPP). 

 
2.0 SUMMARY OF METHOD 

The operation of an equivalent method ozone analyzer is based on the absorption of ultraviolet 
light at 254 nm by ozone molecules. Ozone concentrations are determined using the Beer-
Lambert law by measuring the intensity of light passing through the absorption path with and 
without ozone present. Gaseous ozone standards are not stable, and therefore cannot be stored for 
any length of time. Ozone concentrations to assay analyzer response must be generated on-site 
and verified on-site using a certified ozone transfer standard.  The results from the on-site 
analyzer, on-site station reference, and the independent transfer standard are entered into the 
calibration form. Results shown in the form dictate any required corrective action. 
  
The ambient analyzer and Level 3 station reference photometer are checked against a  
Level 2 transfer standard on a schedule in accordance with the network requirements or site specific 
QAPP. The Level 2 transfer standards used are certified annually against the NIST standard 
reference photometer by EPA.  All traveling Level 2 transfer standards used at ARS are Thermo 49i 
instruments that use internal scrubbers to generate reference air for the ozone measurements. 

 
 

3.0 SCOPE 
Activities described in this document are performed by ARS field technicians or specialists 
during routinely scheduled or emergency visits to monitoring stations. ARS field staff have been 
appropriately trained in site operations and possess the required technical knowledge and abilities 
to perform the activities described below. 

  

Standard 

Reference  

Photometer 

Level-1 

Maintained at  

EPA Regions 

ARS Field 
Transfer 
Standard 

Level 2 

Taken to field  
locations 

In-Station 

Reference 

Level 3 

Maintained at 
monitoring 

location 
 

Certified annually Certified annually Certified as required         
by QAPP 
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4.0 ROLES AND RESPONSIBILITIES 

Program or Project Manager 

• Establish project specific calibration and reporting schedule and requirements as 
documented in the network or site specific Quality Assurance Project Plan (QAPP) 

• Review calibration results, identify inconsistencies and initiate corrective action 
Fields Operations Manager 

• Coordinate site visit schedules 
• Conducts field technician/specialist training and assessments 

Field Technician or Specialist 
• Coordinate scheduled visit with client as directed by project manager or field supervisor 
• Verify all transfer standards to be used are in current certification with appropriate 

documentation 
• Perform as-found verification checks 
• Perform any required instrument maintenance, repair and calibration 
• Perform as-left verification checks 
• Document all calibration results and maintenance procedures 
• Summarize visit in written trip report within 30 days 

5.0 REQUIRED EQUIPMENT AND MATERIALS 

• Certified ozone transfer standard  

• Replacement parts  
o Ozone converter 
o Solenoid valve 
o UV photometer lamp 
o Sample pump 
o Ozone generator lamp 
o Other parts as required 

• Calibration forms in Excel format with site and standards information completed 

• Ozone transfer standard certification form in Excel format for on-site station reference (if 
applicable) 

• Instrument manual for specific analyzer(s) in use 
 
6.0 PROCEDURES 

 
6.1 “AS-FOUND” or “PRE-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed prior to any maintenance activity. No 
equipment maintenance or replacement should be performed prior to the verification checks. Any 
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findings of as-found conditions shall be documented in the comments field of the calibration 
form.  

  
Setup 

• Plug in Level 2 transfer standard and allow to warm up for at least one hour 
 Be sure sample pump is off so no ambient air enters transfer standard 

 
• If necessary, perform zero-air maintenance and replace zero-air media 

 Zero-air should flow in the following order 
desiccant   Purafil  charcoal 
 

• Make notation in station logs and/or flag the ozone channel in the on-site datalogger 
indicating maintenance. 

• Connect output of the ozone manifold on the back of the ozone source to the input of the 
Level 2 transfer standard. In most cases, ozone generation will be accomplished with the 
site analyzer. Please see the Appendix A for diagrams of station tubing plumbing for the 
various networks maintained by ARS. 

• Initiate a zero event on ozone source.  Reference the appropriate manual for the ozone 
source. 

• Check the sample inlet for excess flow (should have ~1 LPM of excess flow) 
• The length of tubing should be as short as reasonably possible, conditioned using high 

concentrations of ozone, and used for this designated purpose only. 
• While all equipment is equilibrating, prepare the pre-maintenance, or “as-found” form in 

the Excel calibration workbook 
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• Complete diagnostic fields from Level 2 transfer standard display  

 

Coefficient and Background must be set to one 
and zero when using Level 2 Transfer Standards 
as they are certified in this configuration. 

Obtain logger slope 
and intercept correction 
from datalogger 

Select using 
analyzer menu and 
enter values in 
calibration form 
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• Enter Transfer Standard Correction Factors using EPA documentation accompanying the 
instrument 

 
 

• Complete diagnostic fields from ambient analyzer and station reference. Reference the 
appropriate manual for the ambient analyzer and station reference. 

 

• Perform multi-point verification checks using target concentrations from the Ozone 
Transfer Standard Certification Form (Please see the instrument manual for detailed 
verification and calibration procedures) 
 

 
 

• Record concentration values for both the ambient analyzer and on-site station reference 
FROM THE DATALOGGER DISPLAY in the calibration forms.  Record the 
concentration value for the transfer standard from the instrument display. 

• If a 1x6 certification of the Level 3 station reference is required, record concentration 
values from the on-site station reference and transfer standard from the instrument 
displays in the Ozone Transfer Standard Certification form. This recertification occurs at 
the same time as the pre-maintenance verification check unless there is a problem with 
the Level 3 station reference (See Section 6.2). 

• Review the results to determine if corrective action or calibration is required (if the form 
indicates FAIL or ACTION). 

• Refer to the instrument manual for more detailed information on performing repairs 
and/or calibration. 
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 6.2 UPDATE OZONE TRANSFER STANDARD CERTIFICATION 

The datalogger contains the verification relationship from the Ozone Transfer Standard 
Certification form. The datalogger uses the RAWO3CAL channel to calculate the O3CAL 
channel. The O3CAL channel is used to input the pre-maintenance and post-maintenance 
calibration checks, which is the corrected value from the Level 3 station reference. During each 
maintenance visit, a 1x6 certification of the on-site station reference is generally required by the 
site-specific QAPP or network requirements.  This 1x6 certification is performed simultaneously 
with the pre-maintenance verification checks unless there is a problem with the Level 3 station 
reference. 
To perform a 1x6 certification of the on-site station reference, use the following procedures: 

• Complete the following fields on the Ozone Transfer Standard Certification Form 
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• Generate concentrations of ozone (using the on-site analyzer) as indicated by the Ozone 
Transfer Standard Certification Form and record results on form. 

 
• The Ozone Transfer Standard Certification Worksheet will calculate the slope and 

intercept and new correction factors to be input in the on-site datalogger. 
 

 
 

• If the form indicates passing results, enter the new correction factors into the on-site 
datalogger. 

• If the form indicates the certification was unsuccessful (FAIL), troubleshoot the 
instrument following procedures outlined in the instrument manual and repeat the 
certification process. 

• If the station reference fails certification again, replace the instrument with a different 
certified station reference. 

• Record all instrument serial numbers and document the issue and resolution. 
  



 

Standard Operating Procedure 
Verification, Calibration and Maintenance of Ozone Analyzers 

Using Traveling Level 2 Ozone Transfer Standards 

 
Version:  1 F_GAS_MTCAL_Ozone-L2_F_1.0 Page 11 of 17 
 
 6.3 PERFORM MAINTENANCE, AND CALIBRATION IF INDICATED 

Following completion of the as-found calibration verification checks, perform any scheduled or 
required maintenance or repair to the ambient analyzer and/or station reference. Refer the 
instrument manual for the make and model of instrument in use for more specific information. 
Maintenance procedures include and are not limited to the following activities: 

• System leak check 
• Sample pump replacement 
• Absorption cell tube cleaning 
• Ozone converter replacement 
• UV lamp replacement 
• Detector frequency adjustment 

 
6.4 AS-LEFT” or “POST-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed following any maintenance activity or 
equipment exchange. Repeat the steps outlined in Section 6.1 and record the measurements in the 
“As-Left” calibration form 

 

 
 

• Make notation in station logs and/or flag the ozone channel in the on-site datalogger 
indicating maintenance has been completed. 
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7.0 REFERENCES 
 

Environmental Protection Agency, 2013, Quality Assurance Handbook for Air Pollution 
Measurement Systems, Volume II, Ambient Air Quality Monitoring Program, EPA-454/B-13-
003 (May 2013). 
Environmental Protection Agency, 2013, Transfer Standards for Calibration of Air Monitoring 
Analyzers for Ozone, Technical Assistance Document,  EPA-454/B-13-004 (October 2013). 

 

8.0 DEFINITIONS AND ACRONYMS 
 

ARS  Air Resource Specialists, Inc. 
AQDB  Air Quality Database 
CFR  Code of Federal Regulations 
DAS  Data Acquisition System 
EPA  U.S. Environmental Protection Agency 
IMC  Information Management Center 
NIST  National Institute of Standards and Technology 
PDF  Portable Document Format 
QA  Quality Assurance 
QAPP  Quality Assurance Project Plan 
QC  Quality Control 
SLAMS State and Local Air Monitoring Stations 
SOP  Standard Operating Procedure 
 
Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 
 
Calibration: adjustment of the instrument or analyzer so it operates within established 
acceptance criteria (defined in the network of project specific QAPP) 
 
Certification: the procedure and methodology of transferring the authority of 
measurement from one device to another. In ozone monitoring, this procedure is 
commonly known as a “six-by-six” verification check consisting of 6 individual 
comparisons of the transfer standard to an authoritative standard. Each comparison must 
be conducted on a different day. 
 
Ozone Transfer Standard: transportable device or apparatus which, together with 
associated operational procedures, is capable of accurately reproducing pollutant 
concentration standards or of producing accurate assays of pollutant concentrations which 
are quantitatively related to an authoritative standard. 
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APPENDIX A  
 

SAMPLE SITE CONFIGURATION DIAGRAMS 
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NPS-CASTNET CONFIGURATION 
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WDEQ-AQD “STYLE A” CONFIGURATION 
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WDEQ-AQD “STYLE B” CONFIGURATION 
  

Connect TRAVEL 
standard here 
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NCORE CONFIGURATION 

Connect TRAVEL 
standard here 
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Approvals 

 

The purpose of this review and approval is to evaluate this Standard Operating Procedure (SOP) for 
adequacy prior to issuance.  The signatories below are stating that the approach defined within this 
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1.0 PURPOSE 

Instructions provided herein outline the steps for the proper verification and maintenance of 
immersible temperature systems operated by Air Resource Specialists, Inc. (ARS).  

Results from the verifications checks constitute required quality control checks, which are used to 
measure the performance of the instrument against acceptance criteria established in the network 
or site specific Quality Assurance Project Plan (QAPP). 

2.0 SUMMARY OF METHOD 
The operation of an immersible temperature sensor is verified by the immersion of the on-site 
sensor(s) into a water bath with a transfer standard. The results from the on-site sensor and the 
transfer standard are entered into the calibration form. Results shown in the form dictate any 
required corrective action. 

3.0 SCOPE 
Activities described in this document are performed by ARS field technicians or specialists 
during routinely scheduled or emergency visits to monitoring stations. ARS field staff have been 
appropriately trained in site operations and possess the required technical knowledge and abilities 
to perform the activities described below. 

4.0 ROLES AND RESPONSIBILITIES 

Program or Project Manager 

• Establish project specific calibration and reporting schedule and requirements as
documented in the network or site specific Quality Assurance Project Plan (QAPP)

• Review calibration results, identify inconsistencies and initiate corrective action
Fields Operations Manager 

• Coordinate site visit schedules
• Conducts field technician/specialist training and assessments

Field Technician or Specialist 
• Coordinate scheduled visit with client as directed by project manager or field supervisor
• Verify all transfer standards to be used are in current certification with appropriate

documentation
• Perform as-found verification checks
• Perform any required instrument maintenance, repair and calibration
• Perform as-left verification checks
• Document all calibration results and maintenance procedures
• Summarize visit in written trip report within 30 days
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5.0 REQUIRED EQUIPMENT AND MATERIALS 

• Meteorological field kit  

• One gallon of distilled water 

• Crushed ice 

• Thermos bottles 

• Calibration forms in Excel format with site and standards information completed 

• Instrument manual for specific sensor(s) in use 
 
6.0 PROCEDURES 

 
6.1 “AS-FOUND” or “PRE-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed prior to any maintenance activity. No 
equipment maintenance or replacement should be performed prior to the verification checks. Any 
findings of as-found conditions shall be documented in the comments field of the calibration 
form.  

  

• Make notation in DataView and flag the temperature channel(s) in the on-site datalogger 
indicating maintenance. 
 
 

• Prepare three water baths in insulated flasks: ice bath, ambient bath (~15-25°C) and high 
range bath (~40-50°C). These temperatures are measured with a NIST-traceable digital 
thermometer. 
 

• Remove temperature probe(s) from the aspirator(s) and check the fans for proper 
operation and flow restrictions. 
 

• Place probe(s) in the first bath along with a transfer standard. Agitate the water bath until 
the values indicated on the DAS and transfer standard stabilize (two-five minutes). 
 

• Record measurements in the calibration form under “as-found” checks. 
 

 
 

• Repeat the above procedures for remaining baths. 
 

• Note any additional findings in the comments field of the calibration form. 
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 6.2 MAINTENANCE and EQUIPMENT EXCHANGE 

If the sensor was found to be operating outside of calibration acceptance criteria, document 
findings in the ARS Site Status Log (www.arssitestatuslog.com).  
 

 
 
Adjustments to the sensors should not be made.  Instead, adjustments to the datalogger or signal 
conditioning system should be made with project manager approval. 

• Inspect the probe(s), wiring, and electrical connections for cleanliness and 
electrical continuity, and correct if necessary.  
 

• Inspect aspirator housing(s) and clean if any dirt or cobwebs have accumulated. 
 

If a spare sensor is available, install spare sensor and repeat the verification checks from Section 
6.1 on the replacement sensor.  
 

Be sure to record the serial number(s) for each on-site sensor 
 

  
 

 
 
 
 
 
 

http://www.arssitestautslog.com/
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6.3 “AS-LEFT” or “POST-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed following any maintenance activity or 
equipment exchange. Repeat the steps outlined in Section 6.1 and record the measurements in the 
“As-Left” field of the calibration form. 

• Make notation in station logs and unflag the temperature channel(s) in the on-site
datalogger indicating maintenance has been completed.

• Pack up transfer standard and equipment and return to the meteorological field kit

7.0 REFERENCES 
Environmental Protection Agency, 2008, Quality Assurance Handbook for Air Pollution 
Measurement Systems: Volume IV. Meteorological Measurements (Version 2.0), 
EPA-454/B-08-002 (March 2008). 

Environmental Protection Agency, 2000, Meteorological Monitoring Guidance for Regulatory 
Modeling Applications, EPA-454/R-99-005 (February 2000). 

8.0 DEFINITIONS AND ACRONYMS 

ARS Air Resource Specialists, Inc. 
AQDB Air Quality Database 
CFR Code of Federal Regulations 
DAS Data Acquisition System 
DVM Digital Volt Meter 
EPA U.S. Environmental Protection Agency 
IMC Information Management Center 
NIST National Institute of Standards and Technology 
PDF Portable Document Format 
QA Quality Assurance 
QAPP Quality Assurance Project Plan 
QC Quality Control 
SLAMS State and Local Air Monitoring Stations 
SOP Standard Operating Procedure 
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Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 

Calibration: adjustment of the instrument or analyzer so it operates within established 
acceptance criteria (defined in the network of project specific QAPP) 
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adequacy prior to issuance.  The signatories below are stating that the approach defined within this 
document is acceptable and that the affected company interests have been represented. 

 

 

 

Author Signature: 

 

 
 

Program: QA Manager 
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Program: Field Operations Manager 
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1.0 PURPOSE 

Instructions provided herein outline the steps for the proper verification and maintenance of non-
immersible ambient temperature/relative humidity sensors operated by Air Resource Specialists, 
Inc. (ARS).  
 
Results from the verifications checks constitute required quality control checks, which are used to 
measure the performance of the instrument against acceptance criteria established in the network 
or site specific Quality Assurance Project Plan (QAPP). 

 
2.0 SUMMARY OF METHOD 

The operation of a thermistor/capacitive resistance-type air temperature and relative humidity 
sensor is verified by collocation of a certified transfer standard with the on-site sensor and 
comparison of the results. The transfer standard must be aspirated or shielded in the same manner 
as the on-site sensor. The sensors must be collocated for a minimum of three (3) hours or per 
QAPP requirements. The results from the on-site sensor and the transfer standard are entered into 
the calibration form. Results shown in the form dictate any required corrective action. 
  

3.0 SCOPE 
Activities described in this document are performed by ARS field technicians or specialists 
during routinely scheduled or emergency visits to monitoring stations. ARS field staff have been 
appropriately trained in site operations and possess the required technical knowledge and abilities 
to perform the activities described below. 
 

4.0 ROLES AND RESPONSIBILITIES 

Program or Project Manager 

• Establish project-specific calibration and reporting schedule and requirements as 
documented in the network or site specific Quality Assurance Project Plan (QAPP) 

• Review calibration results, identify inconsistencies and initiate corrective action 

Fields Operations Manager 

• Coordinate site visit schedules 
• Conducts field technician/specialist training and assessments 

Field Technician or Specialist 

• Coordinate scheduled visit with client as directed by project manager or field supervisor 
• Verify all transfer standards to be used are in current certification with appropriate 

documentation 
• Perform as-found verification checks 
• Perform any required instrument maintenance, repair and calibration 
• Perform as-left verification checks 
• Document all calibration results and maintenance procedures 
• Summarize visit in written trip report within 30 days  
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5.0 REQUIRED EQUIPMENT AND MATERIALS 

• Meteorological field kit  

• Calibration forms in Excel format with site and standards information completed 

• Instrument manual for specific sensor(s) in use 
 
6.0 PROCEDURES 

 
6.1 “AS-FOUND” or “PRE-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed prior to any maintenance activity. No 
equipment maintenance or replacement should be performed prior to the verification checks. Any 
findings of as-found conditions shall be documented in the comments field of the calibration 
form.  

  
Ambient Temperature  

• Make notation in station logs and/or flag the ambient temperature channel in the on-site 
datalogger indicating maintenance only if the act of making the comparisons affects 
ambient measurements. 

• Attach transfer standard as close as possible to on-site sensor using the provided 
mounting hardware and aspiration shield, as necessary. 

• Verify met kit datalogger is recording data hourly intervals. 
• Following/during at least three (3) hours of collocated comparison, record measurements 

in the calibration form under “as-found” checks. 

 
 

 
• Determine condition of aspirator fan (if site is 

passively aspirated, check N/A). 

 

V

1200
1300

23.20
23.70 22.90 PASS

Hour Difference
-0.1 PASS22.10

Average

-0.2 PASS
-0.8

-0.4 PASS

Temperature (oC)AS FOUND

22.00
23.40

STD DAS
1100

Aspirator fan functional? Yes No N/A



 

Standard Operating Procedure 
Verification and Maintenance of Ambient Temperature/ 
Relative Humidity Sensors by Collocated Comparison 

 
Version:  1 F_MET_MTCAL_ATRH_F_1.0 Page 5 of 8 
 

• If any collocated hours should not be included in the calculation (due to sensor 
malfunction, wiring issues, etc.) enter an “X” into the yellow box under the valid or “V” 
column. This will exclude the comparison in the final calculations. 
 IMPORTANT: Only use this field if the comparison is invalid. Do not use 

this field in an attempt to improve results. 
• Note any additional findings in the comments field of the calibration form.  

Relative Humidity 

• Make notation in station logs and/or flag the relative humidity channel in the on-site 
datalogger indicating maintenance only if the act of making the comparisons affects 
ambient measurements.  

• Attach transfer standard as close as possible to on-site sensor using the provided 
mounting hardware and aspiration shield, as necessary. Verify met kit datalogger is 
recording data hourly intervals. 

• Following/during at least three (3) hours of collocated comparison, record measurements 
in the calibration form under “as-found” checks. 
 

 
• Determine condition of aspirator fan (if site is passively aspirated, check N/A). 

 
• If any collocated hours should not be included in the calculation (due to sensor 

malfunction, wiring issues, etc.) enter an “X” into the yellow box under the valid or “V” 
column. This will exclude the comparison in the final calculations. 
 IMPORTANT: Only use this field if the comparison is invalid. Do not use 

this field in an attempt to improve results 
• Note any additional findings in the comments field of the calibration form. 

 
 6.2 MAINTENANCE AND EQUIPMENT EXCHANGE 

Inspect all wiring for abrasions, damage, or loose connections.  Inspect all connections for 
possible corrosion or damage and repair as necessary. 

V
1100
1200
1300

0.6% PASS

55.0% 54.5% -0.5% PASS
Difference

Average

49.4% 50.0% 0.6% PASS
51.2% 53.0% 1.8% PASS

Relative Humidity (%)
Hour

AS FOUND
STD DAS

Aspirator fan functional? Yes No N/A
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If the network or project schedule dictates a sensor exchange, replace the sensor and repeat the 
verification checks from Section 6.1 on the replacement sensor.  
 

Be sure to record the serial number(s) for each on-site sensor 
 

  
 

If the sensor was found to be operating outside of calibration acceptance criteria, replace the 
sensor and repeat the verification checks from Section 6.1 on the replacement sensor. On-site 
adjustments or calibrations are not recommended without project manager approval.  
 

 

 
Any sensor removed from the site and returned to ARS should be returned to the 

instrument laboratory with a completed “Instrument Service Order Form”. 
 
 

Model
Serial Number

Manufacturer

AS FOUND

Model
Serial Number

AS LEFT

Manufacturer

V

1200
1300

24.90
23.70 24.80 FAIL

Hour Difference
0.9 PASS22.10

Average

1.5 FAIL
1.1

1.2 FAIL

Temperature (oC)AS FOUND

23.00
23.40

STD DAS
1100

V
1100
1200
1300

5.4% FAIL

55.0% 59.7% 4.7% PASS
Difference

Average

49.4% 55.7% 6.3% FAIL
51.2% 56.3% 5.1% FAIL

Relative Humidity (%)
Hour

AS FOUND
STD DAS
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6.3 “AS-LEFT” or “POST-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed following any maintenance activity or 
equipment exchange. Repeat the steps outlined in Section 6.1 and record the measurements in the 
“As-Left” field of the calibration form 

• Verify all data were recorded by the meteorological kit datalogger.
• Make notation in station logs indicating that maintenance has been completed.
• Remove transfer standard from its mount and return equipment to the meteorological

field kit.

7.0 REFERENCES 
Environmental Protection Agency, 2008, Quality Assurance Handbook for Air Pollution 
Measurement Systems: Volume IV. Meteorological Measurements (Version 2.0), 
EPA-454/B-08-002 (March 2008). 

Environmental Protection Agency, 2000, Meteorological Monitoring Guidance for Regulatory 
Modeling Applications, EPA-454/R-99-005 (February 2000). 

V

-0.2

1500
1600
1700 23.50

Hour
AS LEFT

Difference
0.1 PASS

Temperature (oC)
STD DAS

23.90 24.00

Average

-0.2 PASS
-0.6 PASS

PASS

25.00 24.80
24.10

V
1500
1600
1700

Average 3.9% PASS

STD DAS Difference
50.0% 55.0% 5.0% PASS

54.2% 4.4% PASS
49.4% 2.4% PASS

Hour

49.8%
47.0%

AS LEFT Relative Humidity (%)
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8.0 DEFINITIONS AND ACRONYMS 
 

ARS  Air Resource Specialists, Inc. 
AQDB  Air Quality Database 
CFR  Code of Federal Regulations 
DAS  Data Acquisition System 
EPA  U.S. Environmental Protection Agency 
IMC  Information Management Center 
NIST  National Institute of Standards and Technology 
PDF  Portable Document Format 
QA  Quality Assurance 
QAPP  Quality Assurance Project Plan 
QC  Quality Control 
SLAMS State and Local Air Monitoring Stations 
SOP  Standard Operating Procedure 
 
Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 
 
Calibration: adjustment of the instrument or analyzer so it operates within established 
acceptance criteria (defined in the network of project specific QAPP) 
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1.0 PURPOSE 

Instructions provided herein outline the steps for the proper verification and calibration of 
precipitation gauge instruments operated by Air Resource Specialists, Inc. (ARS).  
 
Results from the verifications checks constitute required quality control checks, which are used to 
measure the performance of the instrument against acceptance criteria established in the network 
or site specific Quality Assurance Project Plan (QAPP). 

 
2.0 SUMMARY OF METHOD 

A calibration bottle or funnel containing a known volume of water is used to introduce water at a 
controlled rate specified by the manufacturer into the tipping bucket rain gauge. The number of 
tips is recorded by the data logger, converted into a measurement, and compared to the designated 
value noted in the calibration form. Results shown in the form dictate any required corrective 
action or calibration. 
  

3.0 SCOPE 
Activities described in this document are performed by ARS field technicians or specialists 
during routinely scheduled or emergency visits to monitoring stations. ARS field staff have been 
appropriately trained in site operations and possess the required technical knowledge and abilities 
to perform the activities described below. 
 

4.0 ROLES AND RESPONSIBILITIES 

Program or Project Manager 
• Establish project specific calibration and reporting schedule and requirements as 

documented in the network or site specific Quality Assurance Project Plan (QAPP) 
• Review calibration results, identify inconsistencies and initiate corrective action 

Fields Operations Manager 
• Coordinate site visit schedules 
• Conducts field technician/specialist training and assessments 

Field Technician or Specialist 
• Coordinate scheduled visit with client as directed by project manager or field supervisor 
• Verify all transfer standards to be used are in current certification with appropriate 

documentation 
• Perform as-found verification checks 
• Perform any required instrument maintenance, repair and calibration 
• Perform as-left verification checks 
• Document all calibration results and maintenance procedures 
• Summarize visit in written trip report within 30 days 
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5.0 REQUIRED EQUIPMENT AND MATERIALS 

• Manufacturer-provided drip bottle and plate OR funnel and graduated cylinder

• Distilled or bottled water

• Calibration forms in Excel format with site and standards information completed

• Instrument manual for specific sensor in use

6.0 PROCEDURES 

6.1 “AS-FOUND” or “PRE-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed prior to any maintenance activity. No 
adjustments or cleaning should be performed prior to the verification checks. Any findings of as-
found conditions shall be documented in the comments field of the calibration form.  The 
calibration form calculates the target response when the volume used is entered on the Standards 
Table tab of the Excel form and the correct manufacturer and model are selected on the 
calibration form for precipitation checks. 
Verification checks can be performed using a drip bottle and plate OR funnel and graduated 
cylinder  
For either method, the following steps must be performed to complete a verification check of the 
precipitation gauge: 

Drip Bottle and Plate 

• Make notation in station logs and/or flag the precipitation channel in the datalogger
indicating maintenance

• Fill bottle with known volume of water.
• Attach drip bottle and plate to bucket
• Once all water has been introduced to the instrument,

record measurement from datalogger in the calibration
form under “as-found” checks
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Funnel and Graduated Cylinder 

• Make notation in station logs and/or flag the precipitation channel in the datalogger 
indicating maintenance 

• Insert funnel into bucket 

 
• Add known volume of water to funnel using the graduated cylinder.  
• Once all water has been introduced to the instrument, record measurement from 

datalogger in the calibration form under “as-found” checks 

 
Following the completion of the “as-found” verification checks, the field specialist will assess the 
condition of the on-site instrument by performing the following tasks: 

• If ambient temperatures are cold enough assess the heater functionality by touch 

o Note in the comments if conditions are too warm to assess heater functionality 

• Remove the outer housing of the precipitation gauge and: 

o Examine the bubble levels to determine if the sensor is level 

o Inspect the tipping mechanism for any debris or obstructions 
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• Record findings on calibration form 

 
 

• Note any additional findings in the comments field of the calibration form 

6.2 MAINTENANCE and CALIBRATION ADJUSTMENTS 
  
Inspect all wiring for abrasions, damage or loose connections.  Inspect all connections for 
possible corrosion and repair as necessary.  Make sure that internal wiring does not interfere with 
the tipping mechanism. 
If the sensor was not found clean and/or level, perform any cleaning, leveling and another 
verification check prior to any adjustments to the instrument. 
If the results from the pre-maintenance verification check indicate “MAINTENANCE 
REQUIRED”, a field calibration of the instrument MUST be performed 

 
 

General adjustment procedures are described 
here. Refer to the instrument manual of the 
on-site gauge for specific adjustment and 
calibration procedures 
 
Using a pipette with the appropriate volume of water 
required for one tip (refer to calibration form or 
instrument manual for volume), introduce water one drop 
at a time until the mechanism tips. 
 
In general, if the mechanism tips prior to the complete 
evacuation of the pipette, the calibration screws need to 
be lowered. If the mechanism does not tip after the 
introduction of all water in the pipette, the screws need to 
be raised. 
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Refer to the instrument manual 
 for detailed adjustment and calibration procedures 

6.3 “AS-LEFT” or “POST-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed following any maintenance activity or 
adjustments. Repeat the steps outlined in Section 6.1 and record the measurements in the “As-
Left” field of the calibration form 

• Make notation in station logs and/or unflag the precipitation channel in the datalogger
indicating maintenance

7.0 REFERENCES 
Environmental Protection Agency, 2008, Quality Assurance Handbook for Air Pollution 
Measurement Systems: Volume IV. Meteorological Measurements (Version 2.0), 
EPA-454/B-08-002  (March 2008). 

8.0 DEFINITIONS AND ACRONYMS 

ARS Air Resource Specialists, Inc. 
AQDB Air Quality Database 
CFR Code of Federal Regulations 
DAS Data Acquisition System 
EPA U.S. Environmental Protection Agency 
IMC Information Management Center 
NIST National Institute of Standards and Technology 
PDF Portable Document Format 
QA Quality Assurance 
QAPP Quality Assurance Project Plan 
QC Quality Control 
SLAMS State and Local Air Monitoring Stations 
SOP Standard Operating Procedure 
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Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 
 
Calibration: adjustment of the instrument or analyzer so it operates within established 
acceptance criteria (defined in the network of project specific QAPP) 
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Approvals 

 

The purpose of this review and approval is to evaluate this Standard Operating Procedure (SOP) for 
adequacy prior to issuance.  The signatories below are stating that the approach defined within this 
document is acceptable and that the affected company interests have been represented. 

 

 

 

Author Signature: 

 

 
 

Program: QA Manager 

Approval Signature: 

 

 
 

Program: Field Operations Manager 
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1.0 PURPOSE 

Instructions provided herein outline the steps for the proper verification and maintenance of solar 
radiation standards operated by Air Resource Specialists, Inc. (ARS).  

Results from the verifications checks constitute required quality control checks, which are used to 
measure the performance of the instrument against acceptance criteria established in the network 
or site specific Quality Assurance Project Plan (QAPP). 

2.0 SUMMARY OF METHOD 
The operation of a solar radiation sensor is verified by collocation of a certified transfer standard 
with the on-site sensor and comparing the results. The results from the on-site sensor and the 
transfer standard are entered into the calibration form. Results shown in the form dictate any 
required corrective action. 

3.0 SCOPE 
Activities described in this document are performed by ARS field technicians or specialists 
during routinely scheduled or emergency visits to monitoring stations. ARS field staff have been 
appropriately trained in site operations and possess the required technical knowledge and abilities 
to perform the activities described below. 

4.0 ROLES AND RESPONSIBILITIES 

Program or Project Manager 

• Establish project specific calibration and reporting schedule and requirements as
documented in the network or site specific Quality Assurance Project Plan (QAPP)

• Review calibration results, identify inconsistencies and initiate corrective action
Fields Operations Manager 

• Coordinate site visit schedules
• Conducts field technician/specialist training and assessments

Field Technician or Specialist 
• Coordinate scheduled visit with client as directed by project manager or field supervisor
• Verify all transfer standards to be used are in current certification with appropriate

documentation
• Perform as-found verification checks
• Perform any required instrument maintenance, repair and calibration
• Perform as-left verification checks
• Document all calibration results and maintenance procedures
• Summarize visit in written trip report within 30 days



Standard Operating Procedure 
Verification and Maintenance of 

Solar Radiation Sensors 

Version:  1 F_MET_MTCAL_SOL_F_1.0 Page 4 of 6 

5.0 REQUIRED EQUIPMENT AND MATERIALS 

• Meteorological field kit

• Calibration forms in Excel format with site and standards information completed

• Instrument manual for specific sensor(s) in use

6.0 PROCEDURES 

6.1 “AS-FOUND” or “PRE-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed prior to any maintenance activity. No 
equipment maintenance or replacement should be performed prior to the verification checks. Any 
findings of as-found conditions shall be documented in the comments field of the calibration 
form.  

Collocated comparison 

• Collocated the reference solar radiation sensor by either mounting the sensor on a tripod
placed close to the existing site sensor or attaching the reference solar (or net) radiation
sensor to the existing solar radiation support bracket. Connect the reference output to a
portable datalogger and record several hours’ values.

• Be sure the transfer standard is level and clean.
• Record measurements from both the collocated standard and the on-site sensor in the

calibration form under “as-found” checks.

• Inspect the site solar radiation sensor for proper level and cleanliness.  Make note of any
obstructions.

• Note any additional findings in the comments field of the calibration form.

Difference

MEAN ABS % DIFF

DAS (W/m2)CTS (W/m2)Hour
AS FOUND Solar Radiation
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 6.2 MAINTENANCE and EQUIPMENT EXCHANGE 

Inspect all wiring for abrasions, damage or loose connections.  Inspect all connections for 
possible corrosion and repair as necessary. Remove any dust or debris from the sensor and check 
the level of the sensor using the bubble level on the mounting bracket. 
If the sensor was found to be operating outside of calibration acceptance criteria, document 
findings in the ARS Site Status Log (www.arssitestatuslog.com). If a spare sensor is available, 
install the spare sensor; on-site adjustments or calibrations are not recommended without project 
manager approval. 

 
Be sure to record the serial number(s) for each on-site sensor 

 

 
  

6.3 “AS-LEFT” or “POST-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed following any maintenance activity or 
equipment exchange. Repeat the steps outlined in Section 6.1 and record the measurements in the 
“As-Left” field of the calibration form 

 

 
 

• Return equipment to the meteorological field kit  

Low Output

Logger Type

Manufacturer

High Input (V)
Low Input (V)

Model
Serial Number
Translator

ESC
High Output
Low Output

Model

Translator

Manufacturer

Logger Type

Serial Number

High Input (V)
ESC Low Input (V)

High Output

AS FOUND AS LEFT

Difference
Solar Radiation

DAS (W/m2)

394 381

-2.1%
-2.0%
-3.3%

-2.3%
942

AS LEFT

12:00 864
Hour CTS (W/m2)

844
922

MEAN ABS % DIFF 3.2% PASS
14 6.1%16:00 13.2

15:00
14:00 960 941
13:00

http://www.arssitestatuslog.com/
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7.0 REFERENCES 

Environmental Protection Agency, 2008, Quality Assurance Handbook for Air Pollution  
  Measurement Systems: Volume IV. Meteorological Measurements (Version 2.0), 
 EPA-454/B-08-002 (March 2008). 
 

Environmental Protection Agency, 2000, Meteorological Monitoring Guidance for Regulatory 
Modeling Applications, EPA-454/R-99-005 (February 2000). 

 

8.0 DEFINITIONS AND ACRONYMS 
 

ARS  Air Resource Specialists, Inc. 
EPA  U.S. Environmental Protection Agency 
NIST  National Institute of Standards and Technology 
QA  Quality Assurance 
QAPP  Quality Assurance Project Plan 
QC  Quality Control 
SOP  Standard Operating Procedure 
 
Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 
 
Calibration: adjustment of the instrument or analyzer so that it operates within 
established acceptance criteria (defined in the network of project specific QAPP) 
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Approvals 

 

The purpose of this review and approval is to evaluate this Standard Operating Procedure (SOP) for 
adequacy prior to issuance.  The signatories below are stating that the approach defined within this 
document is acceptable and that the affected company interests have been represented. 

 

 

 

Author Signature: 

 

 
 

Program: QA Manager 

Approval Signature: 

 

 
 

Program: Field Operations Manager 
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1.0 PURPOSE 

Instructions provided herein outline the steps for the proper verification and maintenance wind 
direction sensors operated by Air Resource Specialists, Inc. (ARS).  
 
Results from the verifications checks constitute required quality control checks, which are used to 
measure the performance of the instrument against acceptance criteria established in the network 
or site specific Quality Assurance Project Plan (QAPP). 

 
2.0 SUMMARY OF METHOD 

Wind direction (vane) measurements are verified using a compass or transit comparisons to 
known landmarks or manufacturer-provided alignment rods. The results from the on-site sensor 
and the transfer standard(s) are entered into the calibration form. Results shown in the form 
dictate any required corrective action. 
  

3.0 SCOPE 
Activities described in this document are performed by ARS field technicians or specialists 
during routinely scheduled or emergency visits to monitoring stations. ARS field staff have been 
appropriately trained in site operations and possess the required technical knowledge and abilities 
to perform the activities described below. 
 

4.0 ROLES AND RESPONSIBILITIES 

Program or Project Manager 

• Establish project specific calibration and reporting schedule and requirements as 
documented in the network or site specific Quality Assurance Project Plan (QAPP) 

• Review calibration results, identify inconsistencies and initiate corrective action 
Fields Operations Manager 

• Coordinate site visit schedules 
• Conducts field technician/specialist training and assessments 

Field Technician or Specialist 
• Coordinate scheduled visit with client as directed by project manager or field supervisor 
• Verify all transfer standards to be used are in current certification with appropriate 

documentation 
• Perform as-found verification checks 
• Perform any required instrument maintenance, repair and calibration 
• Perform as-left verification checks 
• Document all calibration results and maintenance procedures 
• Summarize visit in written trip report within 30 days 
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5.0 REQUIRED EQUIPMENT AND MATERIALS 

• Meteorological field kit  

• Transit or non-ferrous tripod-mounted compass, accurate to at least 1 degree 

• Site location in latitude and longitude 

• Program to calculate the sun’s azimuth direction  

• Linearity jig 

• Torque disc 

• Torque meter 

• Calibration forms in Excel format with site and standards information completed 

• Instrument manual for specific sensor(s) in use 
 
6.0 PROCEDURES 

 
6.1 “AS-FOUND” or “PRE-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed prior to any maintenance activity. No 
equipment maintenance or replacement should be performed prior to the verification checks. Any 
findings of as-found conditions shall be documented in the comments field of the calibration 
form.  

  
 Sensor Alignment 

• Make notation in station logs and/or flag the wind 
direction channel in the on-site datalogger indicating 
maintenance 

• Determine the magnetic declination of magnetic 
north from true north using one of the following 
methods (methods marked with * are preferred): 
 ARS Solar Azimuth Calculator*  
 Approved Solar Azimuth applications on 

your smart phone* 
 National Geomagnetism Program from the 

USGS web site  
(http://geomag.usgs.gov/models) 

 National Geographic Data Center web site  
(http://www.ngdc.noaa.gov/seg/geomag/ 
magfield.shtml) 

 U.S. Navy Observatory web site (http://aa. 
Usno.navy.mil/data/docs/AltAz.html)  

• Set up tripod and affix compass or transit 

http://geomag.usgs.gov/models
http://www.ngdc.noaa.gov/seg/geomag/%20magfield.shtml
http://www.ngdc.noaa.gov/seg/geomag/%20magfield.shtml
http://aa.usno.navy.mil/data/docs/AltAz.html
http://aa.usno.navy.mil/data/docs/AltAz.html
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• Position compass or transit to align the cross-hairs through the cross-arm or alignment 
rod of the wind direction sensor  

• Determine if the orientation of the alignment rod.  If the alignment rod is intended to be 
North-South, use the “N-S reference” section of the form. For any other reference, use 
the “X reference” section of the form.  For use of landmarks (usually associated with 
towers that require climbing), use the “Landmark” section of the form. 

NOTE: Only one of these methods is 
required to be completed on the form 

   
  Sensor Linearity 

• Use the appropriate linearity test assembly 
for the sensor under test 
 RM Young sensors generally use 

either RM Young Model 18112 or 
18212. 

 Climatronics sensors use a 8-
position Wilson Machining disc 

• Cycle the test assembly through nine 45° increments. 
• Enter results in calibration form 

 
 Starting Threshold Check 

• Remove the sensor from the 
cross-arm 

• Remove the vane, if necessary,  
and install the torque disc on the 
sensor shaft 

• Hold the sensor in a: 
 Position such that the sensor shaft is parallel to the ground (Climatronics) 
 Position such that the sensor vane body is parallel to the ground (RM Young) 

• Note the weight size and distance from center when the shaft first turns (torque) 
• Enter value in calibration form. Sensors over the threshold limit require action. Sensors 

near the limit re quire consideration. 
• Note any additional findings in the comments field of the calibration form 

 
 6.2 MAINTENANCE and EQUIPMENT EXCHANGE 

Inspect all wiring for abrasions, damage or loose connections. Inspect all connections for possible 
corrosion or damage and repair as necessary. If the sensor has a heater, verify correction 
operation of the heater if conditions allow. 
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If the network or project schedule dictates a sensor exchange, replace the sensor and repeat the 
verification checks from Section 6.1 on the replacement sensor.  Potentionmeter or bearing 
replacements in the field should generally NOT be performed in the field.  Such maintenance 
requires project manager approval. 
 

Be sure to record the serial number(s) for each on-site sensor 
 

  
 

6.3 “AS-LEFT” or “POST-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed following any maintenance activity or 
equipment exchange. Repeat the steps outlined in Section 6.1 and record the measurements in the 
“As-Left” field of the calibration form 

 

• Verify all data were recorded on calibration forms  
• Remount the site sensor and vane. 
• Make notation in station logs and/or unflag the wind speed and direction channels in the 

on-site datalogger indicating maintenance has been completed. 
• Return equipment to the meteorological field kit 

 

6.4 SENSORS REMOVED FROM THE FIELD 
All sensors removed from the field should be turned in to the ARS laboratory for routine 

maintenance and any necessary repairs.  All sensors are required to have an Instrument Service Order 
Form completed and accompany the sensor to the ARS laboratory.  See the project manager for additional 
information. 

 
7.0 REFERENCES 

Environmental Protection Agency, 2008, Quality Assurance Handbook for Air Pollution  
  Measurement Systems: Volume IV. Meteorological Measurements (Version 2.0), 
 EPA-454/B-08-002 (March 2008). 
 

Environmental Protection Agency, 2000, Meteorological Monitoring Guidance for Regulatory 
Modeling Applications, EPA-454/R-99-005 (February 2000). 
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8.0 DEFINITIONS AND ACRONYMS 
 

ARS  Air Resource Specialists, Inc. 
AQDB  Air Quality Database 
CFR  Code of Federal Regulations 
DAS  Data Acquisition System 
EPA  U.S. Environmental Protection Agency 
IMC  Information Management Center 
NIST  National Institute of Standards and Technology 
PDF  Portable Document Format 
QA  Quality Assurance 
QAPP  Quality Assurance Project Plan 
QC  Quality Control 
SLAMS State and Local Air Monitoring Stations 
SOP  Standard Operating Procedure 
 
Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 
 
Calibration: adjustment of the instrument or analyzer so it operates within established 
acceptance criteria (defined in the network of project specific QAPP) 
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Approvals 

 

The purpose of this review and approval is to evaluate this Standard Operating Procedure (SOP) for 
adequacy prior to issuance.  The signatories below are stating that the approach defined within this 
document is acceptable and that the affected company interests have been represented. 

 

 

 

Author Signature: 

 

 
 

Program: QA Manager 

Approval Signature: 

 

 
 

Program: Field Operations Manager 
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1.0 PURPOSE 

Instructions provided herein outline the steps for the proper verification and maintenance wind 
speed sensors operated by Air Resource Specialists, Inc. (ARS).  
 
Results from the verifications checks constitute required quality control checks, which are used to 
measure the performance of the instrument against acceptance criteria established in the network 
or site specific Quality Assurance Project Plan (QAPP). 

 
2.0 SUMMARY OF METHOD 

The operation of a propeller or cup anemometer wind speed sensor is verified by turning the on-
site anemometer with a motor drive at known speeds and observing the output. The results from 
the on-site sensor and the transfer standard(s) are entered into the calibration form. Results shown 
in the form dictate any required corrective action. 
  

3.0 SCOPE 
Activities described in this document are performed by ARS field technicians or specialists 
during routinely scheduled or emergency visits to monitoring stations. ARS field staff have been 
appropriately trained in site operations and possess the required technical knowledge and abilities 
to perform the activities described below. 
 

4.0 ROLES AND RESPONSIBILITIES 

Program or Project Manager 

• Establish project specific calibration and reporting schedule and requirements as 
documented in the network or site specific Quality Assurance Project Plan (QAPP) 

• Review calibration results, identify inconsistencies and initiate corrective action 
Fields Operations Manager 

• Coordinate site visit schedules 
• Conducts field technician/specialist training and assessments 

Field Technician or Specialist 
• Coordinate scheduled visit with client as directed by project manager or field supervisor 
• Verify all transfer standards to be used are in current certification with appropriate 

documentation 
• Perform as-found verification checks 
• Perform any required instrument maintenance, repair and calibration 
• Perform as-left verification checks 
• Document all calibration results and maintenance procedures 
• Summarize visit in written trip report within 30 days 
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5.0 REQUIRED EQUIPMENT AND MATERIALS 

• Meteorological field kit  

• Anemometer drive 

• Site location in latitude and longitude 

• Torque disc 

• Calibration forms in Excel format with site and standards information completed 

• Instrument manual for specific sensor(s) in use 
 
6.0 PROCEDURES 

 
6.1 “AS-FOUND” or “PRE-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed prior to any maintenance activity. No 
equipment maintenance or replacement should be performed prior to the verification checks. Any 
findings of as-found conditions shall be documented in the comments field of the calibration 
form.  

  

• Make notation in station logs and/or flag the wind 
speed channel in the on-site datalogger indicating 
maintenance 

• Select manufacturer and model of sensor and measured 
units on calibration form – this populates motor speed 
targets in form 

• Remove the propeller or cups from the on-site sensor 
and attach the variable speed calibration motor to the 
sensor shaft input 

• Set the certified anemometer drive for the slowest 
motor speed on the calibration form and allow to stabilize 

• Record results in wind speed calibration form under “as-found” 
• Repeat procedure for other motor speeds listed on form 
• Note any additional findings in the comments field of the calibration form  
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Starting Threshold Check 

• Remove the sensor from the cross-arm 
• Install the torque disc on the sensor shaft 
• Hold the sensor such that the shaft if parallel with the ground 
• Note the weight size and distance from center when the shaft first turns (torque) 
• Enter value in form 
• Note any additional findings in the 

comments field of the calibration 
form 

 
 
 6.2 MAINTENANCE and EQUIPMENT EXCHANGE 

Inspect all wiring for abrasions, damage or loose connections. Inspect all connections for possible 
corrosion or damage and repair as necessary.  If the sensor has a heater, verify correction 
operation of the heater if conditions allow. 

If the network or project schedule dictates a sensor exchange, replace the sensor and repeat the 
verification checks from Section 6.1 on the replacement sensor.  If the network or project 
schedule dictates field sensor maintenance (i.e. bearing replacement), perform the maintenance 
and repeat the verification checks from Section 6.1. 
 

Be sure to record the serial number(s) for each on-site sensor 

  
 

6.3 “AS-LEFT” or “POST-MAINTENANCE” VERIFICATION CHECKS 

A complete verification check must be performed following any maintenance activity or 
equipment exchange. Repeat the steps outlined in Section 6.1 and record the measurements in the 
“As-Left” field of the calibration form. 

 

• Verify all data were recorded on calibration forms  
• Remount the site sensor and propeller or vane 

 
• Make notation in station logs and/or unflag the wind speed channels in the on-site 

datalogger indicating maintenance has been completed. 
• Return equipment to the meteorological field kit 
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6.4 SENSORS REMOVED FROM THE FIELD 
All sensors removed from the field should be turned in to the ARS laboratory for routine 

maintenance and any necessary repairs.  All sensors are required to have an Instrument Service Order 
Form completed and accompany the sensor to the ARS laboratory.  See the project manager for additional 
information. 

 
7.0 REFERENCES 

Environmental Protection Agency, 2008, Quality Assurance Handbook for Air Pollution  
  Measurement Systems: Volume IV. Meteorological Measurements (Version 2.0), 
 EPA-454/B-08-002 (March 2008). 
 

Environmental Protection Agency, 2000, Meteorological Monitoring Guidance for Regulatory 
Modeling Applications, EPA-454/R-99-005 (February 2000). 

 

8.0 DEFINITIONS AND ACRONYMS 

 
ARS  Air Resource Specialists, Inc. 
AQDB  Air Quality Database 
CFR  Code of Federal Regulations 
DAS  Data Acquisition System 
EPA  U.S. Environmental Protection Agency 
IMC  Information Management Center 
NIST  National Institute of Standards and Technology 
PDF  Portable Document Format 
QA  Quality Assurance 
QAPP  Quality Assurance Project Plan 
QC  Quality Control 
SLAMS State and Local Air Monitoring Stations 
SOP  Standard Operating Procedure 
 
Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 
 
Calibration: adjustment of the instrument or analyzer so it operates within established 
acceptance criteria (defined in the network of project specific QAPP) 
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The purpose of this review and approval is to evaluate this Standard Operating Procedure (SOP) for 
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Author Signature: 
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Approval Signature: 

 

 
 

Program: Field Operations Manager – Mark Tigges 
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1.0 PURPOSE 

This standard operating procedure (SOP) serves as a guide for transferring the certificate of 
authority from a verified ozone UV photometer (primary standard) or certified ozone transfer 
standard to a candidate ozone transfer standard. This SOP also serves as a guide to re-certify a 
previously certified ozone transfer standard. This procedure is for photometer-based ozone 
analyzers only, not stand-alone ozone generating sources. 
 
Results from the verifications checks constitute required quality control checks, which are used to 
measure the performance of the instrument against acceptance criteria established in the network 
or site specific Quality Assurance Project Plan (QAPP). 

 
2.0 SUMMARY OF METHOD 

Because ozone (O3) cannot be reliably stored, O3 concentrations for analyzer calibration purposes 
must be generated and carefully assayed on-site. Transfer standards are used to assay generated 
O3 concentrations used for calibrations. Certification of candidate ozone transfer standards 
requires a six-point calibration check performed on six different days (six-by-six calibration). The 
days need not be consecutive.  Success of the certification process is determined by statistical 
analysis of the calibration check results. Ozone transfer standard certifications are valid for 90 
days and require re-certification quarterly. 
Re-certification involves one six-point calibration check. Data from the most recent six-point 
calibration checks are subjected to analysis to determine the success of the re-certification. A 
moving (rolling) average of results is calculated and maintained each quarter. Should an ozone 
transfer standard fail re-certification, or should its certification lapse, the entire certification 
process must be repeated, starting with a new six-by-six calibration check procedure 
  

3.0 SCOPE 
Activities described in this document are performed by ARS laboratory technicians or specialists. 
ARS field staff have been appropriately trained in site operations and possess the required 
technical knowledge and abilities to perform the activities described below. 
 

4.0 ROLES AND RESPONSIBILITIES 

Quality Assurance Manager and Officer 

• Oversee and ensure certification is performed according to the required schedule. 
• Review certification results. 
• Review and approve any changes to certification procedures. 
• Identify inconsistencies in certification results and initiate corrective action. 

Laboratory Specialist 
• Perform required certifications as described in this SOP and manufacturer’s instrument 

manual. 
• Document all certification results and procedures performed. 
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5.0 REQUIRED EQUIPMENT AND MATERIALS 

• A UV photometer (primary standard) under current verification, or an ozone transfer 
standard under current certification 

• Candidate ozone transfer standard 
• Ozone Transfer Standard Certification Worksheet 
• Instrument manual for specific equipment in use 

 
6.0 PROCEDURES 

 
6.1 PREPARATION FOR OZONE TRANSFER STANDARD CERTIFICATION 
Transfer standard certifications are critical, lengthy (six day) operations that require careful 
attention to detail and record keeping. Certification should be performed in a properly equipped 
laboratory where external variables can be kept to a minimum. Personnel performing the 
certifications need to be experienced technicians familiar with the operation of UV photometric-
based ozone analyzers. 
Preparation for transfer standard certification involves the following procedures: 

 
CONFIGURE 
STANDARDS 

Configure the primary (or certified transfer) standard and candidate transfer 
standard(s) for operation. 
 

CONFIGURE 
TEFLON TUBING 

Configure clean Teflon tubing so the candidate transfer standard is assaying 
ozone concentrations generated from the primary (or certified transfer) 
standard. Be certain flows generated by the primary (or certified transfer) 
standard satisfy the demands of the photometers. 
 

WARM UP 
INSTRUMENTS 
 

Warm up the instruments for an adequate amount of time. 
 

VERIFY 
DOCUMENTATION 

Confirm that calibration documentation is current, complete, and available. 

 

 6.2 CERTIFICATION (SIX-BY-SIX) OF AN OZONE TRANSFER STANDARD 
The following procedures detail the necessary steps to complete the six-by-six certification 
process. Re-certification procedures are identical to certification, but just one calibration check is 
required rather than six. The procedures assume that an ozone primary standard (UV photometer) 
is being used to transfer authority to a candidate transfer standard.  The procedures are identical if 
a certified transfer standard is used in place of the ozone primary standard.  
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6.2.1 Introduce Known Ozone Concentrations and Record Instrument Responses 
 
RECORD 
PARAMETERS 

Check all instrument-specific operational parameters for operation and record 
parameter values on the Ozone Transfer Standard Certification Worksheet. 
 

INTRODUCE ZERO 
AIR 

Direct a flow of zero air into the candidate transfer standard(s) and allow the value 
to stabilize (as indicated by the DAS). Record the response on the calibration form. 
This point represents the zero response, the first of the six levels of known ozone 
concentration. 

GENERATE OZONE Consecutively generate the following concentrations of ozone from the primary 
standard and direct the flow into the candidate transfer standard. Allow 
sufficient time for each point to stabilize (as indicated by the DAS). 
Concentrations to be generated include:

 
   

RECORD VALUES As each point stabilizes, note and average five consecutive updates of both the 
primary standard and candidate transfer standard(s). Record the primary standard 
value on the calibration form as the primary ozone concentration and the 
candidate transfer standard as the transfer response.  
 

REPEAT Repeat the above procedures once a day for a total of six days. 
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6.3 RE-CERTIFICATION OF AN OZONE TRANSFER STANDARD 
Re-certification of an ozone transfer standard requires only a single (one day) six-point check 
each quarter. All other re-certification procedures are identical to the certification procedures 
presented in Section 6.2. 
Re-certification documentation procedures require using the most recent six calibration checks to 
determine certification success. Complete the Ozone Transfer Standard Certification Worksheet 
with the most recent calibration check first, followed by the five most recent calibration checks. 
If the transfer standard does not pass the re-certification tests, the standard should be evaluated 
and serviced. At any time that a transfer standard fails the re-certification process, a new, 
complete six-by-six certification procedure must be initiated. 

 
7.0 REFERENCES 
 

Environmental Protection Agency, 2013, Quality Assurance Handbook for Air Pollution 
Measurement Systems, Volume II, Ambient Air Quality Monitoring Program, EPA-454/B-13-
003 (May 2013). 
 

Environmental Protection Agency (EPA), October 2013, Transfer Standards for the Calibration of 
Ambient Air Monitoring Analyzers for Ozone, Technical Assistance Document.  (EPA-454/B-13-
004). 

 

8.0 DEFINITIONS AND ACRONYMS 
 

ARS  Air Resource Specialists, Inc. 
AQDB  Air Quality Database 
CFR  Code of Federal Regulations 
DAS  Data Acquisition System 
EPA  U.S. Environmental Protection Agency 
IMC  Information Management Center 
NIST  National Institute of Standards and Technology 
PDF  Portable Document Format 
QA  Quality Assurance 
QAPP  Quality Assurance Project Plan 
QC  Quality Control 
SLAMS State and Local Air Monitoring Stations 
SOP  Standard Operating Procedure 
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Verification: establishes the quantitative relationship between the value of a known 
traceable standard and the instrument’s response 
 
Calibration: adjustment of the instrument or analyzer so it operates within established 
acceptance criteria (defined in the network of project specific QAPP) 
 
Certification: The procedure and methodology of transferring the authority of 
measurement from one device to another. In ozone monitoring, this procedure is 
commonly known as a “six-by-six” calibration referring to subjecting a candidate transfer 
standard to a six-point calibration check on six different days. 
 
Ozone Transfer Standard: A device capable of accurately assaying concentrations of 
ozone. Ozone transfer standards are typically ozone analyzers that have been dedicated in 
their usage as transfer standards. 
 
Re-Certification: A single six point verification check of a previously-certified ozone 
transfer standard. 
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